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This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code
is provided under the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of
or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it
and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of con-
ditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list of
conditions in documentation and/or other materials provided with the distribution.

3. Altered versions— including, but not limited to, ports to new operating systems, existing ports with new graph-
ical interfaces, and dynamic, shared, or static library versions—must be plainly marked as such and must not
be misrepresented as being the original source. Such altered versions also must not be misrepresented as
being Info-ZIP releases— including, but not limited to, labeling of the altered versions with the names "Info-ZIP"
(or any variation thereof, including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or
"MacZip" without the explicit permission of Info-ZIP. Such altered versions are further prohibited frommis-
representative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.

____________________________________________________________________________

Copyright © 2013 - 2024. Micromeritics Instrument Corporation. All rights reserved.



WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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MICROMERITICS CORPORATE PROFILE
Micromeritics is the global leader in analytical instrumentation for the physical characterization of
particles, powders, and porous materials. Our advanced technologies provide precise
measurement of density, surface area, porosity, activity, and powder flow, supporting research,
product development, and quality control. Serving industries like materials science, chemicals,
energy, and natural resources, our instruments enable critical advancements in fields such as
battery materials, hydrogen economy, and carbon capture. Founded in 1962, Micromeritics
operates globally with over 15,000 instruments in daily use, delivering expert support and cutting-
edge solutions from our U.S. headquarters and international locations.For more information,
please visit www.micromeritics.com.

PATENTS
For patent information, visit www.Micromeritics.com/patents.
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CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive
Norcross, GA 30093-2901 USA
Phone: 1-770-662-3636
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3636
International: Contact your local distributor or call 1-770-662-3636
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 iii



About this Manual

ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.micromeritics.com).

n Calculations document (PDF)
n Error Messages document (PDF)
n Operator Manual (PDF)

n Parts and Accessories
n Smart VacPrep Operator Manual (PDF)
n Vacuum Pump Guide (PDF)

All references to 3500, Flex, or Flex Series in this document encompass the Flex,
3Flex, and Flex Confirm environments unless otherwise noted.

This manual contains instructions for installations in standard and 21CFR11
environments. For instructions on installing the application in a 21CFR11
environment, see the Confirm Administrator Guide [part number 004-42821-01].

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

Icon Refers to

Chemisorption and Dynamic Analysis

Physisorption only

Dynamic Analysis

Chemisorption only

Common Icons

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage
the instrument or components.
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WARNING—Warnings contain information to help prevent actions that may cause
personal injury.

NOTE — Notes that apply to 21CFR11 environments only (Confirm applications).

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

About this Manual
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General Safety

GENERAL SAFETY

Do not service or modify this instrument without authorization fromMicromeritics Ser-
vice Personnel. It does not include any user-serviceable parts.

Any laboratory equipment can pose a risk to personnel if not operated or maintained correctly. All
employees who operate and maintain Micromeritics instruments should be well-familiar with their
operation and receive proper safety training and instruction

n Read the operator manual for any special operational instructions for the instrument.
n Know how the instrument functions and understand the operating processes.

n Ensure that personnel use the appropriate personal protective equipment (PPE)
when removing, handling, or repairing equipment. This may include gloves, safety
glasses, or other items specific to the equipment or environment.

n When lifting or relocating the instrument, use appropriate lifting and transporting
devices designed for heavy equipment. Ensure that enough personnel are
available to assist with the movement of the instrument.

The Flex weighs approximately 103 - 106 kg (227 - 234 lb) depending on
configuration.

n Always follow the safety instructions on the labels affixed to the instrument, and
never alter or remove them. During inspections, verify that the safety labels are
intact and not worn or damaged.

n The Flex has a safety shield. Ensure it is in place when operating the instrument.
n Regular maintenance is essential for ensuring personnel safety and the efficient

operation of instruments. Consistent upkeep helps enhance safety, ensures
optimal test results, and minimizes costly downtime. Neglecting proper
maintenance procedures can create unsafe conditions and reduce the lifespan of
the instrument.

n Improper handling, disposal, or transportation of potentially hazardous materials
can result in serious injury or damage to the instrument. Always consult the SDS
when working with hazardous substances. Safe operation and handling of the
instrument, supplies, and accessories are the responsibility of the operator.
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EQUIPMENT REMOVAL AND REPLACEMENT PROCEDURES
Follow these procedures to safely remove equipment from service for repair or disposal and to
ensure safety is maintained when new equipment is put into service.

n Before removing equipment from use for repair or disposal, ensure that all power sources are
disconnected and all stored energy sources have been discharged to prevent accidental injury
to personnel. Refer to the “Power Instrument On and Off” guidelines for more information.

n Only qualified personnel should perform repairs or dispose of the equipment. This ensures that
the work is done safely and that the equipment is properly disposed of in accordance with local
regulations.

n When removing equipment for repair, clearly label it with the reason for removal and the date it
was taken out of service. This helps ensure that the equipment is not put back into service until
it has been properly repaired and tested.

n Depending on the type of equipment being handled, it may be necessary to address
environmental safety, such as preventing spills or leaks of hazardous substances during
removal or transport.

n When moving an instrument to another location (e.g., by car, truck, or plane), the following is
recommended:
o Pack the instrument in the original shipping materials. If such materials are no longer
available, use packaging material (such as a sturdy box with bubble wrap or foam) that will
keep the instrument safe from damage during transport.

o Identify any special handling the package requires (e.g., "Fragile," "This Side Up," or "Do Not
Stack Heavy Items on Top").

o Strap or anchor the package so that it will not tip or fall during transport.
o Inspect the package on arrival to ensure no damage has occurred. If damage has occurred,
contact the responsible party (such as the shipping carrier) for the next steps.

n Follow local regulations and guidelines when disposing of electrical and electronic equipment,
especially if classified as hazardous waste. This may include specific requirements for removal,
transportation, recycling, or other disposal methods.

n Keep records of all equipment removed from service, including the reason for removal and any
repair or disposal actions taken. This helps ensure that the equipment is properly tracked and
that safety issues are addressed in a timely manner.

n Ensure that all replacement equipment meets the same safety standards as the equipment
being replaced. This helps ensure that safety is not compromised when new equipment is put
into service.

n After replacing or repairing equipment, re-calibration or verification may be necessary to
ensure the equipment functions correctly and meets operational standards.

n Before returning equipment to service, ensure that it has been properly repaired and tested to
ensure that it meets all safety requirements. Only qualified personnel should perform this work.

Equipment Removal and Replacement Procedures
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General Safety

INTENDED USE
Micromeritics Surface Characterization Analyzer is a fully automated one, two or three station
instrument capable of high-performance physisorption and chemisorption analyses with superior
accuracy, resolution, and data reduction.

The instrument is intended to be operated by trained personnel familiar with the
proper operation of the equipment recommended by the manufacturer and as well as
relevant hazards involved and prevention methods. Other than what is described in
this manual, all use is seen as unintended use and can cause a safety hazard.

The instrument is intended to be used as per applicable local and national regulations.

TRAINING
It is the customer's responsibility to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.
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Part Name
Hazardous Substances

Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls
(PBB)

Polybrominated
diphenyl ethers

(PBDE)
Cover x o o o o o

Power
Supplies x o o o o o

Printed
Circuit
Boards

x o o o o o

Cables, Con-
nectors &
Transducers

x o o o o o

Hazardous Substances Table

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and are
marked to reflect such. The Environmentally Friendly Use Period is valid only
when the product is operated under the conditions defined in the product
manual.

Equipment Removal and Replacement Procedures
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General Safety

SYMBOLS THAT MAY APPEAR ON THE INSTRUMENT

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear on your instrument:

Use extreme caution when working on the instrument where one of these symbols
may be displayed. These symbols indicate the part may be hot and cause serious
burns.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

When working on an instrument where this symbol is displayed, refer to the cor-
responding Operator Manual for additional information.

When this symbol is displayed, toxic or flammable gases require proper venting of
exhaust.

This symbol can also indicate the instrument uses mercury which is an extremely
toxic substance. Read the Safety Data Sheet (SDS) and be aware of the hazards of
mercury and know what to do in the event of a spill or an exposure incident.
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1 ANALYZER COMPONENTS

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

Parts and accessories are located on the Micromeritics web page.

FRONT COMPONENTS

Physisorption Chemisorption Cold Trap option

Component Description
A Access panels to

reset buttons
Lift the pad and panel to access the reset buttons for the mantle,
heater, and transformer.

B Elevator The elevator raises and lowers automatically when the analysis
is started and completed. During analysis, the elevator
optionally lowers after the free space measurement to allow
evacuation, then raises and continues the analysis.

C Mantle / Furnace
power connector

Power connector for the mantle or furnace.

D Mantle / Furnace ther-
mocouple connector

Connector for the thermocouple.

Front Components

1 Analyzer Components
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1 Analyzer Components

Component Description
E Elevator reset button Resets the elevator in case of failure. The message Elevator Cir-

cuit Breaker Open on the analyzer schematic indicates this reset
button should be used.

F P0 tube For measuring the saturation pressure.

G Sample ports For installing up to three sample tubes.

H Manifold com-
partment cover latch

Holds the removable manifold compartment cover.

I Power indicator light Blinks when power is applied to the analyzer; illuminates when
the analysis program is initiated and ready for operation.

J Cooling gas port Forces air into the furnace to cool it down.

K Thermocouple For chemical adsorption samples.

Cold Trap option Attaches to the left side of the analyzer and removes water of
reaction or other reaction products that might interfere with the
operation of the thermal conductivity detector or to remove
impure vapors in the analysis gas stream, especially water
vapor.

Front Components (continued)
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BACK AND SIDE COMPONENTS

A. Power cord connector
B. Vacuum pump foreline

connector
C. Gas inlet valves
D. Compressed air connector
E. Mass Spec external trig-

ger connector
F. Exhaust port
G. Mass Spec port

Chemisorption units
only

Components Description
Compressed
air connector

For compressed air supply for the pneumatically actuated, hard seal
valves.

Ethernet port
(not shown)

Located on the side panel. Port for a shielded Ethernet cable allow-
ing communication between the analyzer and the computer.

Exhaust port The top port is to vent flowing chemisorption gas. The bottom port is
used for the optional mass spectrometer.

Gas inlet valves Inlet valves 1-6 for analysis gases.

Mass spectrometer
external trigger signal

For connecting the external trigger signal for the optional mass spec-
trometer.

Mass spectrometer
exhaust port

For connecting the exhaust line for the optional mass spectrometer.

Power switch
(not shown)

Located on the side panel. For powering the analyzer on and off.

Power cord connector For setting the power voltage and connecting the analyzer to the
power supply.

RS-232 port (not shown) Located on the side panel. connect the Smart VacPrep.

Vacuum pump foreline
connector

For attaching the dry diaphragm roughing vacuum pump hose.

Back and Side Components

1 Analyzer Components
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1 Analyzer Components

EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories are located on the Micromeritics web page.

Option Description
Chemisorption Includes a Mass Flow Controller for precise flowing preparation of

samples, a furnace to control sample temperature from ambient to
1100 °C, quartz flow-through sample tubes, an exhaust port for vent-
ing hazardous gases, a mass spectrometer port and electronic trig-
ger signal, and six additional gas inlets for a total of twelve. The
single chemisorption port is port number 2. The micropore option is
required for the chemisorption port.

Chiller Dewar A closed loop recirculating system that utilizes a high surface area
copper coil to provide excellent heat transfer between the Dewar and
the recirculating liquids. The Chiller Dewar Quick Start Guide is
located on the Micromeritics web page.

CryoStat A closed-cycle CryoCooler based on the Gifford-McMahon (GM) refri-
geration principle. It uses helium gas from a helium compressor to
generate cryogenic temperatures. The cryostat eliminates the need
for liquid nitrogen and can obtain temperatures below the 77 K of
liquid nitrogen. The decibel rating of the CryoStat HC-4A Zephyr is
56 dBA at 1 meter.

FlowPrep The FlowPrep applies both heat and a stream of inert gas to the
sample to remove adsorbed contaminants from the surface and
pores in preparation for analysis for up to six samples. Choose the
temperature, gas, and flow rate best suited for the sample material.
The FlowPrep is an independent unit and not controlled by the ana-
lyzer.

Micropore Option Each port on the standard analyzer can be upgraded for high quality
micropore analyses with 10 torr and 0.1 torr transducers on each
micropore port. Any remaining ports continue to operate in standard
mode.

The micropore option is required to run krypton.
MKS Cirrus 3 Connects directly to a dedicated port for detection and identification

of low concentrations of condensable and/or reactive gases.
Smart VacPrep The Smart VacPrep prepares samples by heating and evacuation. It

contains six sample ports in which up to five temperatures, ramp
rates, and soak times per sample are individually controlled by the
analyzer program so that all degas information is integrated into the
sample data file for future reference. Samples can also be prepared,
started, and completed independently. There is no need to wait for
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Option Description
samples on other ports to finish. Front panel buttons allow a
QuickStart operation with preprogrammed conditions.

Up to three additional Smart VacPrep degassers can be connected
to one computer permitting 24 preparation ports to be used. The
Smart VacPrep is the recommended degassing unit.

Thermal Conductivity
Detector (TCD)

With the TCD option, dynamic analyses provide the ability to perform
temperature programmed reduction (TPR), oxidation (TPO),
desorption (TPD), and reactions (TPRx).

Provides the capability to investigate temperature dependence of
specific adsorption or desorption process profiles for catalyst and
adsorbents, as well as pulse chemisorption.

VacPrep The VacPrep offers two methods for removing contaminants. In addi-
tion to flowing gas, it provides vacuum to prepare samples by heating
and evacuation of up to six samples. This combination provides pre-
paration method options best suited to the material or application.
Needle valves are also provided for introducing the vacuum slowly to
prevent fluidization of samples. The VacPrep is an independent unit
and not controlled by the analyzer.

Vacuum Pump The analyzer requires a dry roughing vacuum pump for sample
analysis. Appropriate vacuum pumps are available from
Micromeritics.

Vapor Adsorption
Option

Vapor adsorption allows analyses with hydrocarbon vapors or water
vapor. The analyzer allows for dosing from one dedicated sample
port to the other two sample ports.

A vapor adsorption option provides for dosing from a reservoir
attached to the Psat port to all three sample ports. The vapor option
includes a stainless steel chamber with a hard seal, manual cutoff
valve to be attached in place of the Psat tube, and a heating mantle
to control the temperature of the chamber at an operator-specified
temperature between ambient and 43 °C.

Equipment Options and Upgrades
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1 Analyzer Components

GAS REQUIREMENTS AND PURITY

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are
required. Pressure relief valves should be set to no more than 30 psig (200 kPag). All gases
should be of a purity listed below. Gas regulators can be ordered from Micromeritics. Parts and
accessories are located on the Micromeritics web page.

All analyzer types Chemisorption units

(CGA 580) N2
(CGA 580) He

99.999%
99.999%

All gases listed to the left and:

(CGA 350) H2 99.999%
(CGA 350) CO 99.990%
Pre-mix 10% CO in helium (required for Dynamic
Chemisorption units and TCD units only)

CRYOGEN REQUIREMENTS
Liquid nitrogen is commonly used as the cryogen to cool the sample during analysis. A liquid
nitrogen transfer system eliminates the need to pressurize storage Dewars. The Model 021 liquid
nitrogen transfer system is available from Micromeritics (www.micromeritics.com).

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.
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SPECIFICATIONS FOR THE FLEX

Analysis Physisorption Chemisorption

Analysis Range 1.3 × 10-9 to 1.0 P/P0 1 × 10-6 to 900 mmHg

Micropore Analysis Standard on all ports Standard on all ports

Dosing and Evacuation
Control Proprietary servo Proprietary servo

Roughing Pump 4 stage diaphragm 4 stage diaphragm

Krypton Analysis Standard on all ports Standard on all ports

Pressure Measurement

One probe per gas port. 3Flex can use to up three gases concurrently.

Analysis Gas Per Sample

Standard 0.01 m2/g 0.01 m2/g

Krypton 0.0005 m2/g 0.0005 m2/g

Minimum Measurable Surface Area

Temperature Control 45 ± 0.05 °C with 3 strategically placed RTDs

Adsorptive
Gas Inlets 6 12 standard; 16 optional

Vapor Sorption Option Standard ports 1 and 2, optional heated

Furnace N/A

Programmable
0.1–50° C/min
50° C/min to 600° C
20° C/min from 600-800° C
10° C/min from 800-1100° C

Mass Flow Controller N/A Standard, flow up to 200 sccm,
±1% of set point

Instrument Control and Features

Specifications for the Flex
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1 Analyzer Components

TCD with Cold Trap N/A Two optional levels of per-
formance available

Standard External Dedic-
ated Port N/A

Heated port for connection of
external detectors including an
available Cirrus quadrapole mass
spec

Degas

3 in situ for 3Flex
1 in situ for Flex

Up to 4 Smart VacPreps can be attached to
give a maximum of 24 additional degas ports

A/D Data Acquisition 29 bit (effective 25)

Pressure Transducer
System

6 for Flex
12 for 3Flex

Transducer Accuracy
1000 mmHg - 0.12% reading
10 mmHg - 0.12% reading
0.1 mmHg - 0.15% reading

Instrument Control and Features (continued)

Temperature 10 to 35 °C (50 to 95 °F), operating
0 to 50 °C (32 to 122 °F), non-operating

Humidity 20 to 80% relative, non-condensing

Indoor or outdoor use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax (6500 ft)
Pollution degree of the intended environment: 2

Environment

Cryogen Dewar
3.2 L.
Greater than 70 hours
Virtually unlimited duration with refill during analysis

Cryogen Free
Space Control Isothermal jacket

Cryogen
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Voltage 100/120/230VAC

Frequency 50-60 Hz

Power 1350 VA

Overvoltage category II

Electrical

Height 112 cm (44 in.)

Width 57.2 cm (23 in.)

Depth 61 cm (24 in.)

Weight 103 - 106 kg (227 - 234 lb.) (depending on configuration)

Physical

Specifications for the Flex
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1 Analyzer Components

Operating System
Windows 10 or higher operating system is required. For 21 CFR
Part 11 environments, Windows 10 Professional or Windows 10
Enterprise or higher is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access.

Multiple users cannot operate the application at the same time.

Ensure the "Sleep" setting on the desktop is set to
"Never" to avoid interruption while running an analysis.
If this occurs, the application loses network
connectivity with the instrument and a communications
error will be reported. A restart of the Windows
application may be required if automatic reconnection
is not successful.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet-based unit is connected to
the same computer, an Ethernet switch will also be required. If a
Smart VacPrep is to be used, an Ethernet switch is required.

Read/Write Permissions

All application users will need Read/Write permission to all
directories and subdirectories where the application is installed.
For 21 CFR Part 11 environments, permission may be limited to
the installation directory.

Drives USB port

Computer Requirements

Due to continuous improvements, specifications are subject to change without notice.
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2 ABOUT THE SOFTWARE

Software in 21CFR11 Environments on page 2 - 38

Dynamic Analysis and Chemisorption options are not applicable when the software
is installed in a 21CFR11 environment.

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Helpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its
own tab and reflects data collected during the analysis.

The MicroActive feature offers a Windows interface with an easy way to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs and copy and
paste graphics are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

In addition to customizable standard reports, user-defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can be manipulated and displayed interactively using MicroActive reports.

2 About the Software
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2 About the Software

MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Unit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Selections Description
File Use to manage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit 

[n] displays on the menu bar for each analyzer attached to the computer.
Smart VacPrep (If installed.) Use to access the menu for each installed Smart VacPrep.

Reports Use to start or initiate reports and view the results.

Options Use to change presentation options, set the method and active metals
defaults, configure signal calibration, manage libraries, select units, and
create report styles.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Use to access the embedded operator manual, Micromeritics web page,
and information about the application.

Main Menu Bar Options
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COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Selections Description
Add Adds an item to the list.

Add Log Entry Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscalemeans that the x- and y- ranges
will be set to show all the data. If Autoscale is not selected, the entered
range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Use to enter additional information about the sample, such as a sample
lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window and displays a prompt to either accept or
reject changes.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments to display in the report header about the sample or
analysis.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables, deletes the selected information.

Destination Selects the report destination.

Common Fields and Buttons

Common Fields and Buttons
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2 About the Software

Selections Description
Edit When working with report parameters, highlight the item in the Selected

Reports list box and click Edit to modify the report details.
Exit Exits the application. If a file is open with unsaved changes, a prompt

displays the option to save the changes and exit or exit the application
without saving the changes. If an analyzer is currently operating, an
additional prompt displays to confirm exiting from the software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to a file, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field or accept the default. Select to save the file as a spread-
sheet (.XLS), a portable document format (.PDF), or an ASCII text
(.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Indicates the From and To range for x- and/or y-axes when working
with report parameters windows.

Insert Inserts one row above the selected row in the table.

List Creates a list of samples or other types of files. The list will contain the
file name, date/time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-
ues.

Common Fields and Buttons (continued)
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Selections Description
Replace All Selects another .SMP file where the values will replace all values for

the active sample file. The original file will remain unchanged. No
analysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis, and
reporting parameters.

Report Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. A portion
can be saved as a separate, stand-alone file, such as Analysis Condi-
tions or Report Options, when saving sample information.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or
messages. Enabled only in Service Test Mode.

Instrument Schematic. Displays a schematic of the analyzer system.

Common Fields and Buttons (continued)

Common Fields and Buttons
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2 About the Software

FILE STATUS
In the File Selector window, theMic Description column and theMic Status column display the file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of
standard Windows functions.

File Status Description
Analyzing Sample files that are currently used for analysis.

Complete Sample files used in an analysis that is completed.

Entered Sample files containing manually entered data.

No Analysis Sample files that have not been used to perform an analysis.

Prepared Sample files that have been used in an automatic degas operation but
have not been analyzed. This status is applicable only if using the
Smart VacPrep degasser.

Preparing Sample files that are currently being used in an automatic degas oper-
ation. This status is applicable only if using the Smart VacPrep
degasser.

File Status
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File Type File Name
Extension

Alpha-s Curve1 ) .ALS

Adsorptive Properties .ADP

Analysis Conditions .ANC

Calibration .CAL

Degas Conditions .DEG

Heat of Adsorption
Report

.HOA

Methods .MTH

Report Options .RPO

Sample Information .SMP

Sample Tube Prop-
erties

.STB

SPC Report .SPC

Thickness Curve2 ) .THK

File Type and File Name Extension

File Type File Name Extension
Portable document
format

.PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

Extensible markup lan-
guage

.XML

File Types for Printing or Exporting

1 ) Saves the relative pressures and resulting quantities adsorbed as an ASCII text file. These
data are derived by dividing the isotherm by the quantity adsorbed at 0.4 relative pressure.
2 ) Saves the relative pressures and corresponding thicknesses as an ASCII text file. These data
are derived by dividing the condensed volume of adsorptive by the selected surface area. The
density conversion factor in the adsorptive properties file is used to convert quantity adsorbed to
volume of condensed adsorptive.

File Status
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2 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the Filemenu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F) then pressingO to open the File Selector).

If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Selections Description
Alt +[Unit n] Opens the Unit [n]menu.

Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt + H Opens the Helpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens the Reportsmenu.

Alt + V Opens the Smart VacPrepmenu.

Alt + W Opens theWindowmenu.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selector window.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F4 When in the File Selector window, opens the address bar.

F5 Opens the File Selector window listing report options files.

F6 Cascades open windows.

Keyboard Shortcuts
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Selections Description
F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

F10 Opens the Heat of Adsorption window.

Shift + F2 Opens the File Selector window listing sample information files.

Shift + F9 Opens the shortcut menu of either the selected component on the ana-
lyzer schematic when manual control is enabled or the onscreen reports.

Keyboard Shortcuts (continued)

Keyboard Shortcuts
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2 About the Software

OPTION PRESENTATION
Options > Option Presentation

For 21CFR11 environments, see Software in 21CFR11 Environments on page 2
- 38.

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window like the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered
to change to the Basic or Advanced display option. This display type
is typically used in laboratories — such as the pharmaceutical
industry — where analysis conditions must remain constant. The
Advanced option is not available in the view selector at the bottom of
the window when using the Restricted display option.

Always Open Edit View Opens files with a Complete status in the tabbed file editor rather
than in the view.

Show Degas
Conditions

When enabled, displays the Degas Conditions tab when using
Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab if not using a
Smart VacPrep.

Check Shield When enabled, checks to ensure the shield is in place around the
Dewar or furnace prior to starting an analysis. If this option is
selected and the Dewar or furnace shield is not in place prior to
starting an analysis, a warning message displays on the analyzer
schematic window. An entry is made in the analyzer log regardless of
operator choice. 

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display
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To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.

Option Presentation Examples

Advanced view Basic or Restricted view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.

Option Presentation
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2 About the Software

LIBRARIES
Options > Manage Libraries

This feature is not available when using Restricted option presentation.

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files stored in multiple locations, such as folders on a C:
drive, a network location, a connected external hard drive, or a connected USB flash drive, and
provides access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items, such as saved searches and search
connectors, cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.
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METHODS

Options > Default Method
File > Open > [.MTH File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Sample file information that is available to Analysts is created by a
member in the Developer group using information in this section.

AMethod determines the default sample identification format and sequence number. AMethod is
a template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed. Only a single selection
is required for each new sample file created.

TheMethod drop-down list displays only those methods applicable to the open sample file type.

Developer Group view in a 21CFR environment

Default Method Examples Default Method Examples

Methods
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2 About the Software

Analyst Group view in a 21CFR environment

Selections Description
Sample file name
[text box]

Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol
to have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code [text box]

These field labels may be renamed, and the new label becomes a
part of all new sample files.

Sequence number
[text box]

Specify a default numeric string to use as a prefix in the Sample field
when a new sample file is created. This number increments with
each sample file created.

Default Methods

Method Selected Default File Modified
Physisorption 3500.SMP

Chemisorption* 3500Chemi.SMP

Dynamic Analysis * 3500DynamicChemi.SMP

Default Method Files

* Not applicable in a 21CFR11 environment.
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CONFIGURE THE ANALYZER

SPECIFY GAS PORTS

Unit [n] > Unit Configuration
Use to display hardware / software configurations, calibrations, and gas selections of the
connected analyzer.

The analyzer has gas inlets for up to six analysis gases (12 with the chemisorption option, plus
four loop gas inlets with the TCD Loop option). The gases connected to the inlets must be
specified in the analysis program. If the gas is changed on one of the inlets, the same change
must be made on the Unit Configuration window. The analysis software must be kept informed of
any changes in gases.

Enter the gas mnemonic in the gas fields to indicate the type of gas connected to that valve.

Configure the Analyzer
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2 About the Software

Selections Description
Calibrations [button] Displays calibration information for analyzer components.

Configuration
[group box]

Displays the IP address used by the analysis program, serial number,
and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP. [button] Displays the Board ID dialog, which describes
the circuit boards in the analyzer. Use the Board drop-down list to
select a board to view.

Board ID. [button]Click to display information from the circuit boards
in the analyzer. Use the drop-down list to select a board to view. The
parameters shown cannot be edited.

CryoStat [button]

IP Address. The IP address of the cryostat temperature controller.

Port. The computer port to which the cryostat temperature controller
is attached.

Input. Temperature sensor input channel.

Output. Heater output channel.

Default ramp rate.The rate at which the temperature will change

Unit Configuration
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Selections Description
while advancing to the hold temperature.

Gas Selections
[group box]

Enter the mnemonics for the analysis gases attached to inlet valves.
Valves 11-16.
Valves 21-26. With chemisorption option.
Valves 31-24. With loop configuration.

Loop Volume [text box] Enter the loop volume for TCD.

Options [group box] Displays options installed on the analyzer.

Software Versions
[group box]

Displays the software versions of the MIC BIOS, controller, and ana-
lysis program.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Unit Configuration (continued)

Specify Gas Ports
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2 About the Software

SPECIFY THE TYPE OF ANALYZER

Unit [n] > Physical Adsorption
Unit [n] > Chemical Adsorption
Unit [n] > Dynamic Analysis

This topic does not apply if physisorption units only are installed.

Up to four analyzers can be connected, and each analyzer may be either physisorption or
chemisorption. When multiple units are installed, the application's title bar reflects the number of
analyzers installed and the type of analyzer.

The analysis type affects the appearance of the analysis sample selection window, the analyzer
schematic, and the status window. This menu selection is disabled when an analysis is being
performed.

When application windows are opened, the title bar reflects both the serial number and the
analysis type. The title bar changes when the analysis type changes.
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UNIT SELECTION SELECT THE PREFERRED UNITS OF MEASURE

Start the analyzer.

Options > Units
Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.

Unit Selection Select the Preferred Units of Measure
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2 About the Software

ENVIRONMENTAL DEFAULTS FOR TCD ANALYZERS

Options > Environmental Defaults

These values are used in some calculations to account for the effect of environmental conditions
on the analysis. These parameters are used in the Dynamic Analysis reports. To ensure accurate
loop calibration, enter current environmental conditions daily, or whenever there is a significant
change in one or more of the environmental conditions.

Saturation pressure (Po) of the adsorbate used by BET analysis is obtained from the
adsorptive properties for the experiment gas specified.

Selections Description
Ambient temperature
[text box]

The temperature of the room where the analyzer is located.

Atmospheric
pressure
[text box]

The atmospheric pressure of the room where the analyzer is located.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Environmental Defaults
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INSTRUMENT STATUS

SHOW DASHBOARD

Unit [n] > Show Dashboard
Data for the dashboard comes from the logged diagnostic data. The dashboard remains current
as the relevant diagnostic data items are updated. The gauges will be updated even if the
dashboard window is not open.

Red numbers on the dashboard require attention. To reset the dashboard numbers,
right-click on the dashboard setting, then click Reset.

Selections Description
Analyses
completed / started

Displays N/M where N is the number of analyses that have finished
data collection andM is the number of analyses that have been star-
ted. Analyses canceled or terminated by errors before the termination
stage starts are not counted as completed.

Days until roughing-
pump service is due

Annual maintenance is recommended. The number of days until the
anniversary of the last pump maintenance is shown. The displayed
value is updated at least once per day and when the maintenance
time is reset. When the displayed value is 30 or less, the value is dis-
played in red. Red negative numbers display if maintenance is past
due.

Dashboard Gauges

Instrument Status
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2 About the Software

Selections Description
Manifold outgas rate Provides the qualitative indication of the outgas rate in the dosing

manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

The gauge is updated when the Analysis Manifold Test is run. See
Schedule Diagnostic Tests on page 9 - 3 and Start Diagnostic
Test on page 9 - 1.

n Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

n At 30%, the left LED turns off.
n At 60%, the center LED turns off.
n At 90%, three green LED lights turn off and the center yellow

LED turns on.
n At 110% and above, only the red LED turns on and attention is

required.

Manifold temperature Displays the statistics of the manifold temperature reading. The
mean, the value at two standard deviations, the minimum, and the
maximum display.

Nitrogen P0 Displays statistics of the saturation pressures measured with nitrogen
gas at liquid nitrogen temperatures. The mean, two-sigma, minimum,
and maximum values display. The gauge is updated when a P0 is
logged with nitrogen as the adsorptive and a bath temperature of
77±2 K.

Dashboard Gauges (continued)
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SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

In 21CFR11 environments, see Software in 21CFR11 Environments on page 2 -
38.

Use to display a log of recent analyses, calibrations, errors, or messages.

Selections Description
Add Log Entry [button] Use to enter information to appear in the sample log report that can-

not be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

Include Message
Number [text box]

Enter any of the following information in the message text box to
generate a log report that includes the following:

n Message number in the text box to view all occurrences of the
entered message,

n Asterisk in the message box to see all numbered messages, or
n Several message numbers separated by commas to include only

messages with those numbers.

Numbered messages contain more detailed information about
analyzer operation.

Report [button] Click to select the print destination and the report start date.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Instrument Log

Show Instrument Log
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2 About the Software

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
Use to display an analyzer schematic. To operate the valves and elevator from this window,
manual control must be enabled (Unit [n] > Enable Manual Control).
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A. Servo valve
B. P0 pressure
C. Port 1 pressure
D. Port 2 pressure
E. Port 3 pressure
F. Elevator
G. Temperature sensors
H. Manifold pressure
I. Vacuum gauge

J. Mass flow controller

K. Injection loop *

L. Loop gas exhaust port *

M. Septum *

N. Loop rotary valve *

O. Chemical exhaust port
P. Cold trap
Q. Cold trap rotary valve

* Displays only if TCD Loop Valve
option is installed.

Physisorption

Chemisorption

Dynamic Analysis with Loop option

Show Instrument Schematic

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 2 - 25



2 About the Software

Schematic
Components

Description

1-3 Sample ports

4 Po port

5 Servo isolation valve

6 Manifold vacuum

7 Vacuum gauge isolation valve

8 Inlet vacuum

9 Exhaust valve for chemisorption only

10 Reference volume (shown in Service Test mode only)

11-16 and 21-26 Inlet valves

31-34 Loop gas inlet valves (displays only if the TCD Loop Valve option is
installed)

Analyzer Schematic Components

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.

Servo Valve. Closed.

Servo Valve. Open.

Elevator.

Sample Tube and Furnace Elevator. The sample tube icon is white
when the sample and furnace temperatures are 50 °C or lower. If either the
sample or furnace temperature exceeds 50 °C, the sample tube icon turns
orange. Temperature readings and ramp rate are displayed below and to
the left of the icon. The furnace icon resides on the elevator.
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Icon or Symbol Description

Mass Flow Controller (MFC). Controls the flow of gas into the sample
port. The current (C) rate and the target (T) rate are shown to the right of the
MFC icon. Applicable only for the gas used in the flowing operations. The
mass flow controller constant is preset for gases provided with the
application. See Chemisorption Tasks on page 4 - 13.
Sample Tube. Cannot be manually controlled.

A warning that indicates the safety shield is not in place.

Vapor Source with Heating Mantle. Also displays the current
temperature, the target vapor source temperature, and rate of temperature
increase.

Instrument Schematic Shortcut Menus

Icon or Symbol Description
Valve options Automatic. Automatically operates the servo valve during dosing or

evacuation. Enter the target pressure.

Close. Closes the selected valve.

Direct. Used in Service Test mode only under the direction of a
Micromeritics Service Representative.

Open.Opens the selected valve.

Pulse. Use to quickly turn the valve on and off allowing the operation
to proceed in small increments.

Elevator options Raise. Select Raise to raise the elevator. When it is moving, press
the keyboard space bar to stop the movement (or right-click and
select Stop from the menu).

Lower. Select Lower and press the keyboard space bar to lower the
elevator.

Stop. Stops the elevator from moving.

Schematic Shortcuts

Show Instrument Schematic
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2 About the Software

Icon or Symbol Description
Temperature control
options

On. Enables the temperature control.

Off. Disables the temperature control.

Set. Select to set the following:
n Enable or disable temperature control
n Control sample temperature
n Control furnace temperature
n Cool the sample to less than 50 °C
n Set heater power percent

Schematic Shortcuts (continued)
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PRESSURE TRANSDUCERS

The schematic shows the pressure transducers present in the system.

n All systems have 1000 mmHg pressure transducers on the manifold and the analysis ports.
n Optional 10 mmHg pressure transducers on the manifold and one or more analysis ports may

be present.
n Optional 0.1 mmHg pressure transducers on one or more analysis ports may be present.

When multiple pressure transducers are present in a port or the manifold, the display
automatically changes to show the pressure reading from the lowest range transducer currently
on the scale.

HEATING MANTLE

When samples are being degassed on the analysis ports, the following icons appear beneath the
elevator. When the mantle temperature is above 50 °C, the sample tube icons (not shown below)
turn orange. If using a GlasCol heating mantle, the sample temperature shows in the yellow
Degas Mantle box.

Right-click the Degas Mantle box to set the target temperature or the rate of temperature increase.

Select Enable Temperature Control, then enter both the Target Temperature and Ramp Rate. The
Set Heater Power Percent field (shown when Disable Temperature Control is selected) is enabled
in Service Test Mode only.

Show Instrument Schematic
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2 About the Software

SHOW STATUS

Unit [n] > Show Status
Use to show the current status for each port.

Physisorption

Chemisorption

Dynamic Analysis

If multiple units are attached to the computer, select Show Status on each Unit [n]menu. The
status for all units displays.

2 - 30 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



ANALYSIS TYPES FOR TCD ANALYZERS
The basic concept for all analyses is the same: the filament detects changes in the gas mixture
flowing past it. The sample, gas selection, and analysis conditions determine what changes occur.

TEMPERATURE PROGRAMMED DESORPTION ANALYSIS
Temperature Programmed Desorption (TPD) analyses determine the number, type, and strength
of active sites available on the surface of a catalyst from measurement of the amount of gas
desorbed at various temperatures.

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of
analysis gas flows through the sample and adsorbs on the active sites. Programmed desorption
begins by raising the temperature linearly with time while a steady stream of inert carrier gas flows
through the sample.

At a certain temperature, the heat overcomes the activation energy; therefore, the bond between
the adsorbate and adsorbent will break, and the adsorbed species desorb. If different active
metals are present, they usually desorb the adsorbed species at different temperatures. These
desorbed molecules enter the stream of inert carrier gas and are swept to the detector, which
detects changes in gas composition. The volume of desorbed species, combined with the
stoichiometry factor and the temperature at which pre-adsorbed species desorb, yields the
number and strength of active sites.

Temperature Programmed
Desorption

Temperature Programmed Decom-
position

n Heated pretreatment
n Active sites to probe
n Active gas to probe sites (NH3, CO2, H2,

etc.)
n Material (sample) does not change during

temperature ramp

n No pretreatment
n No active sites to probe
n Only inert gas is used
n Material changes throughout temperature

ramp

Observe changes of gas phase species during temperature ramp.

Analysis Types for TCD Analyzers
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2 About the Software

TEMPERATURE PROGRAMMED REDUCTION ANALYSIS

Temperature Programmed Reduction (TPR) determines the number of reducible species present
in the catalyst and reveals the temperatures at which the reduction occurs.

The TPR analysis begins by flowing analysis gas (typically hydrogen in an inert carrier gas such
as nitrogen or argon) through the sample, usually at ambient temperature. While the gas is
flowing, the temperature of the sample is increased linearly with time and the consumption of
hydrogen by adsorption/reaction is monitored. Changes in the concentration of the gas mixture
are determined. This information yields the hydrogen uptake volume.

When using any mixture of gases for TPR or TPO analyses, ensure the thermal
conductivities of the two gases in the mixture are quite different for maximum
sensitivity. SeeGas Charts on page I - 1 .

TEMPERATURE PROGRAMMED OXIDATION ANALYSIS

Temperature Programmed Oxidation (TPO) examines the extent to which a catalyst can be
oxidized or was previously reduced.

Usually the sample is pretreated and the metal oxides are reduced to the base metal, typically with
a gas mixture of hydrogen with either nitrogen or argon. Then the oxidizing gas, typically 2-5%
oxygen with helium, is applied to the sample in pulses or, alternatively, as a steady stream.

The furnace heats the sample tube and sample according to the user-selected temperature
program. The oxidation reaction occurs at a specific temperature. The analyzer measures the
uptake of oxygen.

When using any mixture of gases for TPR or TPO analyses, ensure the thermal
conductivities of the two gases in the mixture are quite different for maximum
sensitivity. SeeGas Charts on page I - 1.
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PULSE CHEMISORPTION ANALYSIS

A Pulse chemisorption analysis determines the amount of gas irreversibly adsorbed and
subsequently calculates active surface area, percent metal dispersion, and the average active
particle size by applying measured doses of reactant gas to the sample.

The active gas interacts with each active site until all active sites are covered. Once the active
sites have been completely covered, the discretely injected gas volumes elute from the sample
tube unchanged. The amount chemisorbed is the difference between the total amount of active
gas injected and the amount that eluted from the system. The quantity of each pulse of reactant
gas is determined by the loop volume on an automatically controlled valve. A 0.5 cm3 loop is
provided with the analyzer and an optional 1 cm3 loop is available.

ADDITIONAL USES OF THE TCD ANALYZER

The analyzer may also be used for temperature programmed reactions, catalyst pretreatment,
and isothermal reactions. The tremendous flexibility of the analyzer allows the use of custom
applications.

Temperature Programmed Reaction

A temperature programmed reaction monitors the products from the reaction between gases and
a catalyst at a specified temperature. The analyzer can be programmed to raise the temperature
of a catalyst bed at a constant ramping rate as the gases flow through the catalyst. At the optimal
temperature, the gases react in the presence of the catalyst, creating products. The products of
the reaction and excess reactants can be diverted to a gas chromatograph or to a mass
spectrometer to be analyzed.

Catalyst Pretreatment

Catalyst pretreatment usually consists of activating a catalyst before its use in a chemical
reaction. For example, a temperature programmed oxidation reaction may require reduction of the
catalyst under a flow of H2 at a specific temperature.

Isothermal Reaction

An isothermal reaction is similar to a temperature programmed reaction except that the catalyst is
kept at a constant temperature (isothermal) to perform the catalytic reaction. Both the product of
the reaction and the excess reactants can be diverted to a gas chromatograph or to a mass
spectrometer to be analyzed.

Pulse Chemisorption Analysis
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2 About the Software

APPLICATIONS

Catalytic processes that benefit from TPD/TPR analyses include:

n Polymerization
n Hydrogenation
n Catalyst cracking
n Hydrocracking
n Isomerization

n Oxidation
n Dehydrogenation
n Hydrotreating
n Alkylation reforming

PEAK EDITOR FOR DYNAMIC ANALYSIS
Peak Editor for Dynamic Analysis on page 7 - 10

The TCD (Thermal Conductivity Detector) features a Peak Editor, which allows the evaluation of
results, peak editing, and reports. Adjusting peak boundaries can be used to eliminate baseline
noise or other undesirable effects. The Peak Editor also allows the separation of composite
peaks.
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EXPORT FILES
File > Export
Exported Data Example on page G - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. The data can be
imported into other applications that read these file formats when exported to a file.

1. Click List and open an .SMP file.
2. Select an experiment and the applicable options.
3. ClickOK.

Export Files
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2 About the Software

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.

Example of
File List

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

The Setup program is located on the installation media and is used to reinstall the software and
make analyzer changes— such as adding, moving, or removing a unit, etc.

If the IP address needs to be changed on the computer connected to the analyzer,
refer to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The IP address must be 192.168.77.100.
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SOFTWARE UNINSTALL
Uninstall Software in 21CFR11 Environments on page 2 - 43

The software can be uninstalled in two ways. Either method removes only the files required to run
the software, not the analysis files.

n Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

n Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file, then follow the
screen prompts.

SOFTWARE UPDATES

A User Account Control in the Windows operating systemmust be enabled to ensure
all components of the Micromeritics application are correctly installed. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.micromeritics.com).

When performing a software update, existing data files are not overwritten.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.

Existing Confirm application users and groups are not affected by software updates.
Any changes to Confirm users and Confirm groups must be made using Windows
Users and Groups.

Software Uninstall
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2 About the Software

SOFTWARE IN 21CFR11 ENVIRONMENTS

The Micromeritics Confirm applications for 21CFR11 environments require an
operating system of Windows 10 Professional or Windows 10 Enterprise or higher.
Management of users and groups is performed in Windows Users and Groups.

The Micromeritics Confirm application enables laboratory managers to develop analysis methods,
enforce industry standards, and produce audit trails. It also enables laboratory analysts to perform
analyses and produce reports.

USER PERMISSIONS

Confirm User Name Description
mic_[analyzer model
number]_controller

mic_[analyzer model number]_controller is the user name used by all
installations.

n This user should have complete control over the installation dir-
ectory.

n The application is launched under this user name and has this
user’s privileges to the windows file system.

n This user should not be used by anyone or any other software that
is not a Micromeritics application.

n The system administrator has the option of modifying this account
so that the password never expires. Alternatively, if the password
does expire while the application is running, the application auto-
matically changes the password for this account.
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Confirm Group Name Description
Developer Group The default Developer group name is

mic_[analyzer model number]_developer. Members of the
Developer group:

n have rights to all functions of the Micromeritics application - includ-
ing Advanced option presentation which allows the creation and
modification of methods, sample files, and parameter files.

n can run an analysis.
n can also be assigned Administrator rights which control the user

profiles.

Analyst Group The default Analyst group name is
mic_[analyzer model number]_analyst. Members of the Analyst
group:

n have access to the Basic presentation option only.
n may create sample files from pre-defined methods and can modify

only a limited number of input fields.

Software in 21CFR11 Environments
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2 About the Software

OPTION PRESENTATION FOR 21CFR11 ENVIRONMENTS
Options > Option Presentation

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Show Degas
Conditions

When enabled, displays the Degas Conditions tab when using
Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab.

Check Shield When enabled, checks to ensure the shield is in place around the
dewar or furnace prior to starting an analysis. If this option is selected
and the dewar or furnace shield is not in place prior to starting an
analysis, a warning message displays on the analyzer schematic win-
dow. An entry is made in the analyzer log regardless of operator
choice.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

For members of the Developer group only. To change the view from Advanced
(for Developers) to Basic (for Analysts), click the view selector drop-down list at the
bottom of the window. Select either Advanced (when in Basic view) or Basic (when
in Advanced view).
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Advanced view / Developer group Basic view / Analyst group

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.

n The Save button is disabled on sample files with a Complete status.
n When the Preview button is used to view reports for sample files with an unsaved status, the

report will have a Preview watermark.
n The Save As and Print buttons on the report window are also disabled.

CREATE A NEW FOLDER
File > Create New Folder
Provides the option to create and name a new folder in the Confirm application folder. This option
may not be available depending on how the IT Administrator configures Windows permissions.

Software in 21CFR11 Environments
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2 About the Software

SYSTEM AUDIT TRAIL
File > System Audit Trail

Lists the current user, successful and failed application user login attempts, and contains a
description of all the changes made to sample files. Contains an audit trail of all system
initializations, user login attempts, and sample analyses.
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UNINSTALL SOFTWARE IN 21CFR11 ENVIRONMENTS

When the software is uninstalled using uninstall.exe, only the files required to run the application
are removed. Parameter files, sample files, reports, calibration files, and data files are not
removed.

To uninstall the software, double-click the uninstall.exe file located in the software installation
directory, then follow the prompts.

To uninstall the Micromeritics Confirm application, the owner of the application
directory and its contents must be set to the account of the administrator that is
removing the application installation. This account must also have permission to
modify the application directory and its contents. This may require modification to the
owner and to the access permissions of the application directory and its contents.

Upon uninstalling the Confirm application, the system administrator should go into
Windows Users and Groups to remove the Confirm users and groups. See the
Confirm Administrator Guide [part number 004-42821-01].

Depending on the network, Windows may not allow the uninstall.exe program to run. If this
happens. follow these steps:

1. In Windows Users and Groups, verify that the current user is not a member of the analyst
group or developer group. If so, remove the user from the group(s). Log OFF, then log back
ON to the computer.

2. In Windows Explorer, in the Confirm installation directory, double-click the uninstall.exe file
to run the uninstall program.

Uninstall Software in 21CFR11 Environments
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3 SAMPLE FILES
Option Presentation on page 2 - 10
Software in 21CFR11 Environments on page 2 - 38

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, specifies report options, and may be
displayed in Advanced, Basic, or Restricted presentation display mode. After data is collected, the
file is shown in MicroActive mode or the tabbed file editor.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either before or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

3 Sample Files
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3 Sample Files

CREATE SAMPLE FILES

Options > Option Presentation > Show Degas Conditions

File > New Sample > [.SMP File]

File > Open > [.SMP File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in
this section helpful. Sample file information that is available to Analysts is created by
a member in the Developer group using information in this section.

Analysis condition defaults for metal stoichiometry factors can be set using the
sample information metal table editor. Stoichiometry factors can also be set for each
pulse chemisorption experiment using the analysis conditions experiment step editor.
If required, stoichiometry factors for a completed pulse chemisorption experiment can
be viewed and modified using the peak editor’s stoichiometry settings window.

For dynamic analyses, the Loop Volume and Environmental Default values must be
correct before starting an analysis.

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation are selected from parameter files created in
the Advanced option presentation. The values specified in the parameter portions of the default
method are the defaults for new sample files. To navigate from one set of parameters to another,
select the parameter tab across the top of the window.

Sample Tube parameters are edited on the Sample Description tab.

For physisorption, the Degas Conditions tab displays only if enabled inOptions >
Option Presentation > Show Degas Conditions.
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Advanced Option Presentation

Physisorption Chemisorption or Dynamic Analysis

Basic Option Presentation

Physisorption Chemisorption or Dynamic Analysis

File Editor Example for 21CFR environments

Create Sample Files
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3 Sample Files

Advanced or Developer view Basic or Analyst view

A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Selections Description
Active Metals [button]  Displays a list of active metals. See Active Metals for Chemisorp-

tion Analyzers on page 3 - 13.

Add Log Entry [button] Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] * Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments to display in the report header about the sample or
analysis.

Mass [group box] If mass = 1, the reported surface area equals the total surface area
but it is always shown as m2/g. If an accurate mass is entered, the
reported surface area is normalized per gram of sample. Choose
whether to enter mass manually or have the system automatically
calculate mass. Enter a value for sample mass. Mass can be
changed any time before, during, or after analysis.

Enter. Enables the Sample mass field. Enter a value for the sample
mass.

Sample Files
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Selections Description
Calculate. Enables the Empty tube and Sample + tube fields. Enter
the values necessary to calculate the sample mass. Equation used
to calculate sample mass:

Masssample = Masssample+tube – Masstube

Density. Value is used for the calculated free space method only.
Use 0.000 for a blank analysis.

Method [drop-down box] Select a method from the drop-down list.

Operator [text box] * Enter operator identification information.

Sample [text box] * Enter a sample description.

Sample Tube
[drop-down box]

Select a sample tube file from the drop-down list, or click Edit to
modify or create a new sample tube file.

Submitter [text box] * Enter submitter identification information.

Type of Data
[group box]

Automatically collected. Select if the type of data will be
automatically collected by the system while an analysis is running.

Manually entered. Use to enter data manually that was collected
from another source. IfManually entered is selected, the Isotherm
Report becomes available in the Basic/Advanced drop-down list for
pasting or importing data into the file.

SeeManually Enter Data on page 3 - 8.
User Parameters
[group box] *

These fields are primarily used for the SPC (Statistical Process Con-
trol) reporting to specify sample characteristics or its manufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SPC Report.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Files (continued)

* This field label may have been renamed or may not display if modified inOptions > Default
Methods.

Create Sample Files
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3 Sample Files

OPEN A SAMPLE FILE
File > Open > [.SMP File]

When working with an existing sample file, consider copying the sample file to
maintain the original configuration options.

File Type File Status Displays

Physisorption or
Chemisorption

Preparing
Prepared
No Analysis

Tabbed file editor

Complete
Analyzing
Entered

MicroActive report window

File Editor Example for CFR21

Advanced or Developer view Basic or Analyst view
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Example of a Report window

To view the tabbed file editor for a sample file with a Complete status, select Advanced from the
view selector drop-down list at the bottom of the window.

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

Open a Sample File
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3 Sample Files

MANUALLY ENTER DATA

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

This process allows the manual entry of pressure data from a sample file with a Complete status.
There are two methods for manually entering data into a sample file:

n Copy and paste onto the graph area of the interactive window.
n Import data into the interactive window.

COPY AND PASTE MANUALLY ENTERED DATA

To display the file status in a search window, go to File > Open. Right-click the
column header then clickMore... Scroll to theMIC entries and enableMIC Status.

1. Open a sample file with a Complete status. The file will open in the interactive reports win-
dow.

2. Right-click in the graph area of the interactive reports window, then select Copy data.

Example of Report window

3. Open another sample file using the Advanced option presentation.
4. On the Sample Description tab, selectManually entered in the Type of Data group box.
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5. In the view selector drop-down list at the bottom of the window, click Advanced, then select
Isotherm.

6. Ensure that all parameter fields are set appropriately, then click Paste.

Manually Enter Data
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3 Sample Files

IMPORT MANUALLY ENTERED DATA
When importing isotherm data from an external ASCII text file using the Import button on the
interactive window, the ASCII text file must use the following rules:

ASCII text file format rules

Data must be in two columns and separated by a comma or white-space. Acceptable column
headings are:

For Physisorption or Chemisorption:

n Relative Pressure
n Absolute Pressure (mmHg)
n Absolute Pressure (kPa)
n Absolute Pressure (mBar)

n Quantity Adsorbed (mmol/g)
n Quantity Adsorbed (cm³/g STP)
n Quantity Adsorbed (cm3/g STP)

Sample Physisorption ASCII Text File

Silica Alumina : Adsorption
Relative Pressure        Quantity Adsorbed (cm3/g STP)
0.108629                 50.6657
0.22288                  60.7813
0.339909                 71.3095
0.459512                 84.4172
0.577447                 102.672
0.654583                 121.707
0.760074                 179.096
0.855713                 334.565
0.958511                 394.675
0.996251                 403.793

Silica Alumina : Desorption
Relative Pressure        Quantity Adsorbed (cm3/g STP)
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0.996251                 403.793
0.86016                  389.626
0.753567                 256.264
0.664418                 133.099
0.542416                 96.7366
0.422295                 79.7351
0.346371                 71.5994
0.2519                   62.8256
0.152718                 54.2336
0.103389                 49.5803

Manually Enter Data

Flex Series Operator Manual
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3 Sample Files

To import the ASCII text file

1. Open a new sample file in Advanced option presentation.
2. On the Sample Description tab, selectManually entered.
3. In the view selector drop-down list at the bottom of the window, click Advanced, then select

Isotherm.

4. Ensure that all parameter fields are set appropriately, then click Import.
5. Open the .TXT file. The data from the original sample file is imported and displayed. If an

error message displays instead, verify that the .TXT file format is correct.
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ACTIVE METALS FOR CHEMISORPTION ANALYZERS
Options > Active Metals Defaults
Or, click Active Metals on the Sample Description tab when using the Advanced presentation
option.

Atomic Weights and Cross-Sectional Areas on page B - 1

Up to 20 elements can be specified. At least one element must have a non-zero % of the sample
weight.

Selections Description
% of Sample Weight *
[column]

Percentage, by weight, of each element contained in the sample.

% Reduced * [column] The percent of metal reduced during preparation.

Active Metals

Active Metals for Chemisorption Analyzers
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3 Sample Files

Selections Description
Adsorptive [button] Click to display and modify both the adsorptives and their associated

stoichiometry factor. Stoichiometry factors for each gas are metal-
specific.

Stoichiometry Factor. The stoichiometry factor is defined as the
moles of metal species covered per mole of adsorptive.

Atomic Cross Sect.
Area (nm2) [column]

Atomic cross-sectional area of the element.

Atomic Weight [column] Atomic weight of the element.

Density g/cm3 [column] Density of the element.

Element
[drop-down box]

Select or enter the active metal.

MxOy, X *
MxOy, Y *
[column]

X and Y values specify the empirical formula for metal and oxygen,
respectively, in a metal oxide.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Active Metals (continued)

* Options are shown only when using the Active Metals button on the Sample Description tab.

3 - 14 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



4 PARAMETER FILES

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

In 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Parameter file information that is available to Analysts is created by a
member in the Developer group using information in this section.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed, or new
parameter files created.

The following file types can exist as part of the sample file as well as individual parameter files.

File Type File Extension
Adsorptive Properties .ADP

Analysis Conditions .ANC

Degas Conditions .DEG

Method .MTH

Report Options .RPO

Sample Tube .STB

Parameter File Types

4 Parameter Files
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4 Parameter Files

ADSORPTIVE PROPERTIES
File > Open > [.ADP File]
Or, for physisorption and chemisorption, click Edit next to the Adsorptive selection on the Analysis
Conditions tab when in Advanced option presentation. For a dynamic analysis, there is no
Adsorptive Properties tab; use File > Open > [.ADP file].

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

In 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Parameter file information that is available to Analysts is created by a
member in the Developer group using information in this section.

Selections Description
Adsorbate molecular
weight [text box]

The molecular mass is used for the weight % column of the isotherm
tabular report and the pressure composition isotherm plot.

Adsorbed phase free-
space correction
[check box]

Adsorbed molecules occupy volume in the sample tube reducing the
analysis free space. Select Adsorbed-phase free space correction to
adjust the reported quantity adsorbed to correct for this effect. This
option is appropriate for all sample analyses that use the real gas
equation of state.

Adsorptive
[drop-down box]

Name of the adsorptive gas whose properties are being defined.

Adsorptive Properties
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Selections Description
Dosing Method
[group box]

Normal. Dose from a pressurized tank of gas attached to a gas inlet
port.

From Psat tube. Select if the Psat tube is to be filled with
condensed adsorptive and dosed from the Psat tube. Select this option
if using krypton.

From sample port 3. Select if the tube attached to sample port 3 is
to be filled with condensed adsorptive and dosed from port 3.

Vapor source. Select if a container of condensed vapor is to
be attached to the Psat port in place of the Psat tube and is dosed from
the Psat port.

Charge from inlet. Use to have the tube automatically charged
with condensate from a gas inlet port after the Dewar is raised.

Purify adsorptive.  Use to have the condensate in the tube purified
after charging by evacuating the gas over the condensate. If Charge
from inlet is selected, select Purify adsorptive to have noncondensing
contaminants automatically removed from the dosing tube prior to
analysis. After the adsorptive has condensed in the selected Psat tube
or port 3, the remaining gas in the tube will be evacuated to remove
noncondensing contaminants. A small amount of the purified
adsorptive condensate will then return to gas phase to restore
equilibrium pressure in the tube.

Dynamic chemi
saturation pressure

Select if vapor is going to be used and enter the vapor defaults.

High-resolution fluid properties. Use to import parameters from a
Fluid Properties (.FPI) file. Changing fluid properties should only be
necessary if an adsorptive is to be used for which no adsorptive
properties are provided. Contact Micromeritics Scientific Services if
new fluid properties are required.

Antoine equation. Enter the Antoine constants.

n A, B, C. Enter the Antoine constants used in the vapor
TCD calibration.

n Min/Max temperature. Enter the temperature range where the con-
stants are valid.

Adsorptive Properties (continued)

Adsorptive Properties
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4 Parameter Files

Selections Description
Fluid properties
[button]

Use to import parameters from a Fluid Properties (.FPI) file. Changing
fluid properties should only be necessary if an adsorptive is to be used
for which no adsorptive properties are provided. Contact Micromeritics
Scientific Services if new fluid properties are required.

Gas Blend [check box] Select to specify a preblended mixture of a chemically insert gas and a
chemically active gas. The blend'sMass Flow Constant and Relative
Thermal Conductivity are automatically calculated from those for the
two gases in the blend.

Mass flow constant
[text box]

Scaling factor for the Mass Flow Controller measured flow rate.
Applicable only for the gas used in the flow prep tasks. The default is
preset for gases provided with the application.

Maximum manifold
pressure
[text box]

The highest pressure to which the manifold will be dosed. To avoid
damage to the analyzer, this number is limited to 925 mmHg. Low pres-
sure sources will require lower numbers. For gases to be used for dos-
ing after charging a tube from a gas inlet, enter the maximum pressure
for dosing from the inlet, not from the tube of condensate.

Mnemonic [text box] Enter the mnemonic name for the adsorptive. See Specify Gas Ports
on page 2 - 15.

Molecular cross-sec-
tional area [text box]

The area that a single adsorbed molecule occupies on the surface of
the sample. It is used in surface area calculations.

Relative Thermal
conductivity

SeeGas Charts on page I - 1.

Therm. tran. hard-
sphere diameter
[text box]

Estimate of the molecular size used in calculating the thermal
transpiration correction.

Vapor Source
Temperature
[group box]

Select if the vapor source temperature is to be controlled by the ana-
lyzer. This field is enabled only if Vapor Source is selected.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Adsorptive Properties (continued)
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ANALYSIS CONDITIONS FOR PHYSISORPTION AND CHEMISORPTION
File > Open > [.ANC File]
Or, click the Analysis Conditions tab when in Advanced option presentation.

Analysis conditions specify the parameters used to guide an analysis.

In 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Parameter file information that is available to Analysts is created by a
member in the Developer group using information in this section.

Physisorption Chemisorption
The Pressures tables have a Starting Pressure and an Ending Pressure column. Each table row
represents a pressure interval. The Starting Pressure column is for information only and cannot be
edited.

Analysis Conditions for Physisorption and Chemisorp-
tion
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4 Parameter Files

Selections Description
Absolute pressure
dosing [check box]

Specifies pressure targets in mmHg or mbar instead of relative
pressure. If this option is selected, the Relative Pressure labels and
entries change to Absolute Pressure in the selected pressure units.

Adsorptive
[drop-down box]

Select an Adsorptive Properties file from the list of defined gases to be
used for analysis. After selection, click Edit to modify adsorptive prop-
erties.

Analysis
Conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis con-
dition parameters to be used in the analysis.

Dosing [button] Options for dosing tolerance, low pressure dosing, and dosing near
saturation pressure.

Absolute / Relative pressure tolerance. Values used to determine
how close the actual pressure must be to each target pressure from the
pressure table. At lower pressures, the relative tolerance value is lower.
At higher pressures, the absolute tolerance value is lower. For example:

Experiment 1. There might be an absolute tolerance of 5 mmHg, a
relative tolerance of 5%, and a target pressure of 40 mmHg; 5% of
40 mmHg is 2 mmHg. Since 2 mmHg (relative tolerance) is lower
than 5 mmHg (absolute tolerance), 2 mmHg is used. Therefore a
minimum pressure of 38 mmHg (40 - 2) must be attained to collect
data for a target pressure of 40 mmHg.

Experiment 2. There might be an absolute tolerance of 5 mmHg, a
relative tolerance of 5%, and a target pressure of 200 mmHg; 5% of
200 mmHg is 10 mmHg. Since 5 mmHg (absolute tolerance) is
lower than 10 mmHg (relative tolerance), 5 mmHg is used.
Therefore a minimum pressure of 195 mmHg (200 - 5) must be

Analysis Conditions
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Selections Description
attained to collect data for a target pressure of 200 mmHg.

Normally, surface area measurement points are widely spaced and
the resulting measurement is not very sensitive to the precise
location of points so wider tolerances may be used. Unnecessarily
tight tolerances lengthen the analysis.

Minimum equilibration delay at p/po > = 0.995. The minimum
number of seconds required before equilibration can occur for a relative
pressure greater than or equal to 0.995. This field is not available if
Absolute pressure dosing is selected on the Analysis Conditions tab.

Low pressure equilibration delay. Delays to be used until the first
pressure in the table is reached.

Free Space [button] How the free space is to be measured.

Physisorption Chemisorption

Calculate. Use to have the free space measurement calculated
using the sample and tube parameters.

Enter. Allows manual entry of free space.

Measure after analysis. Measures free space after analysis ends.
Enter the estimated free space measurements.

Analysis Conditions (continued)

Analysis Conditions for Physisorption and Chemisorp-
tion
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4 Parameter Files

Selections Description

Measure before analysis. Select if the free space is to be
measured before the analysis begins.

n Lower Dewar for evacuation. If the Dewar is to be lowered for evac-
uation, select this option and enter the length of time for evacuation
after the free space measurement in the Evacuation time field. If
using a cryostat, the operator must manually move the cryostat
assembly when prompted.

n Outgas test. Checks for system leaks or sample outgassing. After
free space is measured, the Dewar is lowered and the sample evac-
uated for the specified amount of time. The leak test is performed
after evacuation. If the pressure rises more than 0.025 mmHg within
the time specified in theOutgas test duration field, outgassing is
present. If a leak is found, the leak test repeats nine times, with 30
minutes evacuation between tests. If the 10th leak check fails,the ana-
lysis stops and the operator is notified. While leak testing slightly
increases analysis time, it prevents the continuation of analysis and
collection of erroneous data if a leak occurs.

p° and Temperature
Options [button] 

How the saturation pressure (P0) is to be measured or calculated and
the analysis bath temperature.

Analysis Temperature Options. Select an option to enter analysis

Analysis Conditions (continued)
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Selections Description
temperature manually, or choose to have it automatically calculated
from p° or P0.

p° Options. Select one option indicating how P0 is to be measured or
calculated. If using a cryostat, Calculate p0 from the analysis
temperature should be selected.

Psat Gas. If choosing to measure the P0 for each isotherm point using a
gas other than the adsorptive, select the P0 gas from the drop-down list,
then click Edit to modify the P0 adsorptive properties. Refer to the
Adsorptive drop-down list earlier in this table for details on editing this
window.

Preparation
[button]

Evacuation rate / time level, leak test and time values, elevator prompts,
and in situ degassing or activation.

To insert chemisorption tasks, see Chemisorption Tasks
on page 4 - 13.

Physisorption Chemisorption
Backfill and match transducer. Backfills the sample tube to
760 mmHg at the beginning of the analysis and to recalibrate the sample
port pressure transducer scale to match the manifold pressure
transducer. Select the backfill gas to be used.

Degas in situ. Degases the sample on the analysis port prior to

Analysis Conditions (continued)

Analysis Conditions for Physisorption and Chemisorp-
tion
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4 Parameter Files

Selections Description

analysis.

n Evacuation Temperature. Temperature of the sample during evac-
uation.

n Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This feature prevents damage to the
sample structure due to 'steaming,' as well as sample elutriation due
to excessive escaping gas velocity.

n Ramp Rate. Rate at which the temperature is to change when advan-
cing to the target temperature. 

Elevator. Select the appropriate elevator control option.

n Automatic. The elevator is raised and lowered automatically.
n Wait for operator. Prompts the operator to set the elevator or ana-

lysis bath to the preferred height. When the prompt is acknowledged,
the analysis will continue. This option should be used if the analysis
bath must be placed manually in the preferred position, or the elev-
ator must be raised to a height other than the standard analysis
height.

n Do not move. Use to have the analysis proceed without pausing or
moving the elevator. This option should be used when the analysis
bath is already in position and should not be moved during analysis. If
Unit [n] > Enable CryoStat is enabled, the elevator option is auto-
matically set to Do not move.

Evacuate and Hold.When selected, the evacuation will evacuate and
then hold at the vacuum level. The option will disable unrestricted
evacuation.

Evacuation rate. The rate for restricted evacuation.

Evacuation time. The length of time for preliminary evacuation. If this
field is blank, the time entered in the Pre-analysis evacuation field on the
Analysis Conditions window is used.

In situ activation. When selected, preparation steps will be
done. If not selected, the task table is disabled and analysis starts after
the preliminary evacuation.

Leak Test. Enables the system to check for leaks or sample

Analysis Conditions (continued)
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Selections Description

outgassing before the analysis. The leak test allows sample pressure to
rise during the test. If the pressure rises more than 0.15 mmHg, the
analysis does not proceed and the operator is notified. While leak
testing slightly increases analysis time, it prevents the continuation of
analysis and collection of erroneous data if a leak exists.

Leak test duration. Enter the duration of the leak test.

Vacuum level. The pressure for unrestricted evacuation.

Unrestricted evac. from. The pressure at which unrestricted
evacuation is to begin. This option is enabled when Fast evacuation is
not selected.

Pre-analysis
evacuation time
[text box]

Evacuation is required prior to analysis. The default setting is 30
minutes.

Preparation. Use to set the evacuation rate, unrestricted pressure, and
setpoint.

Temperature. Use to set the temperature and ramp rate.
Repeat analysis
[selection]

Pressure at which heating will stop and hold the sample temperature
approximately constant until the pressure falls below the Hold pressure.
This feature prevents damage to the sample structure due to 'steaming,'
as well as sample elutriation due to excessive escaping gas velocity.

Set external trigger
during data col-
lection

If selected, the contact closure used to trigger an external mass spec-
trometer or Calorimeter will be activated. If deselected, the contact clos-
ure will be deselected. Chemisorption option is required.

Temperature
[button]

Provides access to furnace and accessory temperature control.

Analysis Conditions (continued)

Analysis Conditions for Physisorption and Chemisorp-
tion
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Selections Description
Furnace temperature control. Enter the analysis temperature rate.

Accessory temperature control. For user supplied temperature
control only. Enter the intended analysis temperature. The operator will
be prompted to establish the analysis temperature before analysis
begins.

Termination
[button]

Select the backfill gas if backfill is to be done after the analysis.

If using a cryostat, deselect Backfill after analysis.

Physisorption Chemisorption

Cool to less than 50 °C. Select to enable the cool down option.  

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Analysis Conditions (continued)
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CHEMISORPTION TASKS

File > Open > [.SMP File] > Analysis Conditions tab > Preparation > Insert

To ensure safe operation and reliable results, an evacuation task should be included:

n between tasks using different gases.
n preceding a leak test.

An evacuation will be performed at the analysis temperature for the Pre-analysis Evacuation Time
after the last task and before analysis.

Task Description
Evacuation
[selection]

Evacuate for [n] min below [n] kPa or Pa. The minutes and pressure

Chemisorption Tasks for Gas Adsorption

Chemisorption Tasks
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Task Description
for preliminary evacuation.

Evacuation rate [n] kPa/s. The rate for restricted evacuation.

Temperature [n] °C or K. The temperature to reach during evacuation.

Temperature rate [n] °C/min or K/min. Enter the analysis temperature
rate.

Unrestricted evac. pressure [n] kPa. The pressure at which
unrestricted evacuation is to begin. This option is enabled when Fast
evacuation is not selected.

Flow Task [selection]

Flow rate [n] cm3 STP/min.The rate at which gas is to flow.

Gas.Gas used for the flow task.

Set external trigger. [check box] If selected, the contact closure used
to trigger an external mass spectrometer or Calorimeter will be
activated. If deselected, the contact closure will be deselected.

Temperature [n] °C. The temperature at which the gas will flow for the
specified time.

Temperature rate [n] °C/min. Enter the analysis temperature rate.

Time [n] min. The duration of time the sample should remain at the
specified temperature.

Chemisorption Tasks for Gas Adsorption (continued)
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Task Description
Leak Test Task
[selection]

Outgas rate limit[n] kPa/min. If a measured leak or outgas rate
exceeds the entered value, the test will be reported as failed. Analysis
will not be canceled.

Temperature [n] °C. The target temperature for the leak test.

Temperature rate [n] °C/min.Enter the analysis temperature rate.

Chemisorption Tasks for Gas Adsorption (continued)

Chemisorption Tasks
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Task Description
Soak [selection]

Gas.Gas used during the soak task.

Minimum pressure [n] kPa. The minimum pressure to be maintained
over the sample during the soak.

Temperature [n] °C. The temperature at which sample is to be soaked.

Temperature rate [n] °C/min. Enter the analysis temperature rate.

Time [n] min. The duration of time the sample is to soak at the specified
temperature.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Chemisorption Tasks for Gas Adsorption (continued)
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EVACUATION RULES FOR CHEMISORPTION

Evacuation parameters apply to all four stages of evacuation with the exception of evacuation
time. Evacuation time is set using the fields specified in the following evacuation rules.

When an analysis starts, evacuation begins at:

1. Ambient temperature before the first preparation step. This step uses the Evacuation time
field on the Preparation Options window.

2. Analysis temperature after preparation and prior to the start of the analysis stage. This step
uses the Pre-analysis evacuation time field on the Analysis Conditions window.

3. Analysis temperature before the repeat analysis if Repeat analysis is selected on the Ana-
lysis Conditions window. This step uses the Repeat Analysis / Evacuation time field.

4. Analysis temperature before the free space measurement. This step uses the Evacuation
time field on the Free Space Options window.Measure after analysismust be selected to
enable the Evacuation time field.

Evacuation Rules for Chemisorption
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ANALYSIS CONDITIONS FOR DYNAMIC ANALYSIS
File > Open > [.ANC File]
Analysis conditions specify the parameters used to guide an analysis.

Selections Description
Analysis Conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Baseline [button] Specifies baseline settings if aWait step depends upon the Baseline.

Analysis Conditions for Dynamic Analysis
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Selections Description

Establishes the Slope or Acceleration threshold and Duration for
determining what constitutes a Stable Baseline, a Change From
Baseline, and a Return To Baseline. These values control whether a
particular change in the signal is significant to the current
experiment, such as defining a stable baseline.

SomeWait steps are contingent upon the values selected, such as if
the experiment contains aWait until Baseline is stable step, the
signal is compared to these values to determine if a stable baseline
has been established. Lower slope/acceleration values and longer
durations create a more rigorous definition of these factors than
higher values and shorter durations.

Stable Baseline. [group box] Detected when the signal slope is
below the threshold for the indicated duration.

Change from Baseline. [group box] Detected when the signal
acceleration exceeds the threshold for the indicated duration.

Return to Baseline. [group box] Detected when the signal
acceleration falls below the threshold for the indicated duration.

Analysis Conditions for Dynamic Analysis (continued)

Analysis Conditions for Dynamic Analysis
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Selections Description
Insert [button] Inserts a new step into the experiment. Steps can be inserted after

the analysis has started by suspending the analysis.

See Insert Experiment Steps on the facing page.

To ensure safe operation and reliable results, a chemically inert gas
flow should be inserted between flows of two chemically reactive
gases such as hydrogen and oxygen.

Insert Analysis
Conditions [button]

Click to load an entire list of steps, baseline parameters, and peaks
parameters from the selected dynamic analysis conditions file.

Step Detail [group box] Displays summary information about the highlighted experiment
step.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Analysis Conditions for Dynamic Analysis (continued)
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INSERT EXPERIMENT STEPS

Experiments can be customized to control the analysis reaction. When an experiment is inserted,
the initial conditions are specified first, then the individual steps.

1. On the Analysis Conditions tab, click Insert to insert an experiment.
2. Select the experiment step in the box.
3. Click Edit to modify settings. An analysis set is created by inserting up to 99 experiments in

the sample file.

To edit steps that have not started, the analysis must be suspended.

n Upcoming steps - display as black or blue
n Current step - step is highlighted and displays as light blue
n Completed steps - display as light green

The DDE Command step andWait for synchronization message option in the Wait
step are no longer supported.

Note that Loop Calibration, Loop Gas, Inject loop gas, and Loop Valve selections are
only applicable to analyzers that have the Loop option. Do not select these for
analyses to be performed on an instrument without the Loop option.

Data from one experiment are not available for editing until the next experiment in the
analysis has begun recording.

Insert Experiment Steps
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4 Parameter Files

Selections Description
Dose

Injection Type:

n Inject loop gas [button]. Automatically injects the contents of the
loop into the path that leads to the sample. The contents of the
loop are pushed out of the loop by the carrier gas.

n Manual injection [button]. Prompts the user to inject a dose of
gas into the septum using a syringe.

After Injection. Specifies the conditions for completion of this step.
Experiment

Description [text box]. Description of the experiment.

Enable Detector [check box]. Enables the Filament temperature
field and enables the thermal conductivity detector (TCD).

Filament temperature [n] °C [text box]. Set the filament
temperature from 20 °C to 250 °C. A temperature of 175 °C is
commonly used.

Type of analysis [drop-down box]. See Analysis Types for
TCD Analyzers on page 2 - 31.If Pulse Chemisorption is selected,
the Stoichiometry button is enabled. When modifying the Active
Metals table during the insertion of a Pulse Chemisorption
experiment, changes to the Active Metals table on the Sample
Description tab are not affected. This is useful when sequencing

Experiment Fields
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Selections Description
multiple experiments and Stoichiometry is different from one
experiment to the next.

Flow with
Temperature Ramp

Flow Rate [n] mmol/min [text box]. The rate at which gas is to flow.

Gas [drop-down box]. Gas used for the flow task.

Set external trigger [check box]. If selected, the contact closure
used to trigger an external mass spectrometer will be activated at the
beginning of the experiment.

Temperature [n] °C [text box]. The temperature at which the gas will
flow for the specified time.

Temperature rate [n] °C/min. Enter the analysis temperature rate.

Time [n] min [text box]. The duration of time the sample should
remain at the specified temperature.

Gas Flow Carrier Gas / Loop or Injection Gas [drop-down box]. Select the
gas for each set of inlet ports. The gases listed are those with defined
adsorptive properties. If manual injections are to be programmed,
the gas to be injected must be selected as Loop or Injection gas. If
loop injections are to be programmed, this gas must be connected to
a loop gas inlet and assigned in Unit [n] > Unit Configuration. See
Configure the Analyzer on page 2 - 15.

When an analysis is started, the application verifies that the selected
gases are connected to the appropriate ports. If there is a
discrepancy between a gas selected for the current sample file and
the gases indicated in the Unit Configuration window, an error
message is displayed.

Flow rate [n] mmol/min [text box]. The rate at which gas is to flow.

Experiment Fields (continued)
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Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 4 - 23



4 Parameter Files

Selections Description
Cold trap valve. Select the status of the cold trap valve: Bypass or
Trap.

Loop valve. Select the status of the loop valve: Fill or Inject.
Loop Calibration Use to calibrate the gas injection loop.

This experiment verifies the exact volume of the loop for use in
calculations on analyses in which the loop is used. Sample analysis
data yield signal vs. time or temperature data and peak areas. After
the analysis, select the Loop Calibration report and enter the Loop
volume from the report on the Unit Configuration window. Entering
the calibrated Loop volume on the Unit Configuration window makes
it possible for the application to convert sample data to volume
values. See Loop volume located in Specify Gas Ports on page 2
- 15.

Description [text box]. Description of the experiment.

Calibration Gases. Select the Carrier and Loop gases to be used in
this calibration. The gases available are those specified in an
Adsorptive Properties [.ADP] file. See Adsorptive Properties on
page 4 - 2 andGas Charts on page I - 1 for gas combinations.

Flow rate [n] mmol/min [text box]. The rate at which gas is to flow.

Filament temperature [n] °C [text box]. Set the filament
temperature from 20 °C to 250 °C. A temperature of 175 °C is
commonly used.

Loop thermal equilibration [n] min [text box]. Specify the duration
of the equilibration delay. This delay allows extra time for the
instrument to stabilize thermally after the baseline has fully
stabilized.

Experiment Fields (continued)
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Selections Description
Number of injections [n] [text box]. Indicate the number of gas
injections to be made into the gas stream.

Set external trigger [check box]. If selected, the contact closure
used to trigger an external mass spectrometer will be activated.

Set Detector

Enable detector [check box]. Enables the Filament temperature
field and enables the thermal conductivity detector (TCD).

Filament temperature [n] °C [text box]. Set the filament
temperature from 20 °C to 250 °C. A temperature of 175 °C is
commonly used.

Set External Trigger

Set external trigger [check box]. If selected, the contact closure
used to trigger an external mass spectrometer or Calorimeter will be
activated. If deselected, the contact closure will be deselected.

Start Recording

Specifies how frequently the signal reading is recorded. A Stop
Recording step is inserted in the steps automatically when a Start
Recording step is inserted. Multiple steps can be inserted between

Experiment Fields (continued)
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4 Parameter Files

Selections Description
the Start Recording and Stop Recording steps.

One measurement every [n] seconds. [text box] Specify the
frequency of measurements.

If a Start Recording step is immediately followed by a
step that prompts an immediate peak, peak data are
recorded before any baseline readings can be col-
lected. To collect some baseline data before the first
peak, insert aWait for [n] minutes step after the Start
Recording step but before the step which causes the
peak.

Start Repeat

Specifies the duration of the repeat sequence. Automatically inserts
a Start Repeat and a Stop Repeat in the list of steps. Multiple
experiment steps can be inserted within the Repeat loop.

Repeat until peaks are equal or [n] times. [button] Stops
repeating the steps within the loop when the last two peaks are equal
to within 5% of the area, or when the maximum number of repeats is
reached. This option is useful when performing H2 or CO pulse
chemisorption on supported metal catalysts.

Repeat until peaks are zero or [n] times. [button] Stops repeating
the steps within the loop when the last two peaks are each less than
10% of the area of the first peak, or when the maximum number of
repeats is reached. This option is useful when performing an N2O
decomposition for characterizing copper catalysts.

Repeat [n] times. [button] Stops repeating the steps within the loop
when the specified number of times is reached.

Repeat until peaks match the first peak or [n] times. [button]

Experiment Fields (continued)
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Selections Description
Stops repeating the steps within the loop when the last two peaks
each match the first peak to within 10% of its area or when the
maximum number of repeats is reached.

Temperature Ramp Changes the sample temperature.

End temperature [n] °C. [selection] The ending temperature for the
ramping procedure. If the CryoCooler is installed, it is automatically
enabled if an ending temperature below 20 °C is used.

Furnace ramp. [button] Ramps the furnace temperature directly to
the End Temperature, ignoring the sample temperature.

Hold time [n] min. [selection] How long the sample is to be held at
the specified temperature before beginning to cool down.

Ramp rate [n] °C/min. [selection] The rate at which the temperature
will change while advancing to the hold temperature.

Return to ambient. [button] Allows the furnace temperature only
(not the sample temperature) to return rapidly to a temperature to
below 45 °C.

Sample ramp. [button] Ramps the sample temperature to the End
temperature. The actual furnace temperature is adjusted to meet this
target.

Experiment Fields (continued)
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4 Parameter Files

Selections Description
Termination

Carrier / Reference / Loop Gas. [drop-down box] Select the gas to
be used during the termination stage of the analysis.

Enable detector. [check box] Enables the Filament temperature
field and enables the thermal conductivity detector (TCD).

Filament temperature [n] °C. [selection] Set the filament
temperature from 20 °C to 250 °C. A temperature of 175 °C is
commonly used.

Flow rate [n] mmol/min. [selection] The rate at which gas is to flow.

Return to ambient temperature. [check box] Allows the furnace
temperature only (not the sample temperature) to return rapidly to a
temperature between 14 °C and 50 °C.

Set external trigger. [check box] If selected, the contact closure
used to trigger an external mass spectrometer or Calorimeter will be
activated. If deselected, the contact closure will be deselected.

Valves Sets the cold trap valve and the loop valve as specified.

Experiment Fields (continued)
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Selections Description
Wait Specify a waiting routine.

Wait [n] minutes. [selection] Specify the time to wait.

Wait for change from baseline or [n] minutes. [button] Specify
the time to wait, clickOK, then click Baseline to specify the settings.

Wait for operator. [button] Enter a description of the operator task.
During an analysis, the entered message displays at the appropriate
time. The analysis continues after the operator clicksOK.

Wait for return to baseline. [button]Waits for a return to baseline.
If enabled, clickOK, then click Baseline to specify the settings.

Wait until Baseline is stable. [button] Specify if the analysis should
wait until the baseline becomes stable, then click Baseline to specify
the settings.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Experiment Fields (continued)

Insert Experiment Steps

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 4 - 29



4 Parameter Files

DEGAS CONDITIONS
File > Open > [.DEG File]
Or, click the Degas Conditions tab when using Advanced option presentation.

Use this option only when the Smart VacPrep is installed. Degassing is a required
step in preparation for an analysis. The Degas Conditions tab provides settings that
will be automatically applied during the degassing procedure when using the Smart
VacPrep.

The Degas Conditions tab displays only if enabled inOptions > Option
Presentation > Show Degas Conditions.

The Smart VacPrep Operator Manual can be found on the Micromeritics web page
(www.micromeritics.com).

Selections Description
Copy QuickStart
degas conditions
from Smart VacPrep
Unit [drop-down box]

Use to copy the degas conditions settings from the selected
Smart VacPrep unit and port.

Degas conditions
[drop-down box]

Use to browse for a .DEG file that contains degas condition para-
meters to be used in the analysis.

Degas Conditions
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Selections Description
Heating Phase [table] This option is applicable when degassing with a Smart VacPrep. Enter

up to five stages of degas conditions.

Temperature. Temperature at which the sample is to be held while
degassing.

Time. How long the sample is to be held at the specified temperature
before beginning to cool down.

Temperature Ramp Rate. The rate at which the temperature will
change while advancing to the hold temperature.

Smart VacPrep
Evacuation
[group box]

Backfill sample tube. Indicate if the sample tube should be backfilled
automatically or wait for operator response.

Evacuation rate. Rate used for evacuation.

Evacuation time. Length of time for preliminary evacuation before
proceeding with the Heating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This prevents damage to the sample
structure due to 'steaming' and /or elutriation due to excessive
escaping gas velocity.

Target temperature. Targeted temperature for evacuation.

Temperature ramp rate. Rate at which the temperature is to change
when advancing to the target pressure.

Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Degas Conditions (continued)
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4 Parameter Files

REPORT OPTIONS

File > Open > [.RPO File]
Or, click the Report Options tab when in Advanced option presentation.

Selected Reports on page 8 - 1

Additional reports are available using the Reportsmenu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column
headings, and components of thickness curve equations. These files may contain tabular reports,
plots, or both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.

Physisorption and
Chemisorption Dynamic Analysis
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Selections Description
Apply thermal
transpiration
correction
[check box]

Use to correct the temperature-induced pressure difference between
the manifold and the chilled sample tube. This option is most sig-
nificant for pressures less than approximately 1.0 mmHg.
Always use thermal transpiration when performing micropore
analyses.

Inside diameter of sample tube. Enabled when Apply thermal
transpiration correction is selected. Enter the inside diameter of the
sample tube used in the analysis.

Refer to the Thermal Transpiration Correction section of the
Calculations document.

Overlays [button] SeeGraph and Sample Overlays on page 7 - 32.

Report options
[drop-down box]

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected Reports
[group box]

Select the report names to include in the report. For BJH reports, BJH
pore dimension can be calculated in pore width (w), pore radius (R), or
pore diameter (D). Go to Options > Units to specify default
calculations.

Show graphic
[text box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Report Options

Report Options
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4 Parameter Files

SAMPLE TUBE
File > Open > [.STB File]
Perform a Sample Tube Free Space Analysis

Or, click Edit next to the Sample Tube selection on the Sample Description tab when in Advanced
option presentation.

Sample Tube files specify information about the sample tube.

Selections Description
Ambient free space
[text box]

Empty sample tube gas capacity measured at room temperature.

Analysis free space
[text box]

Empty sample tube gas capacity measured with the Dewar raised.

Load from Sample
File [button]

Loads parameters from the selected sample file.

Sample tube
[drop-down box]

It is a good practice to label each sample tube with a unique iden-
tification. Enter that information here. This information will also appear
in the Sample Tube drop-down list on the Sample Description tab.

Use filler rod
[check box]

Select if a filler rod is to be used in the sample tube. A filler rod reduces
the stem free space volume resulting in reduction of free space error. It
is generally a good practice to use filler rods for samples having less
than 100 square meters of total surface area.

Sample Tube
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Selections Description
Use isothermal jacket
[check box]

Select if an isothermal jacket is to be used. An isothermal jacket main-
tains a constant temperature profile along the sample tube stem during
an extended analysis of more than 1 or 2 hours.

Vacuum seal type
[group box]

Select the seal type to be used.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Tube (continued)
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5 DEGASSING

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere.
The sample must be clean when an analysis is performed. The degas process heats the sample
to remove the moisture and contaminants.

After the sample has been weighed, degas the sample on:

n the analysis port (see Degas in Situ on page 5 - 3),
n a Smart VacPrep. The Smart VacPrep Operator Manual can be found on the Micromeritics web

page (www.micromeritics.com), or
n a user supplied degasser.

The Check Seal or TranSeal sample tube closures can be used with the Smart VacPrep to
minimize sample contamination when transferring the sample tube from the Smart VacPrep to the
analyzer port.

n If using the TranSeal, refer to the instructions included with the TranSeal [part num-
ber 350-42803-00].

n If using the Check Seal, see the instructions included with the Check Seal [part
number 350-42802-00].

5 Degassing
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5 Degassing

BACKFILL PORTS
Unit [n] > Backfill Ports
Use to backfill ports with gas.

Physisorption Chemisorption or Dynamic Analysis
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DEGAS IN SITU
Unit [n] > Sample Analysis
Most solid materials absorb moisture and other contaminants when exposed to the atmosphere.
The sample must be clean when an analysis is performed. The degas process heats the sample
to remove the moisture and contaminants.

Physisorption samples can be degassed on either the analyzer's analysis port (in situ) or on a
separate device such as a Smart VacPrep. Degassing should be performed prior to starting
analysis.

Samples containing excessive amounts of moisture or significant amounts of other
contaminants must be degassed on a separate degas system before attaching to the
analyzer to prevent contamination of the analyzer high vacuum system.

Microporous samples should receive a secondary in situ degas on the analyzer to
remove any moisture readmitted during transfer from the separate degas system to
the analyzer.

When the degas is completed, observe the temperatures on the analyzer schematic. When the
mantle has cooled, the Sample Analysis window will display a prompt to remove the degas
heating mantle, properly position the isothermal jackets and Dewar cover, then install the Dewar.

If using the heating mantle option, remove the heating mantle (it is not necessary to unplug the
mantle), support the bottom of the tubes, then remove the mantle cover.

To prevent potential burns, do not touch the sample tube or the heating mantle until
they have cooled below 45 °C.

Degas in Situ
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5 Degassing

TRANSFER A DEGASSED SAMPLE TO AN ANALYSIS PORT
Sample Data Worksheet for Gas Adsorption on page O - 2

When degassing on a separate degasser such as a Smart VacPrep, the sample tube must be
removed from the degas port, weighed, and then installed onto the analysis port for analysis.

If the sample tube is not mounted on the analysis port immediately, leave it on the
degas port. If it is necessary to remove the sample tube and a Check Seal or TranSeal
was not used, insert a rubber stopper into the sample tube.

1. Allow the sample tube to cool to room temperature (approximately 15 minutes).

Do not touch the sample tube or the heating mantle until they have reached room
temperature. Touching the sample tube, heating mantle, or heating mantle clip before
they have cooled could result in burns.

2. Carefully remove the heating mantle clip and the heating mantle from the sample tube.
3. While holding the sample tube, loosen the port connector nut and remove the sample tube

from the degas port. If a Check Seal or TranSeal was not inserted prior to degassing, imme-
diately insert a rubber stopper into the sample tube.

4. Complete the Sample Data Worksheet.
5. If using a Check Seal, ensure that the Check Seal opener is installed in the analyzer sample

port. If a rubber stopper was used, remove the stopper from the sample tube.
6. bulb
7. Place the connector nut, ferrule, and O-ring onto the sample tube stem.
8. On the analyzer, loosen the connector nut on the Psat tube and rotate it out of the way.
9. Position the Dewar cover so that the slot for the Psat tube is on the left between port 1 and

port 2.
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A. P0 slot
B. Connector nut
C. Ferrule
D. O-ring
E. Dewar cover

10. Insert the sample tube through one of the holes in the Dewar cover.
11. Place the sample port nut, ferrule, and O-ring onto the sample tube stem.
12. Insert the sample tube into the analysis port and ensure it is completely in the port. Securely

hand tighten the sample port nut onto the analysis port.
13. Repeat all previous steps for each sample tube.
14. Position the Dewar cover approximately 3/4 in. (19 mm) below the sample port nut.
15. Slide the Psat tube into the Psat slot in the Dewar cover and retighten the Psat tube

connector nut.

Transfer a Degassed Sample to an Analysis Port
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5 Degassing

A. O-ring (1/4 in. from top)
B. Ferrule
C. Connector nut
D. Isothermal jacket

16. If degassing a sample on the sample port, see Degas in Situ on page 5 - 3. Otherwise,
place the Dewar cover over the sample tube stem just above the isothermal jacket. Ensure
the P0 tube is next to the sample tube. Refer to the image in step 9.

17. Install the Dewar onto the elevator and place the safety shield over the sample tube and
Dewar.

18. Begin the analysis.
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DEGAS ON THE SMART VACPREP
Equipment Options and Upgrades on page 1 - 4

The Smart VacPrep Operator Manual can be found on the Micromeritics web page
(www.micromeritics.com).

Degas on the Smart VacPrep
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5 Degassing

EVACUATE PORTS
Unit [n] > Evacuate Port

Physisorption Chemisorption or Dynamic Analysis

Selections Description
Evacuation Options
[group box]

Evacuation rate. The maximum rate of change of pressure when
evacuating the sample tube.

Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

Backfill Gas. Select the backfill gas from the drop-down list.
Evacuate Port[s]
[group box]

Select the ports to evacuate.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Evacuate Ports
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6 PERFORM AN ANALYSIS

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.

6 Perform an Analysis
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6 Perform an Analysis

DEWAR PRECAUTIONS

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

When handling Dewars containing liquefied gases or cryogenic liquids:

n Wear protective equipment:
o goggles or face shield
o an insulated or rubber apron
o insulated gloves

n When pouring liquefied gases from one container to another:
o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

FOR GLASS DEWARS

n Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases (or
other materials of extremely low temperature). Do not use a glass or metal stirring rod unless it
has a protective coating.

n Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the
Dewar opening. If an object of sufficient weight is accidentally dropped into the Dewar, shat-
tering may occur.

n If the Dewar has a protective mesh covering, do not remove it. This cover minimizes the risk of
flying particles should the Dewar be knocked over, dropped, or broken.
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MIXING AN IPA/LN2 SLURRY

An isopropyl alcohol (IPA) /liquid nitrogen (LN2) slurry is used to maintain cold trap
temperatures of approximately -80 °C. Improperly mixing an IPA/LN2 slurry could
cause injury. If the mixture is not stirred continuously, gas may build up under the sur-
face, causing the liquids to splash out of the Dewar.

1. Chill a 600 mL Dewar by rinsing it with LN2. Allow a small amount of LN2 to remain in the bot-
tom of the Dewar (approximately 1 cm deep).

2. Stirring constantly, slowly add approximately 500 mL of IPA. For greatest safety, use
a laboratory squirt bottle. Squirt the stream of IPA along the inside edge of the Dewar, close
to the top of the Dewar, allowing the IPA to flow down the inside wall of the Dewar. Do not
stop stirring the mixture in the bottom of the Dewar, even if stirring becomes difficult. As stir-
ring and adding IPA continues, the mixture will loosen and become easier to stir.

3. When all the IPA has been placed in the Dewar, slowly begin pouring LN2 into the Dewar.
Approximately 1 liter is needed. Continue to stir the mixture as LN2 is added. As ice chunks
form, break them up and stir them down into the mixture. Avoid splashing. Gently knock ice
chunks away from the sides of the Dewar and continue stirring. Add liquid nitrogen until the
slurry is within 25 mm (1 in.) of the top of the Dewar.

4. Lift the stirrer out of the slurry and observe as the slurry drips into the Dewar; the
stirrer should be thickly coated with slurry.

The goal is to achieve a slurry that has a thick, syrupy consistency without large chunks.
When the slurry is cold enough, small pieces of ice may be present (10 - 20% of the
mixture). A little ice accumulation along the sides of the Dewar is acceptable.

DYNAMIC ANALYSIS
To surround the cold trap, the Dewar must rest on a small stand. Hold the Dewar beneath the cold
trap, then raise it to slide the stand underneath the Dewar. Lower the Dewar until it rests on the
stand. Ensure the cold trap is immersed.

Mixing an IPA/LN2 Slurry
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6 Perform an Analysis

PREPARE FOR ANALYSIS
It is recommended to perform the tasks in the provided order.

Dewar Precautions on page 6 - 2

Step 1 - Clean and Label Sample Tubes on the facing page
Step 2 - Create Sample Files on page 3 - 2
Step 3 - Determine the Sample Mass for Physisorption on page 6 - 8 or
Determine the Sample Mass for Chemisorption on page 6 - 13
Step 4 - Degas the Sample on page 6 - 20
Step 5 - Sample Tube Installation for Physisorption on page 6 - 10
Step 6 - Fill and Install the Dewar on page 6 - 21

For dynamic analyses that include manual or loop injections of a chemically
active gas, selection of an active gas/inert gas pair is required. The gas to be injected
may be a blend of chemically active gas and inert gas, or a pure active gas. If a blend
is used for injections, the inert gas in the blend should be the same as the carrier gas.
See Adsorptive Properties on page 4 - 2 andGas Charts on page I - 1. The inert
carrier gas should be selected to have a very different thermal conductivity from the
active gas so as to provide a large change in the thermal conductivity detector signal,
for instance helium (inert, T.C.=5.84) with carbon monoxide (active, T.C.=0.97) or
argon (inert, T.C.=0.68) with hydrogen (active, T.C.=7.07). The selected carrier gas
must be connected to one of the 12 primary gas inlets on the rear panel of the
instrument. For manual injections, the gas to be injected must be connected to an
external septum (provided in the accessory kit) to allow filling the syringe. For loop
injections, the gas to be injected must be connected to one of the four loop gas inlets
on the side of the instrument. Be sure to enter the mnemonics for the connected
gases under Specify Gas Ports on page 2 - 15.
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CLEAN AND LABEL SAMPLE TUBES

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The
following table indicates which materials are needed for cleaning. The procedures following the
materials list are recommended.

Supplied by Micromeritics Supplied by User

n Filler rod
n Funnel
n Sample data worksheet
n Sample tube
n Sample tube brush
n Sample tube rack
n Sample weighing support (required for

chemisorption sample tubes)
n Stopper for sample tube (Check Seal, rubber

stopper, or TranSeal)

n Acetone or isopropyl alcohol
n Analytical balance
n Detergent (such as Alconox)
n Drying oven
n Forceps
n Insulated gloves
n Pipe cleaners
n Rubber gloves or clean, lint-free cloth
n Safety glasses
n Ultrasonic cleaning unit
n Waste container

1. Preheat drying oven to 110 ºC.
2. Verify that the ultrasonic cleaning unit is clean.
3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the

ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubes with warm water and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.

Clean and Label Sample Tubes
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6 Perform an Analysis

5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubes with the brush supplied with the analyzer.
7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl

alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in
the rack. Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high-purity acetone or isopropyl alcohol and
dried for about 10 minutes under heat. If using this method, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube
is installed on the analysis port.
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10. Blow out the sample tubes with oil-free compressed air.
11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry

with a clean, lint-free cloth.
12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper, Check Seal, or TranSeal.

Clean and Label Sample Tubes
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6 Perform an Analysis

DETERMINE THE SAMPLE MASS FOR PHYSISORPTION

Sample Data Worksheet for Gas Adsorption on page O - 2

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

There are several different surface area ranges that require different protocol for optimal results.

n If there is between 0.1 m2 and 1 m2 in the tube, follow the recommendations for balancing the
free space using glass beads, along with filler rods, and measure the resulting free space
difference.

n If there is between 1 m2 and 5 m2 of total surface under test, measure the free space difference
between the two tubes as a part of each analysis.

n If there is between 5 m2 and 30 m2, use the option to calculate the free space difference
between the two tubes using the density of the sample in the tube, along with the mass entered.
There are some special considerations when using the tubes with the cylindrical bulb on the
end as opposed to the straight-walled tubes.

n If there is more than 30 m2 in the tube total, it may not be necessary to determine the free
space difference between the two tubes as a part of the analysis.

Smaller quantities are required for samples having high surface areas. These samples require
careful weighing after degassing because a small error may represent a considerable percent of
total mass. Proper weighing techniques are most important in this case. Use no less than 100 mg
to reduce the effect of weighing errors.

Care should be taken when loading powders: the accessory funnel is useful for this purpose.
Large granules or chunks may be loaded with forceps.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is
important to know the true sample mass.

Follow the instructions on the Sample Data Worksheet and complete all fields to find the true
sample mass.

1. Record the sample tube identification on the Sample Data Worksheet.
2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize

at zero (0).
3. Place the empty sample tube set (empty sample tube and stopper) on the sample weighing

support and place it on the balance.
4. Record the stabilized mass on the Sample Data Worksheet. Remove the sample tube set

from the balance.
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Do not touch the sample with bare hands while performing the following steps. Doing
so could affect the accuracy of results.

5. Place a sample container on the balance. Tare the balance and allow it to stabilize to zero.
6. Slowly pour the specified amount of sample into the sample container.
7. Remove the rubber stopper, Seal Frit, Check Seal, or TranSeal from the sample tube.
8. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the

weighing container into the sample tube.
9. Replace either the rubber stopper, Seal Frit, Check Seal, or TranSeal.
10. On the Sample Data Worksheet, record the following:

n Mass of the sample tube set with the sample.
n Subtract theMass of empty sample tube set from theMass of sample tube set plus

sample.

Determine the Sample Mass for Physisorption
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6 Perform an Analysis

SAMPLE TUBE INSTALLATION FOR PHYSISORPTION

Sample Tube Installation for Chemisorption on page 6 - 16
Sample Tube O-ring Replacement on page 12 - 21

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Repeat the following steps for each sample to be installed.

If using... Then...
A rubber stopper Remove it.

An isothermal jacket Slide the jacket down over the stem of the sample tube until it
touches the sample tube bulb. The top of the isothermal jacket
should be aligned with the mark on the sample tube. If using sample
material, insert it into the sample tube.

A filler rod Hold the sample tube horizontally and carefully slide the filler rod into
the tube until the metal clip touches the end of the tube. If using a
hanging filler rod, the rod attaches to the Seal Frit.

Do not hold the rod vertically and drop the rod into the
tube as this could break the rod and/or tube.
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1. Loosen the connector nut on the Psat tube and rotate it out of the way.
2. If using a Check Seal, verify that the port has the Check Seal opener installed or if using a

TranSeal, install it at this time.
3. Position the Dewar cover so that the slot for the Psat tube is on the left between ports 1 and

2.

A. P0 slot
B. Connector

nut
C. Ferrule
D. O-ring
E. Dewar

cover

4. Insert the sample tube through one of the holes in the Dewar cover.
5. Place the sample port nut, ferrule, and O-ring onto the sample tube stem.
6. Insert the sample tube into the analysis port and ensure it is completely in the port. Securely

hand tighten the sample port nut onto the analysis port.
7. Repeat for each sample tube.
8. Position the Dewar cover approximately 3/4 in. (19 mm) below the sample port nut.
9. Slide the Psat tube into the Psat slot in the Dewar cover and retighten the Psat tube con-

nector nut.
10. Insert the jacket onto the Psat tube and ensure that the Psat tube jacket is below the Dewar

cover.

Sample Tube Installation for Physisorption
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6 Perform an Analysis

n If using the TranSeal, refer to the instructions included with the TranSeal [part num-
ber 350-42803-00].

n If using the Check Seal, see the instructions included with the Check Seal [part
number 350-42802-00].
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DETERMINE THE SAMPLE MASS FOR CHEMISORPTION

Use Quartz Filter Discs for Chemisorption on the next page
Sample Data Worksheet for Chemisorption on page O - 3

Bulb sample tubes are for pellets and other samples without loose particles. Using
powder samples in bulb tubes may cause the loose particles to go into the analyzer's
exhaust.

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Record the sample tube identification on the Sample Data Worksheet.
2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize

at zero.
3. If analyzing a powder or sample made of fine particles, push a piece of quartz wool all the

way down into the sample tube.
4. If using quartz wool, put a second piece of quartz wool just inside the sample tube.

If using filter discs, push a filter disc down into the tube until it sits on top of the quartz wool.
Place a second filter disc just inside the sample tube.

5. Place the sample tube set (sample tube with quartz wool or filter discs and stoppers) on the
sample support. Record the stabilized mass on the Sample Data Worksheet.

6. Remove the sample weighing support and sample tube set from the balance.
7. Place the sample container on the balance and allow the balance to stabilize at zero.

Do not touch the sample with bare hands. Oil from hands could affect the accuracy of
results.

Determine the Sample Mass for Chemisorption
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6 Perform an Analysis

8. Slowly add approximately 0.5 to 1.0 gram of sample to the sample container.
9. If a second piece of quartz wool or filter disc was inserted, remove the top portion of the

quartz wool or the filter disc from the sample tube.
10. Use a funnel to slowly pour sample from the container into the sample tube on top of the

quartz wool in the tube.

Ensure all sample in the container is placed in the sample tube to avoid errors caused
by incorrect sample mass.

11. If using quartz wool, insert the top portion of quartz wool into the tube and press it down.
If using filter discs, insert the filter disc into the tube and press it down.

Ensure the disc is flat on top of the sample. A seal must be created around the edge to
prevent the sample from escaping.

12. Wipe the top of the sample tube with a clean, lint-free cloth, such as a Kimwipe®, to remove
any quartz wool that may have adhered to the surface.

13. Weigh the sample tube set containing the sample and the stoppers. Record this mass as
the Sample + tube.

Use Quartz Filter Discs for Chemisorption

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

The use of quartz wool is not mandatory; however, it can provide extra protection for
light powdered samples.

Wear latex gloves when handling the quartz sample tube. The natural oils in human
skin can chemically damage and weaken the quartz tube. It is also important that the
sample tube and its components, as well as the sample and exhaust ports, be clean
and free of debris. Dust particles from quartz wool or the insulator disc of previous
analyses may adhere to the port and/or components, preventing a proper seal of the
sample tube.

Use quartz filter discs or quartz wool to aid in chemisorption sample preparation. Quartz filter
discs (placed both below and above powdered samples) not only provide a more uniform sample
surface but also keep the analyzer free of sample debris. The filters can be used up to 900 °C.
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1. Insert a small portion of quartz wool into the sample tube to serve as a support for the
powdered sample. Use a filler rod or smaller sample tube to push the quartz wool to the bot-
tom of the sample tube.

Insert quartz wool and disc Top disc, powdered sample, bottom disc,
quartz wool

2. Insert a quartz disc into the sample tube and push it into the tube until it rests on top of the
quartz wool. Inspect the disc to ensure that there is a good seal and that the sample will not
go past the filter. An additional filter can be inserted if needed.

3. Insert a second filter disc on top of the quartz wool. Ensure that the filter is placed high
enough into the sample tube for easy retrieval.

4. Take the initial tube weight (with both filters).
5. Remove the top filter disc. Place it on a clean surface, then use a funnel to add the

powdered sample on the bottom filter disc.
6. Reinsert the top filter disc into the sample tube, then use a rod or smaller sample tube to

push it down until it reaches the top of the sample.
7. To remove the quartz wool and disc after analysis, use the quartz wool extractor tool.

Determine the Sample Mass for Chemisorption
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6 Perform an Analysis

SAMPLE TUBE INSTALLATION FOR CHEMISORPTION

Sample Tube Installation for Physisorption on page 6 - 10

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Wear latex gloves when handling the quartz sample tube. The natural oils in human
skin can chemically damage and weaken the quartz tube. It is also important that the
sample tube and its components, as well as the sample and exhaust ports, be clean
and free of debris. Dust particles from quartz wool or the insulator disc of previous
analyses may adhere to the port and/or components, preventing a proper seal of the
sample tube.

Remove the plug from the exhaust port
and sample tube port #2

1. Remove the stopper from the sample tube stem and the cap from the exhaust stem.
2. Use a clean, lint-free swab moistened with IPA and wipe the interior rims of the sample and

exhaust ports.
3. Use a clean, lint-free tissue moistened with IPA and wipe the O-ring, ferrule, and connector

nuts for the sample and exhaust tubes. Place on a clean, lint-free tissue.

Sample and exhaust ports, as well as all components that contact the sample and
exhaust ports, must be clean, therefore it is recommended that the previous steps be
repeated each time a sample tube is installed onto a port.
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4. Remove the stopper from the sample tube stem and the cap from the exhaust stem.
5. If using a hanging filler rod (recommended), hold the sample tube slightly tilted and carefully

place the filler rod into the tube.

A. Quartz filler rod (for chemisorption analyses
B. Borosilicate glass filler rod (for physisorption analyses)

The quartz filler rod can be used for both physisorption and chemisorption analyses;
however, the borosilicate glass filler rod can only be used with physisorption
analyses. The quartz filler rod can be identified by the notch across the top of the rod.

Use of the borosilicate glass filler rod in a chemisorption analysis can cause damage
to the instrument.

6. Assemble and install the sample and exhaust tube components.

A. Connector nut
B. Ferrule
C. O-ring
D. Filler rod

7. Insert the assembled sample tube into the exhaust port and analysis port #2.
8. Slide the connector nuts up the stems and screw the nuts clockwise to secure the tube in

place.
9. Hand tighten both connector nuts until snug.

Sample Tube Installation for Chemisorption
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6 Perform an Analysis

10. Install clip and slide it up the sample
tube.

11. Ensure the thermocouple rests on the lip
on the back of the sample tube.

12. Rest the sample thermocouple tip on the lip on the back of the sample tube and install the
sample tube clip around the sample tube and thermocouple. Ensure the clip is high enough
on the sample tube to clear the furnace disk when the elevator and furnace are raised.

13. Ensure the furnace is on the elevator shelf and manually raise the elevator. To raise the
elevator, go to Unit [n] and ensure there is a check mark to the left of the chemisorption
option. If not, select Unit [n] > [Chemical Analysis] to select it.

14. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

15. On the schematic, right-click the furnace icon and select Raise to raise the elevator. If it is
necessary to stop the elevator, right-click the elevator icon again and select Stop.

16. When the elevator reaches the top, insert the two furnace disk halves on top of the furnace
opening.
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17. Place the first disk behind the sample tube and the second disk in front of the sample tube,
ensuring the clip remains above the furnace disks.

Sample Tube Installation for Chemisorption
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6 Perform an Analysis

DEGAS THE SAMPLE

If using the Smart VacPrep degasser, go to Smart VacPrep > Unit [n] > Start
Degas, then degas the sample using menu commands and information entered on
the Degas Conditions tab. The Smart VacPrep Operator Manual can be found on the
Micromeritics web page (www.micromeritics.com).

After the sample has been weighed, use a degassing unit to remove any contaminants which may
have adsorbed to the surface or pores. Appropriate degassing units are available from
Micromeritics.

After degassing is complete, perform the following steps:

1. Weigh the sample tube set containing the sample.
2. Record the mass on the Sample Data Worksheet asMass of Sample tube set plus sample

(After Degas).
3. Subtract theMass of empty sample tube set (Before Degas) from theMass of Sample tube

set plus sample (After Degas) to obtain the sample’s mass. Record this value asMass of
sample (After Degas).
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FILL AND INSTALL THE DEWAR

Dewar Precautions on page 6 - 2

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Fill the Dewar with the analysis bath liquid (such as liquid nitrogen) to no higher than
2 1/4 in. (5.7 cm) from the top. Filling the Dewar higher than this will cause an error in the
free space measurement.

Incorrect fluid levels can lead to measurement errors. Check the level of the bath
liquid before each analysis.

2. Insert the dipstick and check the level of the analysis bath liquid. Condensation should not
exceed the level indicator mark.

Fill and Install the Dewar
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6 Perform an Analysis

A. Wetness or frozen
condensation
indicates bath
liquid level

B. Level indicator
mark

3. For best results, if the Dewar has not been used for a while, allow approximately 30 minutes
for the temperature of the Dewar to stabilize with the bath liquid, then recheck the level of
the bath liquid. Add additional liquid if necessary.

4. Slide the Dewar cover to approximately 3/4 in. (19 mm) from the sample port nuts to ensure
a proper seal on the top of the Dewar.

5. Place the Dewar on the elevator.
6. Attach the safety shield to the brackets on the front of the analyzer.

Ensure the analyzer safety shield is in place before beginning an analysis. If the
analyzer is operated at an excessive pressure, the sample or balance tube could
become dislodged from its port, possibly causing personal injury or damage to the
equipment.
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PERFORM AN ANALYSIS SEQUENCE
Unit [n] > Analysis Sequence
Refill the Dewar during Analysis on page 6 - 45.

If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 × 10-6mmHg or lower.

Use to perform a sequence of analyses on port 2. If the Analysis Sequence option is selected and
a sequence analysis is already in progress, the program continues to run the four steps for the
analysis in progress. Files can be added and removed from the sequence while it is in progress.

The analysis sequence can run a:

n sequence of only physisorption files.
n physisorption analysis as a part of the chemisorption analysis sequence.
n physisorption file in any position in the sequence.

The physisorption live graph will be used for the physisorption analysis within a chemisorption
sequence.

Operator intervention will be required between analyses in the sequence if the temperature
control type changes. Intervention will be required if at the beginning of the analysis.

Perform an Analysis Sequence
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6 Perform an Analysis

1. Click Close Valves.
2. Click Insert and select a sample file.
3. Edit the fields below the sample file selections.
4. Click Save to save the selected files as an analysis sequence file (.SEQ) for future ana-

lyses.
5. Click Start to start the analysis. A window displays data as they are collected. A short delay

is encountered before the port status at the bottom of the window changes from the Idle
state.

6. When the analysis is complete, remove the sample tube and store (or dispose of) the
sample material as applicable.

Use caution when removing the sample tube if using a hanging filler rod. The sample
tube O-ring or Dewar cover may snag the filler rod retaining ring. Loosen the snag
gently; excessive force may break the tip of the filler rod.

Selections Description
Close Valves [button] Closes all valves on the unit.

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

Sample mass / Sample
+ tube mass / Tube
mass / Analysis free
space [text box]

Enter the values for the sample mass and free space.

Analysis Sequence
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Selections Description
Use CryoStat
[check box]

For cryostat use only. If using a cryostat, select and enter the Tar-
get Tolerance and Hold Time. The cryostat temperature will be
ramped (if ramp is enabled) to the sample analysis temperature.
Once the cryostat temperature is within the entered tolerance, the
analysis will wait for the hold time before proceeding.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Analysis Sequence (continued)

PERFORM A BLANK ANALYSIS
Unit [n] > Reference Analysis
Perform a Reference Material Analysis on page 6 - 31
Refill the Dewar during Analysis on page 6 - 45

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 × 10-6mmHg or lower.

The Blank Analysis is run in the same manner as a Reference Material analysis except a blank
method is selected and no sample material is placed in the sample tube.

Perform a Blank Analysis
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6 Perform an Analysis

PERFORM A MEASURE FREE SPACE ANALYSIS FOR PHYSISORPTION
Unit [n] > Measure Free Space
TheMeasure Free Space is run in the same manner as a regular analysis, but it will only measure
the free space. The other steps will be skipped. This analysis is used to quickly measure free
space.
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PERFORM A PULSE CHEMISORPTION ANALYSIS

This topic provides an example of Pulse chemisorption being performed on a sample
of Pt/Al2O3 with CO. Make the appropriate modifications for the material being
analyzed. Platinum Alumina Reference Material can be ordered fromMicromeritics.
Parts and accessories are located on the Micromeritics web page.

A Pulse chemisorption analysis determines the quantity of active gas irreversibly adsorbed. By
applying pulses of known quantity of active gas to the sample, calculations of active surface area,
percent metal dispersion, and active particle size can be made for supported metals. The sample
is dosed with the analysis gas using the injection loop or a syringe until all accessible active sites
are covered. The amount chemisorbed is the difference between the total amount of active gas
injected and the amount that does not interact irreversibly with the sample.

The number of injections depends on the quantity in each pulse and total number of active sites
present.

LOOP VOLUME
Environmental Defaults for TCD Analyzers on page 2 - 20

The gas quantity in each pulse is determined by active gas concentration, the loop or syringe
volume, temperature, and pressure. The loop temperature is controlled by the instrument. The
ambient (syringe) temperature and atmospheric pressure are entered by the operator. If a syringe
is used, the volume injected is determined by the operator. In general, it is desirable for the
sample to require at least two doses of gas, but no more than ten doses, before the reaction ends
(although this may vary from lab to lab). Some factors that influence the number of doses required
are sample size, the density of active sites, the concentration of active gas, and the size of the
loop.

A 0.5 cm3 loop is provided with the analyzer. There are also 1 cm3 and 5 cm3 loops available.

Perform a Pulse Chemisorption Analysis
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6 Perform an Analysis

LOOP CALIBRATION
For the most accurate determination of the injected gas quantity, a loop calibration experiment
should be performed. An independent loop calibration can be performed before or after the
analysis.

The following example assumes that the loop calibration will be performed after the analysis. A
Loop Calibration step can be included in a pulse chemisorption analysis.

Preparation
Pretreatment Degas by flowing inert gas (such as helium, argon, or nitrogen) over

the sample while ramping the temperature. Hydrogen of at least 10%
concentration is generally used for reduction.

Analysis Pulse the loop gas over the sample until the peak area remains con-
stant.

Cold or Sorption Trap The cold trap does not need to be cooled during the reference mater-
ial analysis. This may vary depending on application or analysis
method. The trap tube should remain on the instrument. Including
the trap in the flow path is optional.

Pressure regulator Gas cylinders should be set to a level between 14 and 16 psig (95
and 110 kPag).

Furnace temperature Select a temperature high enough to remove any contaminants or
moisture, but not so high as to cause sintering or fusing of the
sample. Ensure the Termination step is set to return the sample tem-
perature to ambient.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 6 - 4.
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PROCEDURE
1. Obtain the sample mass, then install the loaded sample tube and thermocouple on the ana-

lyzer. Raise the furnace around the sample tube and install the insulator disc and shield.
2. Create a new sample file for this analysis. In the Analysis Conditions drop-down box, select

either Pt-Al CO Pulse Chemisorption Loop or Pt-Al CO Pulse Chemisorption Syringe and
modify the steps as needed depending on the analysis to be performed.

3. On the Report Options tab, select the required report options for the analysis.
4. Save and close the file.
5. Go to Unit [n] > Sample Analysis and select the sample file saved in the previous step.

Chemisorption can only be performed on port 2, therefore Port 2 is the only selection avail-
able.

6. Click Start to start the analysis.
7. When prompted, select the calibrations associated with each experiment in the sample file

(if applicable). For this example, select None. Calibration files can also be associated with a
sample file after analysis using the Peak Editor. See Peak Editor for Dynamic Analysis
on page 7 - 10.

When the analysis ends, the furnace begins to lower the sample temperature to room
temperature. When the sample has cooled, open the furnace and remove the sample
tube.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

Perform a Pulse Chemisorption Analysis
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6 Perform an Analysis

GENERATE THE REPORT
Peak Editor for Dynamic Analysis on page 7 - 10

Open the Peak Editor and ensure that peaks are properly marked.

There are three possibilities for each dose of gas injected during:

n all of the gas is taken up by the sample,
n some of the gas is taken up by the sample, or
n none of the gas is taken up by the sample.

When Pulse chemisorption is properly performed, there will be some injections of each type.
When the data is viewed using the Peak Editor, however, only those injections in which some or
none of the gas is taken up will appear as peaks. When all of the gas is taken up by the sample,
none of it reaches the detector and, therefore, the peak area is zero. These types of peaks are
detected automatically by the application and do not require marking.

To generate the report, go to Reports > Start Report> [.SMP file created above] or click
Preview and select the signal view.
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PERFORM A REFERENCE MATERIAL ANALYSIS
Unit [n] > Reference Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Refill the Dewar during Analysis on page 6 - 45

If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 × 10-6mmHg or lower.

A reference material analysis is used to verify the analyzer is operating properly and producing
optimum results. These methods provide specifications for critical report quantities and reporting
of whether quantities are in or out of specification.

When running a reference material analysis, use the appropriate reference material provided in
the accessories kit to perform this analysis. The results should match those shown on the label of
the reference material bottle, within the tolerance level.

If using a cryostat, select Use CryoStat, enter a Target Tolerance and a Hold Time. The
cryostat temperature will be ramped (if ramp is enabled) to the sample analysis temperature.
Once the cryostat temperature is within the entered tolerance, the analysis will wait for the hold
time before proceeding.

Flex Physisorption Flex Chemisorption or Dynamic Analysis

Perform a Reference Material Analysis

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 6 - 31



6 Perform an Analysis

Flex Physisorption Flex Chemisorption or Dynamic Analysis
If a Blank Analysis was selected, look at the Blank Analysis Report. The isotherm points should all
fall between the minimum and maximum specification lines.

n If the results are within tolerance, the analyzer is operating properly. Click Close.
n If the results are not within tolerance, refer to the following Cause and Action table. After per-

forming the action, perform the reference material analysis again.

Cause Action
The sample was not
degassed properly.

Degas the sample again.

The gas lines are not
clean.

Perform the procedure for cleaning and verifying gas lines, then try
again.

The measured free
space is too high.

This indicates the helium is not pure enough. Use helium that is
99.999% pure, then try again.

Cause and Action
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PERFORM A SAMPLE ANALYSIS
Unit [n] > Sample Analysis
Prepare for Analysis on page 6 - 4
Refill the Dewar during Analysis on page 6 - 45

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 × 10-6mmHg or lower.

Physisorption Chemisorption or Dynamic Analysis

Use to perform up to three analyses with different analysis conditions and/or report options.
Sample files can be loaded into ports 1, 2, and 3 allowing one analysis using different analysis
conditions to run on each port.

Use to perform an analysis on port 2.

When Start is selected, the selected sample file’s analysis conditions will be compared with the
port’s hardware configuration to verify that the specified analysis is supported by the hardware:

Perform a Sample Analysis
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6 Perform an Analysis

n The minimum target pressure must be no less than theMinimum Record Pressure for the
minimum range transducer present on the port.

n The selected sample files will be checked for matching adsorptive gases, matching Psat or
P0 gases if measured, and matching backfill gases. All selected gases, except those in a
precharged vapor source, must be connected to gas inlets and identified on the Unit [n]
> Unit Configuration > Gas Selections window. See Specify Gas Ports on page 2 - 15.

n If any selected sample file specifies an Adsorptive Dose Method from port 3 and a sample
file is selected for port 3, an error message displays indicating the problem and the Start
window will remain active.

n If in-situ Degas is selected for any samples, the operator is prompted to raise the
isothermal jackets, then connect and install the degas heating mantle on the
sample tubes. If this occurs, the operator will be prompted after degas to remove
the heating mantle and properly position both the isothermal jackets and Dewar
cover.

n If Vapor Source Temperature Control is selected and the vapor heating mantle is
not connected, the operator is prompted to install and connect the vapor heating
mantle. If Degas is selected for any samples, this will occur after the prompt to
remove the degas heating mantle. Otherwise, this will occur immediately at the
start of analysis.

Click Next to schedule additional analyses after the completion of the first series of analyses. The
Next button displays after the first set of analyses is complete. Samples cannot be removed from
or added to ports until the full set of analyses has completed.

1. Click Close Valves to manually close all analyzer valves.
2. For a selected port, either click Browse and select a sample file, or click New to create a

new sample file.

On port 1, up to three sample files may be selected. The files will be loaded into
ports 1, 2, and 3 in the order they appear in the file selector.

A sample cannot be attached to port 3 if port 3 is being used as the vapor source.

Port 2 is the only available port.

3. Verify the information populated into the sample identification. This information is pulled
from the selected or newly created sample file. The Density value is applicable only if using
the Calculatemethod for the free space determination.

4. Edit the P0 and Bath temperature fields, if necessary.
5. If using a cryostat, select Use CryoStat and complete the Target tolerance and Hold time

fields.
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6. Click Report after analysis to generate reports automatically when the analysis is com-
plete.

7. On the Report Settings window, select the report destination. ClickOK to return to the pre-
vious window.

8. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status at the bottom of the window changes from the Idle
state.

When running a dynamic analysis, after starting the analysis several windows
display with various warnings, messages, and prompts for the user to perform a spe-
cific task. Tasks will depend on the experiments in the current analysis — such as:
wait status, manual injections, or calibration file selection.

9. When the analysis is complete, remove the sample tube and store (or dispose of) the
sample material as applicable.

Use caution when removing the sample tube if using a hanging filler rod. The
sample tube O-ring or Dewar cover may snag the filler rod retaining ring. Loosen the
snag gently as excessive force may break the tip of the filler rod.

Selections Description
Bath temperature
[text box]

Enter the temperature for the analysis bath.

Close Valves [button] Closes all valves on the unit.

Density / Mass / Sample
+ Tub[text box]e / Empty
Tube

Enter values for the sample’s mass and density. These values may
be edited after analysis.

New [button] Creates a new sample file.

P0 [text box] Enabled if Entered is selected for the P0measurement for at least
one file.

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Analysis Graph

Perform a Sample Analysis
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6 Perform an Analysis

A. Suspend/Resume/Skip
buttons

B. Port report buttons
C. Live graph settings
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Selections Description
Port [button] Generates a report on data being collected . The reports are

displayed on the computer monitor only.
Live Graph Settings
[button]

Select Thermal transpiration, x-axis Quantity (relative or absolute
pressure), and the x-axis Scale (linear or logarithmic).

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

Skip [button] Moves to the next step. This button is visible only when an analysis is
in progress. Select the ports to skip. In 21CFR11 environments,
steps cannot be skipped.

Resume [button] Restarts the suspended application.

Status window Displays the last point pressure and relative pressure for each port.

Suspend [button] Suspends an analysis in progress.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Analysis Graph

Perform a Sample Analysis
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6 Perform an Analysis

TEMPERATURE PROGRAMMED DESORPTION ANALYSIS

This topic provides an example of how to perform a Temperature Programmed
Desorption analysis using NH3 on calcium oxalate under helium with a 10 °C/min tem-
perature ramp. Make the appropriate modifications for the material being analyzed.

Temperature Programmed Desorption (TPD) analyses determine the quantity, type, and strength
of active sites available on the surface of a catalyst from measurement of the amount of gas
desorbed at various temperatures.

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of
analysis gas flows over the sample and reacts with the active sites. (Alternatively, Pulse
chemisorption can be used to react with active sites.) Programmed desorption begins when the
temperature is ramped linearly over time while a constant stream of inert carrier gas passes over
the sample.

At a certain temperature, the heat will overcome the activation energy, breaking the bond between
the adsorbate and adsorbent. The adsorbed species will then desorb. If different active metals are
present, they usually will desorb the reacted species at different temperatures. The desorbed
molecules enter the stream of inert carrier gas and are swept to the detector where the detector
response is proportional to the gas concentrations. The quantity of desorbed species, combined
with the stoichiometry factor, and the temperature at which pre-adsorbed species desorb, yield
the quantity and strength of active sites, respectively.

If TPD is performed after coverage of the active sites by flow or pulse chemisorption, additional
information about the distribution of active sites and the strength of active sites is collected.

PREPARATION

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 6 - 4.
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PROCEDURE
1. For NH3 on zeolite, a sample mass of 50 mg ±10 mg should be used. Install the loaded

sample tube and thermocouple on the analyzer. Raise the furnace around the sample tube
and install the insulator disc and shield.

2. Create a new sample file for this analysis. In the Analysis Conditions drop-down box, select
Y Zeolite with nitrogen, measure freespace and modify the steps as needed depending on
the analysis to be performed.

3. On the Report Options tab, select the required report options for the analysis.
4. Save and close the file.
5. Go to Unit [n] > Sample Analysis and select the sample file saved in the previous step.
6. Click Start to start the analysis.
7. When prompted, select the calibrations associated with each experiment in the sample file

(if applicable). For this example, select None. See Peak Editor for Dynamic Analysis on
page 7 - 10.

When the analysis ends, the furnace begins to lower the sample temperature to room
temperature. When the sample has cooled, remove the sample tube when the
analysis is complete.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

8. Verify that the peak temperatures are consistent with specifications in the Reference Mater-
ial booklet.

Temperature Programmed Desorption Analysis
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6 Perform an Analysis

TEMPERATURE PROGRAMMED OXIDATION ANALYSIS

This topic provides an example of performing a TPO onWO3. Because TPR is often
used as the preparation for TPO, the TPR process was included in this example.

Temperature Programmed Oxidation (TPO) examines the extent to which a catalyst can be re-
oxidized. Generally, TPO analyses are used to measure the degree of reduction of certain oxides.

Usually the sample is pretreated and the metal oxides are reduced to the base metal. Then the
reactant gas is applied to the sample in pulses or (alternatively) as a steady stream. The analyzer
measures the uptake of the reactant gas.

TPO is often performed after TPR is performed. When the TPR experiment concludes, the sample
is returned to room temperature. Then, the analysis gas is changed to 2-5% O2 + He. This gas
mixture is flowed after the sample is at ambient temperature, then the temperature is ramped up to
the same maximum temperature used for the preceding TPR analysis. The portion of the sample
that had been reduced is re-oxidized, and the degree of reduction can be calculated.

If the TPR and TPO results are different, there are several possible causes: the sample material
sintered such that only a surface oxide (and not a bulk oxide) is formed, or part of the sample was
re-oxidized at room temperature while the TCD baseline was stabilizing.

When using any mixture of gases for TPR or TPO analyses, make sure the thermal
conductivities of the two gases in the mixture are quite different for maximum
sensitivity, See Gas Charts on page I - 1.

Preparation
Pretreatment TPR

Analysis 2 to 5% oxygen/helium is flowed through the sample while tem-
perature is ramped, beginning at ambient temperature.

Cold Trap The cold trap does not need to be cooled during the reference
material analysis. This may vary depending on application or
analysis method. The cold trap tube should remain on the
instrument. Including the cold trap in the flow path is optional.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 6 - 4.
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PROCEDURE
1. Obtain the sample mass, then install the loaded sample tube and thermocouple on the ana-

lyzer. Raise the furnace around the sample tube.
2. Create a new sample file for this analysis. In the Analysis Conditions drop-down box, select

the analysis conditions file and modify the steps as needed depending on the analysis to be
performed.

4. On the Report Options tab, select the required report options for the analysis.
5. Save and close the file.
6. Go to Unit [n] > Sample Analysis and select the sample file saved in the previous step.
7. Click Start to start the analysis.
8. When prompted, select the calibrations associated with each experiment in the sample file

(if applicable). For this example, select None. Calibration files can also be associated with a
sample file after analysis using the Peak Editor. See Peak Editor for Dynamic Analysis
on page 7 - 10.

When the analysis ends, the furnace begins to lower the sample to room temperature.
When the sample has cooled, remove the sample tube when the analysis is complete.

9. As the temperature increases, the sample is oxidized, and the application calculates the
volume of oxygen taken up.

10. Allow the TCD signal to return to the initial baseline after the peak has been displayed.
11. When the displayed sample temperature reaches the ambient temperature, open the fur-

nace. Using gloves, remove the sample tube.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

Temperature Programmed Oxidation Analysis
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6 Perform an Analysis

TEMPERATURE PROGRAMMED REDUCTION ANALYSIS

This topic provides an example of how to perform a TPR analysis of silver oxide. Sil-
ver Oxide Reference Material can be ordered from Micromeritics. Parts and accessor-
ies are located on the Micromeritics web page.

Temperature Programmed Reduction (TPR) determines the quantity of reducing gas consumed
during reaction with the catalyst and reveals the temperature at which reduction occurs. For the
reference material analysis, hydrogen (5-10%) is the reducing gas. The following method provides
an overview of the steps to successfully analyze the reference material only. For other materials,
the sample mass, gas flow rate, temperature ramp, active gas, or active gas concentration may
need to be changed. Refer to the reference material booklet and the reference material bottle
label for the expected results.

Preparation
Pretreatment (Optional step.) Not required for reference material.

Analysis Flow 5-10% hydrogen/argon or 5-10% hydrogen/nitrogen, while ramping
the temperature. The analyzer records hydrogen consumption as a func-
tion of temperature. Nitrogen is sometimes used because it may be more
economical than argon.

Cold Trap A cooling of the cold trap is generally needed for the entire analysis.
A mixture of liquid nitrogen or dry ice and acetone or isopropanol
provides the best performance. A cooling bath with dry ice will last longer
than a cooling bath with liquid nitrogen. See step 2 in the following pro-
cedure for preparation details.

Before performing an analysis, ensure the sample and analyzer are adequately pre-
pared. See Prepare for Analysis on page 6 - 4.
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PROCEDURE
Create Sample Files on page 3 - 2
Peak Editor for Dynamic Analysis on page 7 - 10

1. Obtain the sample mass (refer to the Silver Oxide Reference Material booklet for proper
mass range), then install the loaded sample tube and thermocouple on the analyzer. Raise
the furnace around the sample tube and install the insulator disc and shield.

2. Place the isopropyl alcohol in a cold trap Dewar and slowly pour LN2 into the Dewar while
stirring the mixture. Continue to add and stir until the mixture becomes slushy. The mixture
must be capable of achieving a temperature of approximately -90 ºC.

3. Place the cold trap Dewar filled with cooling fluid around the cold trap tube. Ensure that the
cold trap Dewar contains enough coolant to immerse the lower part of the cold trap tube.

Extreme caution should be used when mixing the IPA/LN2. See Dewar Precautions
on page 6 - 2.

4. Create a new sample file for this analysis. In the Analysis Conditions drop-down box, select
AgO TPR with H2Ar .

5. On the Report Options tab, select Summary in the Selected Reports list box.
6. Save and close the file.
7. Go to Unit [n] > Sample Analysis and select the sample file saved in the previous step.
8. Click Start to start the analysis.
9. When prompted, select the calibrations associated with each experiment in the sample file

(if applicable). For this example, select None. Calibration files can also be associated with a
sample file after analysis using the Peak Editor.

As the temperature increases, the silver oxide is reduced, the water produced by the
reaction is collected in the cold trap, and the amount of hydrogen consumed is detected.

A hydrogen consumption peak which corresponds to the reduction capacity of silver oxide is
displayed. Refer to the Silver Oxide Reference Material booklet for the maximum peak
temperature.

10. When the analysis concludes, remove the sample tube.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

Temperature Programmed Reduction Analysis
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6 Perform an Analysis

PERFORM A VAPOR ANALYSIS

This option is for physisorption or chemisorption only.

File > Open > [.SMP File]

After running a chemisorption analysis, port 2 can become contaminated with use.
Clean the system by evacuating all three ports that were fitted with empty
physisorption tubes until the system vacuum level is at 9 × 10-6mmHg or lower.

A vapor analysis requires that a vapor source container be installed.

Micromeritics offers two methods of installing a vapor source container - one method
for analyzers with a shelf support and another method for analyzers without a shelf
support. See Vapor Source Container Installation on page 11-17.

1. On the Adsorptive Properties window, select Vapor source in the Dosing Method group box.
If running the vapor analysis on port 3, select From sample port 3 and proceed to Step 3.

2. Set the Vapor Source Temperature to the correct value if Vapor Source is selected. If
sample port 3 is selected, the analysis bath temperature is assumed.

3. Select Controlled by instrument using heating mantle if the vapor source is to be auto-
matically heated to this temperature.

If this option is selected for a chemisorption analysis, sample temperature control
must be set to Accessory temperature control. See Temperature button in Analysis
Conditions for Physisorption and Chemisorption on page 4 - 5.
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REFILL THE DEWAR DURING ANALYSIS

Always use caution when handling Dewars. See Dewar Precautions on page 6 - 2.

Ensure cryogen is readily available in a suitable delivery system when using this fea-
ture. The Dewar will be lowered 2.5 cm, so space for refilling will be limited.

Tool Description

Liquid Nitrogen Transfer Unit
[part number 021-00000-00]

Dip Stick [part number 350-25901-00] This dipstick is
specially designed to easily fit within a 2.5 cm space
when the Dewar is lowered.

Parts and accessories are located on the Micromeritics web page.

Recommended Tools

Refill the Dewar during Analysis
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6 Perform an Analysis

The Dewar refill icon allows the checking and refilling of the Dewar during an analysis. This icon is
only enabled during data collection. It is important that the cryogen level always cover the bottom
portion of the isothermal jacket during analysis, therefore, the level should be checked within 48
hours of starting an analysis. When using this icon, the operator is prompted when the analysis is
paused, the Dewar lowered, and when the analysis resumes. The application automatically
ensures that analysis dosing and equilibration will not be disrupted by the refilling procedure.

For ease of use, Micromeritics recommends the use of their Liquid Nitrogen Transfer Unit. This
unit has a small delivery tube that easily inserts between the Dewar cover and the top of the
Dewar.

1. To lower the Dewar elevator 2.5 cm, click the Dewar icon. The following prompt will display:

The instrument will pause the analysis and lower the Dewar for refilling. This may take up
to a minute or so. Have sufficient cryogen prepared to refill the Dewar before continuing.

[Continue Refill]      [Cancel Refill]

Continue Refill. Click to lower the Dewar elevator 2.5 cm. Continue to the next step for
instructions to refill the Dewar.

Cancel Refill. Click to close the prompt and cancel the elevator movement. Analysis will
continue. The remaining steps in this section can be skipped if this button is clicked.

2. If a sample is being dosed with adsorptive, the analysis will pause prior to elevator move-
ment. This pause may take a minute or so then the elevator will lower automatically. The fol-
lowing prompt will display:

Waiting for analysis to pause. This may take up to a minute or so. When the analysis is
paused, the Dewar will be lowered 2.5 cm to allow refill.

[Cancel Refill]
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Cancel Refill. Click to close the prompt and cancel the pause. Analysis will continue after
equilibration. The remaining steps in this section can be skipped if this button is clicked.

3. When the analysis pauses, the Dewar elevator will lower 2.5 cm. The following prompt will
display:

The analysis is paused. Remove the safety shield and refill the Dewar. When complete,
reposition the Dewar cover and safety shield. Then press [Resume Analysis]. The
analysis will wait 20 minutes after the Dewar is raised for thermal equilibration.

[Resume Analysis]

a. With the elevator lowered, remove the safety shield.
b. Check the cryogen level using the recommended dip stick. If necessary, slide the

Dewar cover upwards slightly to allow a little more room for the dip stick and cryogen
delivery tube.

i. Lay the dip stick horizontally along the top of the Dewar and to the right of the
sample tubes on ports 2 and 3.

Slide dip stick against the
right side of sample tubes
on ports 2 and 3 then pivot
dipstick downwards to
place in Dewar

ii. Pivot the dip stick so that the end of the dip stick slides into the Dewar
against the right sides of sample tubes on ports 2 and 3. Do not try to insert
the dip stick in the middle of the sample tubes. The isothermal jackets will be
in the way.

c. Remove the dipstick and recheck the cryogen level.
d. To refill the Dewar, insert the cryogen delivery tube into the opening between the

Dewar and Dewar cover and fill with cryogen. Check the cryogen level often. When
the level is correct, slightly lower the Dewar cover so that it is approximately ½ in.
below the top of the sample tubes. It should be low enough so that when the Dewar
rises, the lid will rest on the top of the Dewar opening.

e. When the cryogen level is correct, reinstall the Dewar safety shield.
4. In the application, click Resume Analysis on the analysis window. The analysis will

resume after a delay for thermal equilibration. Any equilibration that was in process ori-
ginally will restart automatically.

Refill the Dewar during Analysis
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7 ABOUT REPORTS

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

Reports can be generated for data collected on a sample that has completed analysis, collected
on a sample currently being analyzed, or manually entered.

Reports > Start
Generates a report on a sample analysis.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

Reports > Open Reports
Opens the selected report.

Reports > Heat of Adsorption
Opens the file selector to open or create a Heat of Adsorption report. See Heat of Adsorption
Report on the next page.

Reports > Open Notebook
Opens the file selector to open or create a Notebook report. SeeOpen a Report Notebook on
page 7 - 7.

7 About Reports
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7 About Reports

HEAT OF ADSORPTION REPORT
Reports > Heat of Adsorption
Reports > Open Notebook

Use to select sample files, define quantities, and generate a Heat of Adsorption report. The
isosteric heat of adsorption is an important parameter for characterizing the surface heterogeneity
and for providing information about the adsorbent and the adsorption capacity. Multiple adsorption
isotherms are obtained on the same sample using the same adsorptive but at different
temperatures to obtain the heat of adsorption.

Heat of Adsorption
report

Virial Type Thermal
Expansion Heat of
Adsorption report
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Move the blue slider bars in the Isotherm sections of the report to display different values.

When opening an existing Heat of Adsorption file, go to Reports > Heat of
Adsorption and select the file with a .HOA file extension.

When a Heat of Adsorption file with a .HOA file extension is saved, the saved file will
have a .NBK (Notebook) file extension.

Not all items listed in the following table are applicable to every report.

Selection Description
Combined System
[group box]

Select to report on mixed gas isotherms.

Delete Selected [button] Deletes the selected Isotherm in the table.

First analysis
[check box]

Select if this is a first analysis.

Isotherm model
[drop-down box]

Select the isotherm model to be used in the report.

Repeat analysis
[check box]

Select if this is a repeat analysis.

Select Isotherms
[button]

Click to add or remove Isotherms in the report.

Select Reports
[group box]

Select the reports to include in the analysis.

Virial Expansion
Coefficients
[drop-down box]

Select the A and B virial expansion coefficients to be used in the
report.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Heat of Adsorption Report

Heat of Adsorption Report
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7 About Reports

IDEAL ADSORBED SOLUTION THEORY (IAST) COMPOSITION REPORT
Reports > Open Notebook > [*.NBK file]

This report applies two separate gas adsorption analyses to a sample material. Each analysis
involves a different adsorbing gas species resulting in an experimental isotherm for each gas. The
calculation then uses Raoult's Law to predict the behavior of these two gas components when
they are adsorbing together in a mixed gas system. The primary prediction of the report is quantity
adsorbed of both species of gas as a function of the relative concentrations of the two gases in the
gas phase when in equilibrium.

Move the blue slider bars in the Isotherm sections of the report to display different values.

Selection Description
Combined System
[group box]

Select to report on mixed gas isotherms.

Isotherm model
[drop-down box]

Select the isotherm model to be used in the report.

Select Isotherms
[button]

Click to add or remove Isotherms in the report.

Select Reports
[group box]

Select the reports to include in the analysis.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Ideal Adsorbed Solution Theory (IAST) Composition Report
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SPC REPORT FOR PHYSISORPTION
Reports > SPC Report Options

n SPC (Statistical Process Control Report)

Use to generate reports with various SPC (Statistical Process Control) options. All
selected variables must be computed for each sample file used in an SPC report;
therefore, it is more efficient to select only the necessary variables.

n Regression Report

Use to generate a Statistical Process Control (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be
plotted against a single independent variable (x-axis). The degree of correlation between
the variables is also reported.

SPC Report for Physisorption
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7 About Reports

n Control Chart Report

Generates a Statistical Process Control (SPC) chart report which plots the changes in a
statistic.

Selection Description
Quantities [button] Click to select SPC quantities to include in the report.

Samples [button] Click to select sample files to include in the report.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

SPC Report Table
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OPEN A REPORT NOTEBOOK
Reports > Open Notebook

File > Open Notebook
Opens the file selector to open or create a report Notebook.

When creating a new report Notebook file using File > Open Notebook, enter the name of the
new file and select the type of report from the popup window.

Open a Report Notebook
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7 About Reports

INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

n a linear plot and log plot of the data collected during analysis.
n a summary of the analysis giving a single total pore volume and surface area.

1. To view the plots in either relative or absolute pressure, select either the Relative Pressure
or Absolute Pressure option.

2. To view the reports selected for generation during the analysis, click Preview.
3. From the view selector drop-down list at the bottom of the window, do either of the following:

n Change the option presentation of the sample description window to either Basic or
Advanced to modify certain file parameters.

n Select another plot from the list and edit the data contained in the plot.

4. When ranges are edited, the changes are reflected immediately in the plots and the sum-
mary data displayed in the window. Some editing options are:
n Drag the blue bars to increase or decrease the range of data included in the plot.
n Edit the Isotherm Linear Plot to include or omit the data point from the BET plot.
n Right-click to display a popup menu to include reports; enable or select overlays; edit

curves, axes, legends, titles; and copy and paste the data in a graph or in tabular
format.

5. Click Save.
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MICROACTIVE REPORTS
This feature provides a quick and easy way to investigate and manipulate analysis data using a
variety of reporting methods.

When a sample file with a status of Complete, Analyzing or Entered is opened, a linear plot and
log plot of the data collected during analysis are displayed as well as a summary of the analysis
giving the total pore volume. Numerous reports are accessible from a drop-down menu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, thickness curve type, pore geometry, and interaction parameters) are
also displayed. Plots may be edited by selecting the data points or data point range to be included
in the plots and modifying the parameters. When a report is edited, the results are immediately
reflected in the plots and summary data.

MicroActive Reports
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7 About Reports

PEAK EDITOR FOR DYNAMIC ANALYSIS

Analysis condition defaults for metal stoichiometry factors can be set using the
sample information metal table editor. Stoichiometry factors can also be set for each
pulse chemisorption experiment using the analysis conditions experiment step
editor. If required, stoichiometry factors for a completed pulse chemisorption
experiment can be viewed and modified using the peak editor’s stoichiometry
settings window.

The Peak Editor feature provides the viewing and editing of up to 16 dynamic analysis
experiments. The Peak Editor options are accessed by opening a Completed sample file and
selecting a "Peak Editor" entry from the drop-down menu at the bottom of the report window.
Peaks can be defined, edited, or deleted.

Peaks are defined by a baseline. If the Find All Peaks button is clicked (enabled when Edit Peaks
is selected), the Peak Editor will define baselines for all positive peaks detected according to the
Integration window accessed from the Integration button. For Pulse experiments and Loop
calibrations, peaks are found using events that occurred during the analysis — such as the time
an injection started— instead of peak detection options. The baseline can be manually defined by
double left clicking in the signal graph on the starting baseline point (this places the Peak Editor
into baseline creation mode). The ending baseline point is then defined by left clicking in the signal
graph on the ending baseline point. Baseline creation mode can be exited by right clicking in the
signal graph.

7 - 10 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



PEAK EDITOR VIEW
Open a Sample File on page 3 - 6

When a sample file with a Complete status is opened, three views are available:

n Overlay Experiments View
n Stacked Experiments View
n Peak Editor

To change the view, select the view from the drop-down list at the bottom of the graph window.
Only the Peak Editor view allows editing of the experiment.

Example of
Overlay Experiments view

Example of
Stacked Experiments view

Peak Editor for Dynamic Analysis
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7 About Reports

Example of
Peak Editor view

Selections Description
Calibration
[button]

Calibration. Select a previously defined calibration file. If the
experiment and calibration gases differ, a warning displays. The system
also compares the experiment flow rate and calibration flow rate. If they
differ, a warning displays.

Experiment Information
n Description. Enter a description of the current experiment.
n Type of analysis. Select the analysis type that most closely

describes the current experiment. This will affect what is reported as
part of the Summary report data and the available reports.

n Vapor. Select a vapor before creating or applying a vapor calibration.
This field is only visible for vapor experiments.

n Loop volume. Displays the volume of the gas injection loop.

Peak Editor
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Selections Description

n Ambient temperature. Displays the ambient temperature entry from
theOptions > Environmental Defaults setting. This field may be
edited.

n Atmospheric pressure. Displays the atmospheric pressure entry
from theOptions > Environmental Defaults setting. This field may
be edited.

n Active concentration. Displays the percent of the gas mixture which
is composed of the reactive gas versus an inert filler. This value is
used for data reduction, including pulse chemisorption.

n Adsorbate cross-sectional area. Displays the area that a single
adsorbed molecule occupies on the surface of the sample. It is used
in surface area calculations.

n Manual Injections. Displays the injection settings entered during
analysis. This table may be edited.

Create Calibration. Create a signal calibration from the currently
selected experiment.

Delete [button] Clears all peaks from the table and removes all markings from the
peaks.
To delete a single peak, select the peak from the peak table or left click
the peak to enable the Delete Peak button.
n Delete All is available only when the Fit Peaks selection is enabled.

n Delete All Peaks is available only when the Edit Peaks selection is
enabled.

n Delete Peak is available only when the Fit Peaks selection is
enabled.

Delete Baseline
[button]

Removes the baseline from the graph.

Available only when the Fit Peaks selection is enabled.
Display Options
[group box]

Use to change how the data are displayed.

Zero. Select to zero the signal (starting baseline).

Invert. Select to invert the signal (peak).

Hide Peak Marks. Select to hide all marks from peaks.

Smooth. Select to smooth the signal on the display.

n Order andWindow. Enabled when the Smooth checkbox is selec-

Peak Editor (continued)

Peak Editor for Dynamic Analysis
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Selections Description

ted. The smoothing process uses the Savitzky-Golay filter to fit a poly-
nomial order n into size of the specified window [m].

Find All Peaks
[button]

Defines baselines for all positive peaks detected according to the
Integration window, accessed via the Integration button. Pulse
experiments and Loop calibrations do not use Integration button
settings when finding peaks.

Find All Peaks automatically detects the peaks and draws the baseline
for detection. Place the cursor over one of the baseline end points and
double left click to grab the baseline. Move the cursor to the new
position and right click. Available only when the Edit Peak selection is
enabled.

Gaussian
[drop-down box]

Standard Gaussian curve. Available only when the Fit Peaks selection
is enabled.

Import M.S. [button]
Remove M.S. [button]

Mass spectrometer data can be imported and overlaid in theOverlay
Experiment view. In the Peak Editor view, it is saved as a separate
signal.

Import M.S. Click to import mass spectrometer data. In the bottom
right-hand corner of the pop-up window, select the type of mass
spectrometer file to import (Quadera, Quadstar, MKS, or TAMS). Select
the file, then clickOpen to import the signals.

A popup window prompts the user to sync the temperature data with the
current experiment temperature data.

Remove M.S. Click to remove all previously imported mass
spectrometer signals from the current experiment.

Import standard
peaks [button]

Imports the saved peak parameters from the Edit Peaks view. Available
only when the Fit Peaks selection is enabled.

Peak Editor (continued)
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Selections Description
Integration Options
[button]

See Peak Detection / Integration Options on page K - 1.
Interpolation [button] Interpolate Temperature. Select to interpolate the temperature. Click

Range to specify a temperature range. Slide the blue bars on the graph
to indicate the range.

Log Normal Skewed
[button]

A 4-parameter, log-normal shape that allows for skewed peaks. This is
the default peak. Available only when the Fit Peaks selection is enabled.

Peak fit model
[button]

Select the peak shape. Available only when the Fit Peaks selection is
enabled. Options include: Gaussian, Lorentzian, Pearson type VII,
Pseudo-Voight, and Log Normal Skewed (3 and 4).

Sample mass
[text box]

Calculates the mass-specific quantities. Initial value is taken from the
sample information at the start of the analysis.

Peak Editor (continued)

Peak Editor for Dynamic Analysis
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Selections Description
Snap to Signal
[button]

Places the selected baseline point on the signal curve.

Stoichiometry
[button]

See Active Metals for Chemisorption Analyzers on page 3 - 13.

View Type
[group box]

Edit Peak. Locates peaks via signal integration over a baseline.

Fit Peaks. Locates peaks via function fitting to minimize residual over a
baseline.

x-axis
[drop-down box]

Change the x-axis to display as time or temperature. This feature is
available in Stacked Experiment view,Overlay Experiment view, and
Peak Editor view. In Peak Editor view, the Edit Peak selection must be
enabled.

Time (minutes). Select to display the x-axis as minutes.

Temperature. Select to display the x-axis as temperature.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Peak Editor (continued)
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EVALUATE REPORT RESULTS
Analysis reports provide a record of test conditions, experimental data, and information extracted
from the experimental data by application of various reduction methods. This topic discusses the
elements of various reports presented by Micromeritics’ static volumetric physisorption analyzers
and suggests ways by which the merit of the reported information may be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriate methods. The
analysis data should be inspected for evidence of experimental error. The traditional method of
confirming the quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’
analyzers log and report the exact conditions of each analysis.

Analysis data can be evaluated by:

n Viewing the Validation Report
n Inspecting the Isotherm Plot
n Evaluating the Isotherm Tabular Data Set
n Reviewing Reduced Data

Evaluate Report Results
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VIEW THE VALIDATION REPORT
The Validation report shows whether the data collected during an analysis are within typical
ranges. Select the types of reports to include by selecting the report in the Validation Report
Options window.

When a selected report is generated, if errors occur, a message is displayed across the top
portion of the report and a unique symbol displays on the graph.

INSPECT THE ISOTHERM PLOT

Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected to mathematical smoothing as far as possible. If
the data describe a Type I isotherm, then the plot is best shown on a logarithmic pressure axis so
that details of the low pressure region are revealed. Data in this region are important particularly
for micropore studies. Examine the plot to determine if any points are outliers or if a region of the
isotherm exhibits characteristics (spikes, steps, etc.) which are inconsistent with the physical
process being monitored. The philosophical question of whether or not these suspected
extraneous data points should be removed from the raw data is not considered here, but it may be
appropriate to exclude an outlier from reduced data. Too many outliers can cause the integrity of
the total data set to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under
reasonable conditions and using reasonable parameters. For example, confirm that the free
space values reported are typical for the sample holder and bath in use. A problem with either
ambient or analysis free space values may indicate a free space measurement error and affect all
calculations of quantity adsorbed.
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The raw data should be carefully examined before it is reduced. Errors that occur in raw data will
only be exacerbated in reduced data.1 )

EVALUATE THE ISOTHERM TABULAR DATA SET

Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the
BET range (P/P0 = 0.05 to 0.30). Total uptake is the specific quantity adsorbed (cm3/g STP) times
the sample mass (g). As an example, the level of uncertainty in this range typically is less than
0.1 cm3 STP for a high performance system. Total uptake quantities should be some multiple of
this level of uncertainty. Otherwise, an unfavorable signal-to-noise ratio and unreliable data result.
The solution is to use a greater quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is
expected to change somewhat over the duration of an analysis, but it is not expected to do so with
large or abrupt transitions. Unreasonable saturation pressures or unusual changes may indicate
that a gas different from the adsorptive was used in determining P0, that the level of the cryogen
fell too far, or that the cryogen is impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular
and graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.2 )

REVIEW REDUCED DATA

Isotherm data may be analyzed by any one of several reduction methods depending on the
analyzer model and pressure range employed. The quality of the results depends on the quality of
the isotherm, the congruity of the data reduction parameters with experimental conditions, the
agreement of the theoretical model with the physical gas-solid system, and compliance to the
pressure range over which the method is valid. Typically, results can be appraised by examining a
few salient areas of the report as described in the following topics.3 )

1 ) The information in this article is extracted from Analytical Methods in Fine Particle Technology,
Webb, P. and Orr, C., (1997).
2 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
3 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).

Evaluate Report Results

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 7 - 19



7 About Reports

PHYSICAL PARAMETERS

The value of physical parameters which are used only in data reduction routines should be
reviewed to assure that they agree with experimental conditions. These parameters can be
changed and the experimental data recalculated if an error is discovered or if exploring an
alternate value is desired. Analysis condition values used in the calculation of quantity adsorbed
can be changed also. These are typically the manually entered free space(s), nonideality
correction factor, and bath temperature.

The area occupied by a single adsorbed molecule is a required parameter in the calculation of
surface area by the BET and Langmuir methods. The software provides a default value, but other
values are found in the literature. McClellan and Harnsberger1 ) provide a comprehensive review
of such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them
by converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptives must be
calculated.

The terms for liquid surface tension , contact angle between solid and liquid phase , molar
volume of the adsorbate , gas constant , and sample temperature are treated as one
constant, the adsorbate property factor expressed by:

using which, the Kelvin equation2 ) reduces to

Either surface tension, contact angle, or molar volume can be revised individually to give a new
value for the factor , or can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters which may be adjusted from those
of the default values. The first is the inside stem (neck) diameter of the sample holder, and the
second is the hard-sphere diameter of the adsorptive molecule. The sample holder inside
diameter is available from the documentation provided with it or is measurable. Information on
hard-sphere diameters of molecules may be obtained from handbooks.

1 ) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577
(1967).
2 ) Thomson, W., Phil. Mag. S., 42, 448 (1871).
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For terms such as the interaction parameter found in the Horvath-Kawazoe calculation1 ) , the
Dubinin affinity coefficient, or Astakhov exponent2 ) , the default values as provided by the
software generally are adequate. A search of the technical literature is required if the analysis
involves a gas-solid system other than that covered by the default values.

The t-Plot method plots quantity adsorbed against thickness (t) derived from a thickness equation,
and the Dubinin transform plots quantity adsorbed against log(P/P0)n. All of these data reduction
methods were first proposed for specific applications. The user must make a judgment as to the
applicability of the method to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysis
must be applied only over the linear range and within the range of application. Fitting a regression
line to surface area transformation plots should yield a correlation coefficient of 0.9999 or better
and for t-plots and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reduction model does not apply to the gas-solid system under examination, then it may
be that either no linear range exists within the pressure range of validity, or that solutions derived
from the regression line of the linear range are intuitively incorrect, that is, they have no relevance
to the physical situation, such as a negative C-value from a BET transform.

BET C-VALUE

BET theory assumes uniform surface coverage with no favored adsorption sites and it also
assumes that the gas is more strongly attracted to the surface than to other gas molecules. The
typical range of BET C-values is from about 5 to well over 100. Values much less than 5 imply that
the gas-to-gas affinity is competing with the gas-to-solid affinity which conflicts with the basic
assumptions of BET theory. C-values much greater than 100 indicate very strong attraction for the
surface or preferential adsorption.

Provided the isotherm was determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-
solid interaction for the particular sample material does not conform to the BET model. An
inappropriate adsorption model may be indicated also by the coefficient of correlation of the
regression line, 0.999 being about the minimum value expected with five more or less equally
spaced points. In the case of indications of poor conformance to the BET model, the Langmuir
data reduction method should be examined.

1 ) Everett, D.H. and Powl, J.C., J. Chem Soc., Faraday Trans. 1, 72, 619 (1976).
2 ) Dubinin, M. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).
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7 About Reports

DATA ANALYSES BY THE BJH METHOD

In general, this method visualizes the incremental decomposition of an experimental isotherm,
starting at the highest relative pressure or pore size. At each step the quantity of adsorptive
involved is divided between pore-emptying and film-thinning processes and is accounted for
totally. This computational algorithm frequently leads to inconsistencies when carried to small
mesopore sizes. If the thickness curve used is too steep, ultimately it will predict a larger
increment of adsorptive for a given pressure increment than is actually observed. The algorithm
must stop since a negative pore volume is nonphysical. Accumulated error results in the
calculation of a too large volume of (possibly nonexistent) small pores if the thickness curve used
underestimates film thinning.
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REPORT FEATURES AND SHORTCUTS
Graph Features and Shortcuts on page 7 - 27

In 21CFR11 environments, members of the Analyst group must click Preview on the
sample file window to access this screen.

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature,
or axis cross-hairs.

n After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
n The report zoom feature provides the viewing of fine graph details and the ability to shift the

axes.
n All reports contain a header displaying file statistics.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

If configured, the report header can also contain a graphic and/or a title.

n Tabular and graphical reports contain sample and analyzer statistics such as analysis date/-
time, analysis conditions, etc.

n The headers contain notes of sample file changes occurring after analysis.

Report Features and Shortcuts
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REPORT HEADER SHORTCUTS
Right-click in the report header to display header shortcuts.

Selections Description
Copy header as text Copies the report header as text. Text is copied to the clipboard and

then can be pasted into other documents.
Edit Opens a dialog box for editing the report title.

Report Header Shortcuts
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REPORT TOOLBAR
The Report window has a toolbar on the right portion of the window and selectable tabs at the top
of the report header. To view a specific report, either select the tab or the report in the Reports list
box, then click Show.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

Selections Description
Default Style [button] Specifies default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in the Reports list box. Deleted reports
will have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button] Displays the Print window for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hid-
den using the Hide button.

Show [button] Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Report Toolbar

Report Features and Shortcuts
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TABULAR REPORT FEATURES AND SHORTCUTS
Display tabular report shortcuts by right-clicking in the body of the tabular report. Column
shortcuts require right-clicking on the column to be modified.

Selections Description
Align column Changes the column alignment to either left, right, or centered.

Copy table as text Copies the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Edits the report title and/or title font attributes. Click Font to modify
font attributes.

Move column Right-click the column to be moved. SelectMove column on the short-
cut menu and select Left or Right for the move.

Rename column Right-click the column to be renamed. Select Rename column on the
shortcut menu and enter the new column name.

Resize column Right-click the column to be resized. Select Resize column on the
shortcut menu and enter the new column width in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right-click in the report data. Select Table data font on the shortcut
menu.

Table header font Right-click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Tabular Report Shortcuts
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GRAPH FEATURES AND SHORTCUTS
Right-click in the graph area to display graph report shortcuts.

Selections Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Copy data Copies the report data to the clipboard. It can then be pasted into
other software programs as tab-delimited columns or copied as an
overlay onto another graph.

Delete baseline Deletes the baseline from the graph

Delete peak Deletes the selected peak from the table.

Edit axis Edits the selected axis properties.

Gridlines. Changes how to display major / minor grid lines.

Scale.
n Autoscale minimum/maximum. To manually specify minimum /

maximum autoscale, deselect the option and enter the new
amount in the text box.

n Invert scale. Inverts the scale.
n Linear/Logarithmic. Scales the graph as linear or logarithmic.
n Scale font. Modifies the font for the scale label. Deselect Use

default font to enable font options.

Signal (a.u.). Converts the signal from calibrated units to
arbitrary units.

Graph Shortcut Options

Graph Features and Shortcuts
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Selections Description
Title. Edits the selected axis label.

Title font.Modifies the font for the selected axis label. Deselect Use
default font. Select new font attributes for report data. Enable Use
default font to reset default fonts.

Edit curve Edits selected curve properties.

Color. Changes the curve color.

Curve. Changes the interpolation, point style, and pen style for the
selected curve. These options are disabled if Use default fill style is
selected in the Histogram group box.

Histogram. Enabled only if Histogram is selected in the Style drop-
down list. Specifies the type of fill, fill color, and label position for the
selected curve.

Label. Designates where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Style. Selects another style for the collected data curve.

Title. Changes the title of the selected curve.

Use default thickness. Uses the default curve thickness. Deselect
to enter a new thickness number in the Thickness text box.

Graph Shortcut Options (continued)

7 - 28 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



Selections Description
Edit legend Changes the legend location and font.

Edit title Changes the report title.

Enable overlays If overlays have been selected, this option displays (or hides) the
overlays.

Hide Peak Marks Removes all peak marks from the graph.

Include report When selected, places a checkmark to the left of the report in the
Select Reports list box on the Report Options tab.

Insert Peak Inserts a peak into the graph at the selected point.

Reset axis limits to
initial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Select overlays... Displays the option to select files to overlay onto the active graph. To
view the overlays, click Enable Overlays on the shortcut menu.

Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Graph Shortcut Options (continued)

Graph Features and Shortcuts
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AXIS CROSS-HAIR
Left-click on the graph to view the cross-hair coordinates.

Example of
Axis cross-hair feature

ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal
view, right-click in the graph and select Autoscale all axes.
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GRAPH GRID LINES
Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using
Restricted option presentation.

Selections Description
Grid Line Styles
[selection]

Select if the major and/or minor grid lines should appear as solid or
dotted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the
logarithmic and linear scales. Deselect this option to remove the grid
lines.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Graph Grid Lines

Graph Features and Shortcuts
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GRAPH AND SAMPLE OVERLAYS

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

n Multiple Graph Overlays.Overlay two different types of graphs from one sample.
n Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot.

This feature is available only when using Advanced option presentation. Go to
Options > Option Presentation > Advanced.

GENERATE PORE SIZE DISTRIBUTION GRAPH OVERLAYS

The following reports in the physisorption applications can produce graphical results for a sample
material's pore size distribution:

BJH Adsorption/Desorption Report on page 8 - 7
DFT Pore Size Report on page 8 - 13
Dollimore-Heal Adsorption/Desorption Report on page 8 - 22
Horvath-Kawazoe Report on page 8 - 40

Two methods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

n Import ASCII text data. Data can be imported from an ASCII text file into the interactive graph.
The ASCII text file must follow certain rules.

n Copy/paste. Data can be copied from one sample file (source) and pasted into another sample
file (target).

Pore size distribution report overlays menu selections are:

n Copy data
n Paste data
n Edit Imported Data
n Display Imported Data
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IMPORT ASCII TEXT DATA
ASCII text file format rules

n The header must consist of one line to include title, two unit specifications, and distribution
type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, mL/g
o Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

n The data must be in two columns and should be separated by a comma or white space.
n The data lines must be ordered so that pore dimensions are monotonically increasing or

decreasing.

Window appearance will vary depending on the selected report. This function can be performed
on samples files with a Complete status or during an analysis.

1. Create the ASCII text file using the proper format as indicated above.
2. In the analyzer application, go to File > Open.
3. Select a sample file to overlay graphs on to.
4. ClickOpen (or double-click the file name).
5. Right-click in the graph area and select Edit imported data.

Generate Pore Size Distribution Graph Overlays
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7 About Reports

6. In the Select Imported Overlays window, if the ASCII text file does not display, click Import
to locate the file.

7. Select the ASCII text file in the Select Imported Overlays window, then clickOK. If an error
message is displayed, verify that the .TXT file format is in the correct format.

8. To include the overlay data in a printed report, see Print Pore Size Distribution Overlay
Data in Reports below.

OVERLAY PORE SIZE DISTRIBUTION DATA USING COPY/PASTE
1. Open a source sample file and a target sample file; both should have a Complete status.

The report will open to the interactive reports window.
2. In the source sample file, right-click on the graph and select Show Curve.
3. Deselect any differential curve data to hide them in the graph.
4. Right-click in the graph area again and select Copy Data.
5. Change to the target sample file, right-click the graph, and select Paste data. The graph

now displays overlayed data from the source sample file.

Typically, one new graph will appear showing both the cumulative and differential curves.
To show or hide individual curves, right-click the graph and select (or deselect) Display
imported data.

6. Ensure that all parameter fields are set appropriately, then click Paste.
7. To include the overlay data in a printed report, see Print Pore Size Distribution Overlay Data

in Reports.

Print Pore Size Distribution Overlay Data in Reports

1. Open the sample file containing the overlay data and select Advanced from the view
selector drop-down list at the bottom of the window.

2. Click the Report Options tab.
3. In the Selected Reports list box, select the cumulative, differential, or incremental intrusion

graph to show the imported distribution data, then click Edit (or double-click the selected
report).

4. In theOverlay drop-down box, select Imported.
5. ClickOK to close the window.
6. Click Preview on the Report Options tab.
7. Click Print in the reports toolbar section to display print options.
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OVERLAY MULTIPLE PHYSISORPTION SAMPLE FILES

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

To overlay the same type of graph on multiple samples:

1. Go to File > Open.
2. Select a .SMP file, then clickOpen. If the Isotherm plot displays, select Advanced from the

view selector drop-down list at the bottom of the window to display the tabbed window view.
3. Click the Report Options tab.
4. In the Selected Reports list box, highlight a report then click Edit. Use the following table to

complete the process for the selected report.

Overlay Multiple Physisorption Sample Files

Flex Series Operator Manual
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7 About Reports

If overlaying this type of
report...

Then...

n Isotherm

a. On the Isotherm Report Options window, select one or
more plots in the Selected Reports group box, then click
Options to the right of the selected plot.

b. On the Plot Options window, select Plot curve and/or Plot
points if they are to be included in the overlay. If the x-
and/or y-axes are to be autoscaled, enable Autoscale; oth-
erwise, enter the From and To points for the axes. Click
OK.

c. On the Isotherm Report Options window, in the Plot
Options group box, select Plot overlays. ClickOK.

d. Continue to Step 5.

n Alpha-S Method
n BET Surface Area
n f-Ratio Method
n Freundlich
n Langmuir Surface Area
n t-plot
n Temkin

a. On the pop-up window, selectOverlay samples. Verify
other fields. ClickOK.

b. Continue to Step 5.

n BJH
n Dollimore-Heal
n MP-Method

a. Select the report variable from the Selected Reports
group box, then click Edit.

b. Click the down arrow on theOverlay field, then select the
Samples option.

c. Verify other fields.
d. ClickOK.
e. ClickOK again.

For Physisorption Reports

If overlaying this type of
report...

Then...

n Difference Method
n Freundlich
n Langmuir
n Sinfelt Method
n Temkin

a. On the pop-up window, selectOverlay samples.
b. Verify other fields.
c. ClickOK.
d. Continue to Step 5.

For Chemisorption Reports

5. On the Report Options tab, clickOverlays.
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6. On the Plot Overlay Sample Selection window, move up to 25 files from the Available Files
box to the Selected Files box:

7. ClickOK.
8. To view the report, click Preview.

Selections Description
Available Files
[selection]

Lists files that meet the selected criteria. Select the files to be com-
bined, then click Add. The selected files are moved to the Selected
Files list box.

Look in [button] Changes the file folder location. Click the Browse icon.

Selected Files
[selection]

Lists the files selected to be combined. Click Remove to move a file
back to the Available Files list box. ClickOK to combine the files.

Status [drop-down box] Selects the status of files to be combined.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Overlay Sample Selection

Overlay Multiple Physisorption Sample Files
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7 About Reports

IMPORT ASCII PORE DISTRIBUTION DATA

Manually Enter Data on page 3 - 8

IMPORT AN ASCII TEXT FILE USING GRAPH SHORTCUTS
1. Create an ASCII text file.
2. Open a report with a Complete status.
3. Select a pore-size distribution report from the view selector drop-down list at the bottom of

the window.
4. Right-click on the graph and select Edit imported data on the shortcut menu.
5. If the ASCII text file does not display on the Selected Imported Overlays window, click

Import.
6. Select the file, then clickOpen. Header information from the ASCII text file will appear in the

Select Imported Overlays window.
7. Select the entry, then clickOK. If an error message appears, verify that the .TXT file format

is correct.
8. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.

COPY/PASTE AN ASCII TEXT FILE USING GRAPH SHORTCUTS
1. Create an ASCII text file.
2. Copy the ASCII text data to the clipboard.
3. Open a report with a Complete status.
4. Select a pore-size distribution report from the view selector drop-down list at the bottom of

the window.
5. Right-click on the graph and select Paste data on the shortcut menu.
6. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.

COPY/PASTE GRAPH DATA FROM ANOTHER GRAPH

1. Open a source pore distribution data report with a Complete status.
2. Right-click on the graph and select Copy Data on the shortcut menu.
3. Open the target pore distribution data report.
4. Right-click on the graph and select Paste Data on the shortcut menu.
5. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.
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REPORT EXAMPLES

BET SURFACE AREA

Report Examples
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7 About Reports

BET SURFACE AREA PLOT
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BJH DESORPTION: CUMULATIVE PORE VOLUME

BJH Desorption: Cumulative Pore Volume
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7 About Reports

BJH ADSORPTION: CUMULATIVE PORE VOLUME
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ISOTHERM LINEAR PLOT

Isotherm Linear Plot
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7 About Reports

LOOP CALIBRATION
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T-PLOT REPORT

t-Plot Report
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7 About Reports

TCD SIGNAL VS TEMPERATURE
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TCD SIGNAL VS TIME

TCD Signal vs Time
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7 About Reports

TCD SIGNAL VS TIME
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TCD SIGNAL VS TIME

TCD Signal vs Time
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7 About Reports

TCD SIGNAL VS TIME
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TCD SIGNAL VS TIME

TCD Signal vs Time
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8 SELECTED REPORTS

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

Report Name P C DA
Advanced Reports - Python Module on page A - 1 ü ü ü

Alpha-S Method Report on page 8 - 3 ü

BET Surface Area Report on page 8 - 5 ü

BJH Adsorption/Desorption Report on page 8 - 7 ü

DFT Pore Size Report on page 8 - 13 ü

DFT Surface Energy Report on page 8 - 16 ü

Difference Method Report on page 8 - 17 ü

Differential Hysteresis on page 8 - 20 ü

Dollimore-Heal Adsorption/Desorption Report on page 8 - 22 ü

Dubinin Report on page 8 - 26 ü

f-Ratio Method Report on page 8 - 31 ü

First Order Kinetics Report on page 8 - 33 ü

Freundlich Report on page 8 - 34 ü ü

Graph Report Options on page 8 - 37
n TCD Concentration vs Time
n TCD Signal and TCD Concentration vs Time
n TCD Signal vs Temperature
n TCD Signal vs Time
n Temperature vs Time

ü

Horvath-Kawazoe Report on page 8 - 40 ü

Isotherm Report on page 8 - 44 ü ü

Langmuir Report on page 8 - 46 ü ü

8 Selected Reports
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8 Selected Reports

Report Name P C DA
Loop Calibration Report on page 8 - 49 ü

MP-Method Report on page 8 - 50 ü

NLDFT Advanced PSD Report on page 8 - 54 ü

Options Report on page 8 - 58 ü ü ü

Pulse Chemisorption Report on page 8 - 59 ü

Sample Log Report on page 8 - 62 ü ü ü

Sinfelt and Difference Methods on page 8 - 63 ü

Summary Report on page 8 - 64 ü

Summary Report for Dynamic Analysis on page 8 - 65 ü

t-Plot Report on page 8 - 66 ü

Temkin Report on page 8 - 69 ü ü

Validation Report on page 8 - 72 ü
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ALPHA-S METHOD REPORT

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using
the quantity adsorbed at a relative pressure of 0.4.

One predefined curve is located in the Reference file directory. Use the table buttons to enter
relative pressure and the Alpha-S values.

Selections Description
Open [button] Use to import values from an existing thickness curve (.ALS).

The table to be imported must be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative
pressures in the first column and the alpha-s values in the second
column. Columns must be separated by a space or a tab.

Alpha-S Method Report

Alpha-S Method Report
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8 Selected Reports

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Ref. surface area
[text box]

Enter the surface area from the reference curve. This value is used
to calculate the sample surface area.

Select Range
for Alpha-S Fit
[group box]

Enter minimum and maximum relative pressures to determine the fit.

Selected Reports
[group box]

Alpha-S Plot. Use to plot data in graph format.
n Autoscale x-axis. The x-axis field shows the relative pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the plot.
Tabular Report. Use to have a tabular report of data generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Alpha-S Method Report (continued)
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BET SURFACE AREA REPORT

The BET calculation obtains the sample surface area value by determining the monolayer
capacity of adsorbed gas from the isotherm data. BET uses a multilayer model.

Selections Description
Pressures [button] This option is available when the sample file has a status of Ana-

lyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table if not using the Use
Interpolation option.

Exclude All. Select to exclude all pressure points in the table.

BET Surface Area Report

BET Surface Area Report

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 8 - 5



8 Selected Reports

Selections Description
Include All. Select to include all pressure points in the table.

Insert Predefined. Click to insert a predefined (default) set of points
into the report. Use Interpolationmust be selected to enable this
button. This button displays for BET reports only.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for BET fit [text box]

Enter values to indicate the fitted pressure range.

Selected Reports
[group box]

BET Isotherm plot. Uses BET monolayer capacity and constant to
produce an isotherm.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the relative pressure for BET.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the

BET isotherm plot.
BET Transform plot. Use to generate a traditional BET surface
area plot used to determine monolayer volume and BET C constant.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the relative pressure for BET.
n Autoscale y-axis. The y-axis field shows BET transformation.
n Overlay samples. Use to overlay sample files on the

BET transform plot.

Tabular report. Use to have a table of measured and calculated
values generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

BET Surface Area Report (continued)
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BJH ADSORPTION/DESORPTION REPORT

The BJH calculation determines the mesopore volume/area distribution, which accounts for both
the change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be
generated from both adsorption and desorption data. The fields for both BJH Adsorption Report
Options and BJH Desorption Report Options are identical unless otherwise specified.

An incomplete pore distribution may be generated if a thickness curve selection is not
a good match for the sample being analyzed.

Circled selection is applicable to BJH
Adsorption only

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

BJH Adsorption/Desorption Report

BJH Adsorption/Desorption Report
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8 Selected Reports

Selections Description

BJH Correction
[group box]

Select the type of correction to apply to calculations. The selected
type will display in the report header.

Faas.Good for statistical thickness curves.

Kruk-Jaroniec-Sayari.Good for reference thickness curves.

Standard. Uses original BJH models.
Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Fraction of pores open at both ends. This field is not available for
the BJH Desorption Report Options window.

During adsorption calculations, the analysis program assumes that
all pores are closed at one end. Occasionally, a percentage of pores
may be open at both ends causing disagreement in the adsorption
and desorption data or in the values for total volume and total BJH
pore volume. Enter the fraction of pores open at both ends to
compensate for this error.

BJH Adsorption/Desorption Report (continued)
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

BJH Adsorption/Desorption Report (continued)

BJH Adsorption/Desorption Report
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8 Selected Reports

Selections Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

BJH Adsorption/Desorption Report (continued)
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BJH Plot

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the BJH Report Options window, then
click Edit.

Selections Description
Autoscale [check box] When enabled on the report parameters windows, allows the x- and

y- axes to be scaled automatically. Autoscalemeans that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points
[check box]

Select to plot points on the graph.

X-Axis [group box] Use to have the x-axis on a logarithmic or linear scale.

Y-Axis [group box] Overlay. Select an option to overlay onto the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

BJH Plot Report

BJH Adsorption/Desorption Report
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BJH Tabular Report

Highlight BJH Tabular Report in the Selected Reports list box on the BJH Adsorption Report
Options window, then click Edit to specify the method of data reduction.

Selections Description
Collected points
[selection]

Use to include all relative pressure points collected. See the
Columns button below.

Columns [button] Select the data types to include in the report. Column [n] indicates
the column order and data contents for the report.

Fixed pore size table
[selection]

Use to specify exact pore sizes for volume or area data. Click Table
to modify the fixed pore size table. See the Table and Columns but-
tons elsewhere in this table.

Table [button] The fixed pore size table must contain a minimum of two points. The
points must be strictly decreasing. Enabled only when Fixed pore
size table is selected.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

BJH Tabular Report
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DFT PORE SIZE REPORT

The DFT Pore Size report contains the results of pore size distribution analyses using a non-local
DFT range of micro and mesopore ranges.

Selections Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

DFT Pore Size Report

DFT Pore Size Report
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Isotherm Data
[group box]

Select the isotherm data to be used in the report.

Select Reports
[group box]

Select the reports to generate. To edit graph details, highlight the
graph option and click Edit. The Log Goodness of Fit andGoodness
of Fit graphs cannot be edited.

Autoscale Options. Use to autoscale the x-axis and/or y-axes.

DFT Pore Size Report (continued)
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Selections Description
Axis Range. From/To fields are enabled when Autoscale options
are not selected. Enter the starting and ending values for the x-
and/or y-axes.
n x-axis. Shows the pore size.
n y-axis. Shows the area.

Overlay. Select an overlay for the report.

Plot Type. Select the method for data display.
Type [drop-down box] Classical.Model based on the Kelvin equation and thickness for

determining the pore size distribution. See DFT Models on page F -
1.

DFT.Model based on the density functional theory.
Version 2
deconvolution
[check box]

If enabled, adds improved performance for nonzero values of the
DFT regularization. The DFT results will be slightly better than when
the checkbox is not selected and when using a regularization
parameter. When the checkbox is not selected, the legacy behavior
of the DFT calculation used by earlier versions of the application is
produced.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

DFT Pore Size Report (continued)

DFT Pore Size Report
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8 Selected Reports

DFT SURFACE ENERGY REPORT

DFT Pore Size Report on page 8 - 13

The DFT Surface Energy report contains the results of surface energy distribution analyses.

DFT Surface Energy Report Options fields and buttons are identical to the DFT Pore Size Report
Options.
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DIFFERENCE METHOD REPORT

The Difference Method Report and the Sinfelt Method Report windows are identical unless
otherwise specified.

The y-intercept quantity adsorbed (Q0) is used for several calculations in the Difference and
Sinfelt reports. This value can be determined in two ways. If one point is selected, Q0 is the
quantity adsorbed for that point.

Difference Method. The repeat isotherm data are subtracted from the primary isotherm. Q0 is the
y-intercept of a straight line through the difference data.

Sinfelt Method. Both the primary and repeat isotherms are fitted to a straight line. Q0 is the
difference between the y-intercepts of the fit lines.

Selections Description
Analysis summary
[selection]

Analysis.Generates a summary of the following for the first
analysis:
n Percent metal dispersion
n Metallic surface area
n Volume adsorbed
n Slope
n Correlation coefficient
Difference.Generates a summary of the differences between the
following information for the first and repeat analyses:
n Percent metal dispersion
n Metallic surface area
n Average difference volume
Repeat. (Sinfelt report only.) Generates a line fit plot for the
secondary analysis.

Difference and Sinfelt Report

Difference Method Report
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Selections Description
Plot data [selection] Analysis. Includes a line fit plot for the primary analysis.

Autoscale x-axis / Autoscale y-axis. Select to have the x- and/or
y- axes automatically scaled. The application uses the highest
values collected during analysis as the ending points for an axis
range. X-axis shows the pressure. Y-axis shows the quantity of gas
adsorbed.

Difference. Plots the difference between the analysis and repeat
analysis lines.

Overlay samples.Overlays data from the current sample with that
of other samples. ClickOverlays on the Report Options window to
choose other sample files.

Plot curve and Plot points. Use to specify how to plot data. Plot
data as a curve, points, or both.

Repeat. Includes a line fit plot for the secondary analysis.
Pressures [button] Use to enter a range of pressure points to be included in the report or

to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.

Difference and Sinfelt Report (continued)
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Selections Description
Tabular report
[selection]

Select to have a report of the pressure points generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Difference and Sinfelt Report (continued)

Difference Method Report
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DIFFERENTIAL HYSTERESIS

This report seeks to determine a distribution of pore sizes for a sample material taking into
account pores of varying geometry such as pyramidal, constricted, and occluded pore shapes. To
extract this information, a sample material is subjected to multiple adsorption and desorption
scans in order to cover the hysteresis region of the isotherm. If the scans are sampled to obtain a
sufficiently dense set of data, a pore size distribution can be obtained by application of NLDFT
calculations to each desorption scan and the results combined into a two dimensional distribution.
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Selections Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Reports [selec-
tion]

Select the report names to include in the report.

Select Scan
[drop-down box]

Select the scans to include in the report.

Type [drop-down box] Classical.Model based on the Kelvin equation and thickness for
determining the pore size distribution. See DFT Models on page F -
1.

DFT.Model based on the density functional theory.
Version 2 decon-
volution [check box]

If enabled, adds improved performance for nonzero values of the
DFT regularization. The DFT results will be slightly better than when
the checkbox is not selected and when using a regularization
parameter. When the checkbox is not selected, the legacy behavior
of the DFT calculation used by earlier versions of the application is
produced.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Differential Hysteresis Report

Differential Hysteresis
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8 Selected Reports

DOLLIMORE-HEAL ADSORPTION/DESORPTION REPORT

BJH Adsorption/Desorption Report on page 8 - 7

The Dollimore-Heal Adsorption Report Option and the Dollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data.

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

Dollimore-Heal Adsorption/Desorption Report
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Selections Description
Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

Dollimore-Heal Adsorption/Desorption Report (continued)
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8 Selected Reports

Selections Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Dollimore-Heal Adsorption/Desorption Report (continued)
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Dollimore-Heal Desorption Plot Options

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the Dollimore-Heal Report Options
window, then click Edit. The fields and buttons for these reports are identical to the BJH Plot
Report Options.

Dollimore-Heal Tabular Report Options

Dollimore-Heal Tabular Report Options are identical to the BJH Tabular Report Options.

Dollimore-Heal Adsorption/Desorption Report
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8 Selected Reports

DUBININ REPORT

The Dubininmethod provides pore volume distributions for microporous materials by making use
of an expression for the adsorption potential.

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

Fitted Relative
Pressure Range
[group box]

Enter the minimum and maximum limits for Radushkevich or Astak-
hov relative pressures included in the line fit.

Dubinin Report
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Report Type
[group box]

Select report types. If Astakhov is selected, either selectOptimize
exponent or enter an appropriate exponent value in the text box.

Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Dubinin Report (continued)

Dubinin Report

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 8 - 27



8 Selected Reports

Dubinin Pore Volume Report Options

In the Dubinin Report Options window, highlight dV/dw Pore Volume in the Selected Reports list
box, then click Edit.

This option plots differential pore volume as a function of pore width.

Selections Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Enable to enter beginning and ending values manually.
Overlay samples
[selection]

Use to overlay sample files on the plot.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Dubinin Report
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Dubinin Tabular Report Options

In the Dubinin Report Options window, highlight Dubinin Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

Log (po/p )^n. The value for [n] is the optimized exponent ifOptimize exponent is selected on the
Dubinin Report Options window. If not, then the value for [n] is the entered exponent value.

Dubinin Report

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 8 - 29



8 Selected Reports

Dubinin Transformed Isotherm Plot Options

Highlight Transformed Isotherm in the Selected Reports list box in the Dubinin Report Options
window, then click Edit.

The transformed Dubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lines when transformed in this way.

Selections Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Deselect to enter beginning and ending values manually.

Autoscale x-axis. Shows the quantity of gas adsorbed at standard
temperature and pressure.

Autoscale y-axis. Shows the log of relative pressure.
Overlay samples
[check box]

Use to overlay sample files on the plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Dubinin Transformed Isotherm Plot Report
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F-RATIO METHOD REPORT

The f-Ratio report uses the measured isotherm and normalizes it using a reference isotherm.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Reference isotherm
[group box]

Browse to select a sample file to use as a reference for the isotherm.
Select a file containing an isotherm measured from a non-porous
sample of the same material as the current sample.

f-Ratio Report

f-Ratio Method Report
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8 Selected Reports

Selections Description
Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

f-Plot. Use to generate a normalized isotherm.

n Autoscale x-axis. The x-axis field is dimensionless in units of f-
ratio.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples. Use to overlay sample files on the f-plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

f-Ratio Report (continued)
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FIRST ORDER KINETICS REPORT

Selections Description
Plot [check box] Select to have the report formatted in a graph format.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

Tabular Report
[check box]

Select to have report formatted in table format.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

First Order Kinetics Report

First Order Kinetics Report
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8 Selected Reports

FREUNDLICH REPORT

The Freundlich Isotherm is an empirical isotherm used to model low pressure adsorption data. It
can also be applied to model some micropore isotherms. In the Selected Reports list box, highlight
Freundlich, then click Edit.

Physisorption Chemisorption

Selections Description
Calculations [group box] Select from the various calculation options.

Difference. Plots the difference between the analysis and repeat
analysis lines.

First Analysis. Includes a line fit plot for the primary analysis.

Repeat Analysis. Includes a line fit plot for the secondary analysis.
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Freundlich Report
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Selections Description
Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Pressures [button] Use to enter a range of pressure points to be included in the report or

to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.

Freundlich Report (continued)

Freundlich Report
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8 Selected Reports

Selections Description
Select Reports
[group box]

Freundlich Isotherm plot. Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure.
n Autoscale y-axis. y-axes begin at zero. The y-axis field shows

the quantity of gas adsorbed.
n Overlay samples. Use to overlay sample files on the Freundlich

isotherm plot.
Freundlich Transform plot. Plots the log(P) vs log(Q) and the best
fit.
n Autoscale x-axis. The x-axis field shows the absolute pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the Freundlich

transform plot.

Tabular report. Select to include pressure points included in the
report.

Specify monolayer
capacity [selection]

Select and enter the monolayer capacity of the sample.

Tabular report
[selection]

Use to have a report of the pressure points generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Freundlich Report (continued)
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GRAPH REPORT OPTIONS

n TCD Signal vs. Time
n Temperature vs. Time
n TCD Signal vs. Temperature

n TCD Concentration vs. Time
n TCD Concentration vs. Temperature
n TCD Signal and TCD Concentration vs. Time

Any signal (the detector signal or the 1 or 2 auxiliary signal) may be plotted against time or
temperature. Any signal can be overlaid onto the primary signal.

For color output to a monitor or printer, signals are displayed in different colors. For black and
white output, different symbols are used.

Selections Description
Do not plot more than
[n] points [text box]

Specifies a maximum number of points to plot. Plot speed may be
affected when a higher resolution is entered.

Graph Report Options

Graph Report Options
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8 Selected Reports

Selections Description
Options [button] Enabled when the Show peak marks option is selected.

Lists the peaks for the results of the highlighted experiment. Select
any (or all) peaks to include in the graph.

Select the peak labels to display on the graphs.
Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown. This option is disabled for new files.

Show peak marks
[check box]

n Enables theOptions button to specify the peaks to include in the
experiment.

n Displays the areas and baselines on the graph.
n Draws a straight baseline between the selected peaks.

X-axis [group box] Specify Time or Temperature for the x-axis variable.

Autoscale.When enabled on the report parameters windows,
allows the x- and y- axes to be scaled automatically. Autoscale
means that the x- and y- ranges will be set so that all the data is
shown. If Autoscale is not selected, the entered range is used.

Graph Report Options (continued)
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Selections Description
Y-axis [group box] Specify Time or Temperature for the y-axis variable.

Autoscale. When enabled on the report parameters windows,
allows the x- and y- axes to be scaled automatically. Autoscale
means that the x- and y- ranges will be set so that all the data is
shown. If Autoscale is not selected, the entered range is used.

Linear/Logarithmic. Scales the graph as Linear or Logarithmic.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Graph Report Options (continued)

Graph Report Options
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HORVATH-KAWAZOE REPORT

The Horvath-Kawazoemethod plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.

Selections Description
Apply Cheng-Yang
correction [selection]

Use to apply the Cheng-Yang correction to the pore size analysis.
This correction substitutes the Langmuir equation of state for Henry’s
Law in the Horvath-Kawazoe derivation.

Interaction Parameter
[group box]

Use to determine which interaction parameter will be used in the
report. These options are disabled if Sphere is selected in the Pore
Geometry group box.

Computed. Use to calculate using the parameters on the Horvath-
Kawazoe Physical Properties window (click Properties to display
the Physical Properties window). The interaction parameter is
recalculated each time a parameter in the Physical Properties
window is edited.

Entered. Calculates using the value entered in the text box.
Pore Geometry
[group box]

Select the option that best represents the physical geometry of the
micropores in the sample material. When Sphere is selected, options
in the Interaction Parameter group box are disabled.

Horvath-Kawazoe Report
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Properties [button] Click to view or edit the constants describing the physical properties

of the adsorbent and adsorptive.

Adsorbent. Contains the parameters for the sample. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

n Density. Enter the density per unit area of the sample. *
n Description. Select the name of the sample used in the analysis.
n Diameter. Enter the diameter of the sample atom.
n Diameter at zero energy. Enter the diameter of an atom at zero

interaction energy: (2/5)1/6 × diameter.
n Magnetic susceptibility. Enter the magnetic susceptibility of the

sample. *
n Polarizability. Enter the polarizability of the sample. *
Adsorptive. Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

n Density. Enter the density per unit area of the adsorptive. *
n Diameter. Enter the diameter of the gas phase atom.
n Diameter at zero energy. Enter the diameter of an atom at zero

Horvath-Kawazoe Report (continued)

Horvath-Kawazoe Report
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8 Selected Reports

Selections Description

interaction energy: (2/5)1/6 × diameter.
n Magnetic susceptibility. Enter the magnetic susceptibility of the

adsorptive. *
n Mnemonic. Select the mnemonic of the adsorptive gas in use.
n Polarizability. Enter the polarizability of the adsorptive. *

* Option is disabled if Entered is selected in the Interactions
Parameter group box.

Select Reports
[group box]

Select the types of reports to generate. Highlight the report, then
click Edit to modify report parameters.

Smooth differentials
[selection]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Horvath-Kawazoe Report (continued)
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Horvath-Kawazoe Plots

See BJH Adsorption/Desorption Report on page 8 - 7 for additional information on fields and
buttons for this report.

Highlight a plot option in the Selected Reports list box in the Horvath-Kawazoe Report Options
window, then click Edit to customize the plotting method.

Horvath-Kawazoe Tabular Report

Highlight H-K Tabular Report in the Selected Reports list box in the Horvath-Kawazoe Report
Options window, then click Edit. Select the data types to include in the report. Column [n]
indicates the column order and data contents for the report.

Horvath-Kawazoe Report
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ISOTHERM REPORT

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from
saturation pressure) of a gas by a solid held at constant temperature.

Physisorption Chemisorption

Selections Description
Autoscale [check box] Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes

begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Options [button]  Click to display related linear plot options. All plot windows contain
identical fields.

Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Plot curve / Plot points. Select to plot points on the graph.
Plot Data [check box] Select each option to include in the final report.

Isotherm Report
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Selections Description
Plot Options [group box] Select the types of isotherm to plot.

Quantity Adsorbed
[group box]

Select how to report the quantity adsorbed.

n per gram (cm3/g) STP
n per BET Surface Area (cm3/m2) STP or mmol/g
n per other Surface Area (cm3/m2) STP or mmol/m2

Selected Reports
[group box]

Select each option to include on the final report. Click the Options
button of a selected item to include plot curve, plot points, and to
autoscale x- and y-axes.

Tabular Options
[group box]

Select the options to include on the report.

Elapsed time. Time elapsed during the analysis.

Time between points. Time elapsed between points during the
analysis.

Weight %. Enter the mass percentage when plotting pressure
composition.

Tabular Report
[group box] 

Select to include tabular data in the report.

X-axis [group box] Indicate if the x-axis should be in linear or logarithmic format.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Isotherm Report (continued)

Isotherm Report
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LANGMUIR REPORT

This report is for physisorption and chemisorption analyses only.

The Langmuir calculation determines the surface area of a sample by relating the surface area to
the volume of gas adsorbed as a monolayer. Langmuir uses a single layer model.

Physisorption Chemisorption

Selections Description
Calculations [group box] Select one or more of the calculation options to be used for analysis.

Pressures [button] Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Langmuir Report
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Selections Description
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.

Pressures [button] This option is available when the sample file has a status of
Analyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table. To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for Langmuir fit
[group box]

Enter values to indicate the fitted pressure range.

Langmuir Report (continued)

Langmuir Report
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Selections Description
Select Reports
[group box]

Langmuir Isotherm Plot. Uses the Langmuir monolayer volume
and constant to produce an isotherm.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure for Langmuir.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the Langmuir

isotherm plot.
Langmuir Transform Plot. Use to generate a traditional Langmuir
surface area plot used to determine monolayer volume constant.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure for Langmuir.
n Autoscale y-axis. The y-axis field shows Langmuir trans-

formation.
n Overlay samples. Use to overlay sample files on the Langmuir

transform plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Langmuir Report (continued)
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LOOP CALIBRATION REPORT

Selections Description
Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Loop Calibration Report

Loop Calibration Report
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MP-METHOD REPORT

TheMP-Method Report provides pore volume distributions for microporous materials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-
selected thickness curve. Pore size can be expressed in angstroms or nanometers. Go
to Options > Units to specify the unit.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

MP-Method Report
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Selections Description
Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

MP-Method Report (continued)

MP-Method Report
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MP-Method Plot Report

In theMP-Method Report Options window, highlight a plot option in the Selected Reports list box,
then click Edit to customize the plotting method.

Selections Description
Overlay [drop-down box] Select an option to overlay on the current report.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

X-Axis [check box] Use to have the x-axis autoscaled or enter beginning and ending
values.

Y-Axis [group box] Autoscale. Use to have the y-axis autoscaled or enter beginning
and ending values.

Overlay. Select an option to overlay on the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

MP Method Plot Report
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MP-Method Tabular Report

In theMP-Method Report Options window, highlightMP Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

The MPMethod reports hydraulic radius only. If Pore size in diameter is selected on
the Unit Selection window, pore size in radius will be reported.

MP-Method Report
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NLDFT ADVANCED PSD REPORT

The NLDFT Advanced PSD report allows for more advanced computation of the pore size
distribution of a material using two separate analyses and two non-local DFT models.

The NLDFT Advanced PSD report option provides the same calculations as the DFT Pore Size
report option and more. The NLDFT report compares two sample files. The models that can be
selected are restricted to only those models which have the same analysis temperature and
analysis gas as the sample file that is open. For instance, if the sample file was analyzed with N2
at 77 degrees Kelvin, then only the N2 DFT models at 77 degrees Kelvin will be available in the
Model drop-down list.

The model curve fit is shown in the lower right quadrant along with the adsorption isotherm. This
curve fit is updated each time the calculation parameters change (selection of isotherm data
points, choice of model, choice of regularization parameter).

A second sample file and second model is used to compute a more accurate pore size distribution
(PSD), which is shown in the upper left quadrant. Typically, the second sample file will have used
the same sample material as the first sample file yet will have used a different analysis gas and
temperature.

In general, the isotherm for this second sample will be different than the first sample. The
advanced DFT calculation takes the data from both sample files and combines all this data into a
more accurate calculation of the pore size distribution. More accurate means getting the pore
distribution at smaller pore sizes (a few Angstroms) as well as larger pore sizes (one thousand
Angstroms).
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To make a successful Advanced calculation, a second sample file must be selected
using the Select button. A second model must also be selected. Use the options next
to the two sample file names to select the isotherm data points for each sample. After
selecting an option, the blue bars in the isotherm graph will be toggled to select either
the red points or the green points. Once these selections have been done, the results
will appear in the left-hand plots and a second isotherm will appear in the isotherm
plot (lower right) as well as a second curve-fit. As the selection of points is adjusted,
the DFT editor will recalculate the PSD results and also recalculate the two model
curve fits.

Selections Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Reports
[group box]

Use to select the second sample file.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

NLDFT Advanced PSD Report

NLDFT Advanced PSD Report
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8 Selected Reports

To run the NLDFT report:

1. Go to File > Open. Select a sample file with a Complete status, then clickOpen.
2. In the view selector drop-down list at the bottom of the window, select NLDFT Advanced

PSD. Graphs for the first sample file display and the sample description shows as the first
group box title in the upper right corner of the window.

A. First selected sample file
B. Second selected sample file

a. Select theGeometry andModel from the drop-down lists for the first sample file.
b. To select isotherm data points for calculation for the first sample file, ensure the option

to the left of the first sample file description is selected. Slide the two blue bars on the
isotherm graph to select data points. Without a second sample selected, the report will
perform a single model DFT calculation and show the results in the two left-hand result
windows.

3. To calculate data from the second sample file, click Select to locate and open the second
sample file with a Complete status. Graphs for the second sample file display and the
sample description will display as the second group box title in the upper right corner of the
window.
a. Select theGeometry andModel from the drop-down lists for the second sample file.
b. To select isotherm data points for calculation for the second sample file, ensure the

option to the left of the second sample file description is selected. Slide the two blue
bars on the isotherm graph to select data points. Data are automatically calculated for
both sample files.

c. Click Edit to make any necessary modifications to the second sample file.
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8 Selected Reports

OPTIONS REPORT

Physisorption

Lists the conditions used to perform the analysis such as:

n Adsorptive properties
n Analysis conditions
n Analysis method
n Degas conditions
n Free space
n Saturation pressure (P0) and temperature

Options reports cannot be edited.

Chemisorption

Produces a printed report of a predefined collection of sample file parameters. If Automatically
collected is selected in the Type of Data group box on the Sample Description tab, the following
information is reported:

n Task Summary. Lists conditions specified for each task selected.
n Analysis Task Options. Details conditions specified for the analysis task.
n Experiment Log. Identifies actual conditions under which each task transpired.
n Leak Test Results. Identifies outgas rates and the outcome for each leak test performed.

Dynamic Analyses

Produces a printed report of predefined collection of sample file parameters.
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PULSE CHEMISORPTION REPORT

Selections Description
Area to Volume
Conversion
[group box]

Calculated. Uses the standard calculation and the raw signal.

Calibrated. Uses selected peaks for the conversion. A calibration
step must be included in the experiment to use this method.

Selected Experiments
[group box]

Displays all related experiments in the current file. Only experiments
with collected data are shown.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Pulse Chemisorption Report

Situation 1 Pulse adsorption experiment, no calibration applied in peak editor, report
option is Calculated.

Situation 2 Pulse adsorption experiment, no calibration applied in peak editor, report
option is Calibrated.
Report displays an error message that calibration is not found and uses the
formula from Situation 1.

Quantity Adsorbed Formulas

Pulse Chemisorption Report
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8 Selected Reports

Situation 3 Pulse adsorption experiment, calibration is applied in peak editor, report
option is Calculated.

Situation 4 Pulse adsorption experiment, calibration is applied in peak editor, report
option is Calibrated.

Situation 5 Pulse reaction experiment, no calibration applied in peak editor, report option
is 'Calculated.

Situation 6 Pulse reaction experiment, no calibration applied in peak editor, report option
is Calibrated.

Report displays an error message that calibration is not found and uses the
formula from Situation 5.

Situation 7 Pulse reaction experiment, calibration is applied in peak editor, report option
is Calculated.

Situation 8 Pulse reaction experiment, calibration is applied in peak editor, report option
is Calibrated.

Quantity Adsorbed Formulas (continued)

8 - 60 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



where

Aend = Area of the last peak, shown as Peak Area in peak editor
Ax = Area of peak #X, shown as Peak Area in peak editor
AvgfirstN = Average of first N peak areas
AvglasttN = Average of last N peak areas
L = Loop quantity calculated from the injection volume, ambient

temperature, ambient pressure, and active gas concentration.

Masssample = Sample mass (grams)
N = Use the last N peaks for saturation in the Pulse Chemisorption Report

Options. For pulse reaction experiments (where gas is emitted by the
reaction and peak areas decrease over time) this is the first N peaks.

Qadsx = Quantity Adsorbed per gram for peak #X, shown in the Pulse Chemisorp-
tion Report's peak table. The report sets negative values to 0.0. To get
total quantity adsorbed, multiply by Masssample and sum across peaks.

Qend = Quantity of the last peak, shown as Peak Quantity in peak editor.
Qx = Quantity of peak #X, shown as Peak Quantity in peak editor

Pulse Chemisorption Report
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8 Selected Reports

SAMPLE AUDIT TRAIL REPORT

For 21CFR11 environments only.

This report lists all changes and comments that have been applied to sample files with a Complete
status.

SAMPLE LOG REPORT

Not applicable to 21CFR11 environments. See Sample Audit Trail Report above.

Sample Log reports cannot be edited.

Inserts a log of sample operations in the reports.

This report provides information on:
n Manual control operations performed during analysis.
n Information entered using Add Log Entry on the sample file editor.
n Warnings and/or errors which occurred during analysis.
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SINFELT AND DIFFERENCE METHODS

Difference Method Report on page 8 - 17

The Difference Method Report and the Sinfelt Method Report windows are identical unless
otherwise specified.

Sinfelt and Difference Methods
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8 Selected Reports

SUMMARY REPORT

The Summary Report for physisorption analyses provides a condensed summary of selected data
results.

In the Pore Volume group box, if Adsorption total or Desorption total is selected, the p/po field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Selections Description
Item [n] [selection] Use to enable the first Pass/Fail item. Until the Summary Report is

selected, S A Single-point BET will be displayed by default. When
selected, click Pass/Fail, then select pass/fail criteria options.

Pass/Fail [n]. Click to display the Pass/Fail Options window for
selection of pass/fail criteria.

S A: Single-point BET. Use to enable Pass/Fail [n] in the Item [n]
group box.

Upper/Lower. Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right of Upper / Lower, enter operator instructions to
be displayed if a failure is encountered.

Summary Report
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Selections Description
Select All / Deselect All
[button]

Selects (or deselects) all options.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Summary Report (continued)

SUMMARY REPORT FOR DYNAMIC ANALYSIS

The Summary Report for dynamic analyses provides a condensed summary of the peaks and
selected analysis parameters.

Summary Report for Dynamic Analysis
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8 Selected Reports

T-PLOT REPORT

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area (the area external to micropores) is directly determined and often proves
to be a valuable way of characterizing complex mixed materials.

Selections Description
Fitted thickness range
[text box]

Enter the minimum and maximum thicknesses (in angstroms or nano-
meters) to include in the thickness curve. Go toOptions > Units to
specify default units.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

t-Plot Report
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Selections Description
Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

t-Plot. Use to have a graphical representation of data generated.
n Autoscale x-axis. The x-axis field shows the statistical thickness

of the adsorbed film.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the t-plot.

Surface area correction
factor [text box]

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area and micropore surface area
into accordance. For most samples, the default value of 1.000 is
adequate.

Surface Area
[group box]

Select the surface area value used for thickness calculations. BET is
the most commonly used option.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

t-Plot Report (continued)

t-Plot Report
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8 Selected Reports

Selections Description
To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

t-Plot [check box] Use to have a graphical representation of data generated.

Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Overlay samples. Use to overlay sample files on the t-plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

t-Plot Report (continued)
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TEMKIN REPORT

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly
with increasing coverage.

Physisorption Chemisorption

Selections Description
Calculation [group box] Select one or more of the calculation options to be used for analysis.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Temkin Report

Temkin Report
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8 Selected Reports

Selections Description
Include All. Select to include all pressure points in the table.

Pressures [button] Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.

Select Reports
[group box]

Tabular Report. Generates a tabular report of the included samples
that contains the numeric values contributed by each sample.

Temkin Isotherm plot. Overlays the Temkin isotherm with the
analysis data.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure.
n Autoscale y-axis. y-axes begin at zero. The y-axis field shows

the quantity of gas adsorbed.
n Overlay samples. Use to overlay sample files on the isotherm

plot.

Temkin Transform plot. Plots a linear form of the Temkin
transform plot.
n Autoscale x-axis. The x-axis field shows the logarithm of pres-

sure (ln).
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the transform

plot.

Specify differential heat
of adsorption

Select and enter the differential heat of adsorption at zero surface
coverage. This allows inclusion of all Temkin constants.

Temkin Report (continued)
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Selections Description
[check box]
Specify monolayer
capacity [check box]

Select and enter the monolayer capacity of the sample.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Temkin Report (continued)

Temkin Report
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8 Selected Reports

VALIDATION REPORT

This report allows data to be examined by the analysis program to determine if the results are
within typical ranges. If the data for any reports selected for validation are determined to be out of
range, a warning will display and suggestions are given for corrective action.
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9 DIAGNOSTICS
Unit [n] > Diagnostics
Use to display diagnostic readings, start and schedule diagnostic tests, and open saved
diagnostic reports. Each test generates a file to the default directory name and path of
...\...\Service\userdiag unless another directory name was specified. These reports can be sent to
a Micromeritics Service Representative for examination.

START DIAGNOSTIC TEST
Unit [n] > Diagnostics > Start Diagnostic Test
Provides a method to start a diagnostic test immediately. Upon completion of the diagnostic test,
the file is saved as a .REP file which can be retrieved by going to Reports > Open Report and
selecting the report file.

It is recommended to schedule the Analysis Manifold Leak Test and the P0 Port Leak
Test to run unattended on a weekly basis. These tests check for system leaks and
require no operator intervention.

The P0 Port Leak Test should only be run if the Psat tube is attached. If a vapor
source is attached, this test should not be run.

Selections Description
Comments [text box] Displays comments from the selected diagnostic test.

Estimated time (min.)
[text box]

Approximate time for test completion.

File [group box] Shows a status bar of steps complete once the test begins.

Start Diagnostic Test

9 Diagnostics
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9 Diagnostics

Selections Description
Next [button] Starts the next test.

Operator [text box] Enter information to identify the person running the service test.

Repeat [button] Repeats the selected diagnostic test.

Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Start Diagnostic Test (continued)
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SCHEDULE DIAGNOSTIC TESTS
Unit [n] > Diagnostics > Schedule Diagnostic Tests
Allows the specification of one-time or periodic running of a sequence of diagnostic tests. A
separate list of tests is saved for each of the possible test frequencies. Tests are categorized and
flagged as requiring intervention or not. If tests requiring intervention are scheduled, the operator
has the option of omitting the tests if the operator does not respond within a specified time after an
initial prompt is displayed and before the test is started. Events are logged in the analyzer log for
all starting, ending, and omitted tests.

It is recommended to schedule the Analysis Manifold Leak Test and the P0 Port Leak
Test to run unattended on a weekly basis. These tests check for system leaks and
require no operator intervention.

The P0 Port Leak Test should only be run if the Psat tube is attached. If a vapor
source is attached, this test should not be run.

Selections Description

Available Tests
[drop-down box]

Select one or more tests to run unattended.

Insert [button] Inserts the selected test in the Available Tests drop-down list.

Schedule Diagnostics Test Frequency

Schedule Diagnostic Tests
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Selections Description

Skip these tests if the
operator does not
respond within [n]
minutes [check box]

Check this option if any test requiring operator intervention should be
omitted if the operator does not respond within the specified time.

Start test sequence if
instrument is idle any
time between 00:00:00
and 00:00:00 [text box]

Enter a from and to time for an unattended test to begin if the instru-
ment is idle at any time during the entered time frame.

Test Frequency
[selection]

Select how often the test is to run unattended.

Test Sequence
[group box]

Provides the test file identification and estimated run time. A
checkmark in the Intervention Required column indicates that
operator intervention is required.

To remove a test from the sequence, select the test, then click
Delete.

To add a test to the test sequence, highlight a row in the Test
Sequence box, select a test from the Available Tests list, then click
Insert.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Schedule Diagnostics Test Frequency (continued)

DIAGNOSTIC TEST REPORT
Unit [n] > Diagnostics > Diagnostic Test Report
Displays previously run diagnostic service tests. Separate directories store tests run once, daily,
weekly, and monthly. Diagnostic test report files have a .SVT file extension and are stored in the
...\Service directory.
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SAVE FILES FOR PROBLEM DIAGNOSIS
Unit [n] > Diagnostics > Save Files for Problem Diagnosis
Use to compress pertinent diagnostic information into a single zip file. This file can be sent to a
Micromeritics Service Representative for problem resolution.

1. Complete the form. A default file named Diagnostics-[date].zip is created unless another file
name is specified.

2. Add any files that are related to the problem— such as sample files — and save the file.
3. Send an email to Service.Helpdesk@Micromeritics.com for instructions on how to transfer

the .ZIP files to Micromeritics.

Selections Description
Problem description
[text box]

Enter information that would be helpful to the Micromeritics rep-
resentative.

Include Files [button] n Add. Click to select additional files to send with this problem
diagnosis.

n Delete. Select the file in the Include Files box, then click Delete to
remove the file from the list.

n Clear. Click to clear all files from the Include Files box.

Save As [button] Click to specify the name and location of the compressed file. Make a
note of the file name and location. This file will need to be sent to
your Micromeritics representative for problem resolution.

Micromeritics
representative [text box]

Enter the name of your Micromeritics representative. This inform-
ation will remain on the window each time files for problem diagnosis
need to be submitted (can be modified as necessary).

Save Files for Problem Diagnostics

Save Files for Problem Diagnosis
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9 Diagnostics

Selections Description
User Information
[text box]

Enter information for the person to be contacted by a Micromeritics
representative. This information will remain on the window each time
files for problem diagnosis need to be submitted (can be modified as
necessary).

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Save Files for Problem Diagnostics (continued)
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SHOW ALL READINGS
Unit [n] > Diagnostics > Show All Readings
The Show All Readings window displays the calibrated and nominal readings of all sensors in the
system.

Show All Readings
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10 CALIBRATION
Unit [n] > Calibration

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

A calibration file was created specifically for the analyzer and included with the
accessories. It is not necessary to recalibrate the system unless it seems out of cal-
ibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go to Unit [n] > Unit Configuration.

Generally, it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

10 Calibration
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10 Calibration

GAS FLOW CALIBRATION
Unit [n] > Gas Flow Calibration
Gas Charts on page I - 1

Use theGas Flow Constant Calibration option to determine a constant used by the analyzer to
ensure accurate gas flows through each Mass Flow Controller (MFC). The Mass Flow Controllers
were calibrated before shipping and calibration is typically not necessary.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic. Flow the gas to be calibrated through the Carrier gas MFC and sample tube.

2. Connect a flow meter to the exhaust and measure the actual flow rate.
3. In theGas drop-down box, select the gas to be flowed. In the Actual flow field, enter the

actual flow rate to compute the mass flow constant.
4. Click Accept to change the mass flow constant in the Adsorptive Properties for the gas to

be the computed value.
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MASS FLOW CONTROLLER CALIBRATION
Gas Charts on page I - 1

The analyzer uses a Mass Flow Controller (MFC) to control the flow of gases. The MFC requires a
conversion constant for each gas or gas mixture to compensate for variations in gas flows
resulting from variations in the gas properties.

In most cases, the default MFC conversion constant yields accurate data. A new conversion
constant may be used if:

n A unique gas mixture is used.
n The gas to be used is not included in the table.
n A higher precision calibration of the MFC for a given gas is required.
n Unexpected analysis data lead you to believe that the default value is in error.

FLOW MEASUREMENT

An external device that measures the flow of gas from the analyzer’s exhaust is used during MFC
calibration. A soap bubble burette is such a device.

For even more precise calibration, use another type of flow meter and follow these instructions for
obtaining a new conversion constant, substituting your flow meter for the soap bubble burette.

Mass Flow Controller Calibration
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INSTALL A SOAP BUBBLE BURETTE OR OTHER TYPE OF FLOW METER

These instructions are for assembling and using a burette obtained fromMicro-
meritics. If using another type of flow meter, follow the meter manufacturer’s assembly
and operation instructions.

1. Carefully unwrap the glass tube and the rubber bulb.
2. Attach one end of the flexible tubing to the side arm of the glass tube.
3. Attach the metal tubing provided with the bubble burette to the other end of the flexible

tubing.

A. Exhaust port
B. Flexible tubing
C. Bulb filled with leak detector

4. Locate the exhaust port that corresponds to the MFC to be used for this calibration.
5. Remove external plumbing from that port and attach the bubble burette using the connector

provided with the burette. The soap bubble burette must be held in an upright position. For
example, if using the Carrier Flow Controller, attach the bubble burette to the carrier gas
exhaust port.

6. Attach the bulb to the bottom of the glass tube.
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DETERMINE THE GAS FLOW CONSTANT FOR INDIVIDUAL GASES

Unit [n] > Gas Flow Calibration

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Flow the gas to be calibrated through the Carrier gas MFC and sample tube.
3. Connect a flow meter to the exhaust and measure the actual flow rate. If using a bubble bur-

ette, observe a bubble as it rises through the glass tube. The lines on the glass tube indicate
the beginning and ending points for measuring the progress of a bubble through the tube.
Use a stopwatch to measure the amount of time that elapses from the moment the bubble
passes the lower mark on the tube until the moment it passes the higher mark on the tube.

4. Go to Unit [n] > Gas Flow Calibration.
5. Select the gas being flowed.
6. In Actual flow field, enter the actual flow rate to compute the mass flow constant.
7. Click Accept to change theMass flow constant field in the Adsorptive Properties for the gas

to the computed value.

Determine the Gas Flow Constant for Individual
Gases
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MATCH TRANSDUCERS
Unit [n] > Calibration > Match Transducers

This process should not be performed when the main transducer reading is abnormal.

Use to evacuate the system and zero the pressure transducers, then adjust the scale to match
them to the manifold transducer near full scale pressure.

A blank sample tube or small plug must be installed on each selected port prior to start-
ing this process.

0.1 Torr transducer is not shown

1. Ensure that all applicable transducers are selected.
2. Click Start. The window closes when the operation is complete.
3. ClickOK when the process is complete.

Selections Description
1000 mmHg Transducers Select the ports.

10 mmHg Transducers Select the ports. Enabled only for ports with 10 mmHg trans-
ducers present.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Match Transducers
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PRESSURE OFFSET

Unit [n] > Calibration > Pressure Offset
This procedure evacuates the system and zeroes the pressure transducers. This calibration
should only be performed by qualified service personnel. In order to perform this procedure,
sample tubes must be attached to each port.

1. Install a blank sample tube or small plug on each applicable port.
2. Ensure that all applicable transducers are selected, then click Start. ClickOK when the pro-

cess is complete. The current pressure readings and operation status messages display.

Selections Description
1000 mmHg Transducers Select the manifold and/or ports.

10 mmHg Transducers Select the manifold and/or ports. Enabled only for the man-
ifold and ports with 10 mmHg transducers present.

0.1 mmHg Transducers Select the ports. Enabled only for ports with 0.1 mmHg trans-
ducers present.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Pressure Offset

Pressure Offset
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CHECK PRESSURE TRANSDUCER SCALE CALIBRATION

Do not change the pressure calibration unless absolutely necessary. Consult with
Micromeritics Norcross, GA prior to changing calibration settings.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Ensure valves 6, 7, and 8 are closed.
3. Open valves 1 through 5 and the N2 gas valve.
4. Set the servo to dose automatically to 760 mmHg by right-clicking the servo valve, select

Set > Dose > Automatic, then enter 760 mmHg.
5. Remove one of the port plugs. The pressure on all transducers will read atmospheric pres-

sure.
6. Check all transducer readings against the external pressure gauge. If the readings are

within 2 mmHg, do not change the transducer’s calibration.
7. To calibrate, go to Unit [n] > Calibration > Pressure Scale.
8. Use a pressure gauge to determine atmospheric pressure.
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9. Select the appropriate transducer.

10. Enter the pressure from the pressure gauge in theMatch to entered pressure field.
11. ClickOK to close the window.
12. A confirmation message is displayed. ClickOK.

The 10 mmHg and 0.1 mmHg transducers should not be calibrated at this time.

Check Pressure Transducer Scale Calibration
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10 Calibration

RESET PRESSURE CALIBRATION
Unit [n] > Calibration > Reset Pressure Calibration
This procedure resets the pressure calibration to the factory default settings.

The servo valve should always be recalibrated after a pressure calibration has been
performed. The pressure transducer should be calibrated before starting this pro-
cedure.

SERVO VALVE
Unit [n] > Calibration > Servo Valve
Use to calibrate the servo valve to the sample transducer. The servo valve should always be
recalibrated after a pressure calibration has been performed. The pressure transducer should be
calibrated before starting this calibration procedure.

Ensure the pressure transducer has been calibrated before performing this pro-
cedure. Go to Unit [n] > Unit Configuration and view the calibration information.
Contact your Micromeritics Service Representative if calibration dates are not listed.

Click Start. The window closes when the calibration is complete.

Click Cancel to stop the calibration process.
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SIGNAL CALIBRATION FOR DYNAMIC ANALYSIS
Unit [n] > Signal Calibration > New
Analyses yield data on signal reading, peak area, temperature, and time. These data are sufficient
for many applications; however, volume data may also be needed.

It is not necessary to perform a calibration if volume data are not needed. If volume data are
needed, calibration may be performed either before or after the analysis.

This does not apply to loop calibration, ambient temperature, and atmospheric pres-
sure. The correct values for these quantities must be entered under Unit [n] > Unit
Configuration and Options > Environment Defaults before starting an analysis
that uses them to determine the quantity of gas in an injection.

A group of automatic calibration routines is provided in the form of specialized experiment steps. A
calibration run is an analysis using one of these experiment steps. The calibration run can be
performed before or after the sample analysis. It can be included as a step within the analysis, or
performed as a separate analysis.

After the sample data and calibration data are collected, the calibration file is associated with the
sample file, and the sample data are converted to volume. A single calibration run can be
associated with an unlimited number of sample data files. For example, TPR yields peak area and
the temperature at which maximum reduction occurs. To obtain the volume of gas uptake, a
calibration file must be associated with the analysis file. Then, reports are created in which the
area data are converted to volume data.

A calibration file can be associated with a sample file by doing the following:

n Going to Unit [n] > Signal Calibration > Defaults and selecting a default calibration file for
each experiment type.

n Using the default file or choose a different file in the Unit [n] > Sample Analysis window.
n Clicking Set Calibration on the Peak Editor window and select from a list of calibration files cre-

ated after the sample file was used in an analysis.

Signal Calibration for Dynamic Analysis
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10 Calibration

CREATE A NEW SIGNAL CALIBRATION FILE
Unit [n] > Signal Calibration > New
When selecting a Signal Type and Type of Calibration, only those options used in the original
analysis are enabled on the right side of the window.

1. Select the sample file to use for the new signal calibration file.
2. Select the Signal Type and Type of Calibration options to include in the new calibration file.

As selections are made, the experiments from the selected analysis file display on the right
side of the window. Only those experiments applicable to the selected signal type and cal-
ibration type are enabled. ClickOK.

3. If prompted, enter the active gas concentration in the carrier gas and loop gas. ClickOK.
4. Delete (or edit) data in the Peak Table as appropriate. Click Save.

Selections Description
Degree [drop-down box] Select the power to display in the Coefficients list.

Delete Peak [button] Removes a peak from the peak table. Select the peak and click
Delete Peak.

Description [text box] Enter a description of the file.

Include origin
[check box]

Enables or disables the original in the graph.

Load Calibration Data
[button]

Use to enter calibration data from a selected file.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Signal Calibration
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CREATE A SIGNAL CALIBRATION REPORT
Unit [n] > Signal Calibration > Report

Select a previously defined signal calibration file from the drop-down list, then select the print
destination.

OPEN A SIGNAL CALIBRATION FILE
Unit [n] > Signal Calibration > Open
Select a previously defined signal calibration file from the drop-down list. If a calibration file
already exists, select the serial number from the drop-down serial number list. When a new
calibration file is saved with a new serial number, the new serial number displays in the Serial
Number drop-down list.

If this is the first calibration file to be saved, the Serial Number drop-down will not display until the
first calibration file is saved.

Signal Calibration for Dynamic Analysis
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10 Calibration

LIST SIGNAL CALIBRATION FILES
Unit [n] > Signal Calibration > List

Displays a list view of previously defined signal calibrations for the selected serial number.
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LOOP CALIBRATION FOR TCD ANALYZERS TUTORIAL
Septum on page 11-13

Each calibration loop must be calibrated prior to its first use to determine its precise volume under
local conditions. Calibration consists of:

n Determining the average area of a series of peaks generated by injections of a known volume
of gas through the analyzer septum using a syringe.

n Determining the average area of a series of peaks generated by injections of the same gas
using the analyzer’s internal loop.

n Calculating the volume of the loop by comparing the average peak area generated by the loop
injections with that generated by the syringe injections.

n Entering the calculated loop volume under Unit [n] > Unit Configuration.

Options > Environmental Defaults
Environmental Defaults for TCD Analyzers on page 2 - 20

Ambient pressure and temperature at the time of the analysis affect the results of a loop
calibration. In calculations, the analyzer uses the ambient pressure and temperature recorded
in Environmental Defaults. Check and update the Environmental Defaults before beginning a
loop calibration.

CREATE A SAMPLE FILE

Create the sample file and insert a Loop Calibration experiment on the Analysis Conditions
tab.

A loop calibration must be created for each loop. For Loop Calibration, select a
carrier gas, flow rate, and loop gas that will commonly be used for sample ana-
lyses.

Loop Calibration for TCD Analyzers Tutorial
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10 Calibration

PERFORM THE ANALYSIS

1. Install the correct injection loop.
2. Go to Unit > Sample Analysis and select the sample file for the loop calibration.
3. Click Next to accept the default values, then click Start.

Pay close attention to the instructions provided in each prompt and perform the
steps in the order given. Most accurate data results from keeping injection size as
consistent as possible. Injection errors may be evident in the data and may make it
necessary to repeat the experiment.

After the last manual injection, the analyzer automatically makes the same number of
injections using the loop.

GENERATE THE REPORT

Peak Editor for Dynamic Analysis on page 7 - 10

When properly performed, each manual and automatic injection results in a peak. When the
Results view of the Start Analysis window is selected, each peak can be viewed as it is
collected. The area under the peak corresponds to the amount of gas injected.

1. In the Peak Editor, open the sample file to ensure the peaks are properly marked.
2. Go to File > Open > [.SMP] and open the .SMP file containing the calibration exper-

iment and verify (or correct) the defined peaks using the Peak Editor.
3. On the Reports tab, select only the Loop Calibration report option.
4. Go to Unit > Unit Configuration. In the Loop volume field, enter the Loop Volume.
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GENERATE THE LOOP CALIBRATION REPORT
Peak Editor for Dynamic Analysis on page 7 - 10

Open the Peak Editor and ensure that peaks are properly marked.

There are three possibilities for each dose of gas injected during Pulse chemisorption :

n all of the gas is taken up by the sample,
n some of the gas is taken up by the sample, or
n none of the gas is taken up by the sample.

When pulse chemisorption is properly performed, there will be some injections of each type.
When the data is viewed using the Peak Editor, however, only those injections in which some
or none of the gas is taken up will appear as peaks. When all of the gas is taken up by the
sample, none of it reaches the detector and, therefore, the peak area is zero. These types of
peaks are detected automatically by the application and do not require marking.

1. Go to File > Open > .SMP file.
2. Select the sample file used with this analysis. ClickOK.
3. Select the Report Options tab.
4. Enter the percent of active gas in the Active concentration field.
5. On the Sample Description tab, click Active Metals.
6. Verify that the Stoichiometry Factor and the% of Sample Weight values are correct.
7. ClickOK.
8. Verify that the values for the physical injection volume, ambient temperature, and ambi-

ent pressure are accurate.
9. Go to Reports > Start Report to generate the report.

Loop Calibration for TCD Analyzers Tutorial
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10 Calibration

LOAD CALIBRATION FROM FILE
Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration
file, a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten
each time a new one is created.

Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE
Unit [n] > Calibration > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be
changed. The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 Analyzer serial number
2013-04-25 Date the calibration file was saved
.CAL File name extension
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11 HARDWARE

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.micromeritics.com).
n Error Messages document (PDF)
n Parts and Accessories
n Smart VacPrep Operator Manual (PDF)
n Vacuum Pump Guide (PDF)

COLD TRAP TUBE

A. Connector
nut

B. Ferrule
C. Sample

port
D. O-ring
E. Sample

tube

To remove the cold trap tube

1. Loosen the connector nut on each stem of the cold trap tube.
2. Gently pull down on the cold trap tube to remove it from the ports. The connector nut and fer-

rule will remain on the cold trap tube stems. If the O-ring remains on the cold trap tube stem,
examine the O-ring to ensure it is still in good condition prior to re-inserting it into the port.
Replace the O-ring, if necessary. If the O-ring remains in the port, it may be gently pried out
for replacement.

11 Hardware
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11 Hardware

To Install the cold trap tube

1. Reassemble the cold trap tube. On each stem, assemble the connector nut, a ferrule (large
side pointing toward the port), and an O-ring.

2. Slide each stem fully into the port, then tighten the connector nuts.
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PREPARE THE COLD TRAP FOR IDLE PERIODS
If the analyzer is to be inoperative or unattended long enough for the liquid nitrogen in the cold trap
Dewar to evaporate (or the dry ice to evaporate from the dry ice acetone slurry), remove the
Dewar and U-tube so that impurities are not released into the system. Install a clean, dry U-tube. If
additional U-tubes are unavailable, clean the current tube and allow to dry; then reinstall at the
cold trap port.

If the analyzer is to be inoperative or unattended for a few days, reduce the gas flow to
approximately one-quarter of its normal value and leave analyzer powered ON. The gas loss and
power drain are very low and the analyzer will be immediately ready for use.

Regardless of how long the analyzer is to be idle, keep a sample tube installed at both
sample ports. This ensures the integrity of the system for gas flow and prevents
infusion of water and other vapors.

ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

Show Instrument Schematic on page 2 - 24
Use Enable Manual Control to enable the manual control of certain system valves and pump com-
ponents on the analyzer schematic. When this option is enabled, a checkmark appears to the left
of Unit [n] > Enable Manual Control. If the analyzer schematic is not immediately visible, go to
Unit [n] > Show Instrument Schematic.

Enable Manual Control
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11 Hardware

FURNACE INSTALLATION FOR CHEMISORPTION

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

The furnace uses the same supply of compressed air as the instrument. There is an internal
regulator that has been set at the factory for the correct flow rate of cooling air to the furnace.

A. Furnace power outlet
B. Cooling air connector
C. Furnace thermocouple connector
D. Sample thermocouple connector
E. Sample thermocouple clipped to

sample tube
F. Tygon tubing

NOTE: This photo is shown without the
safety shield. The safety shield should
always be installed prior to running an
analysis.

1. If the heating mantle is installed, it must first be removed and replaced with the furnace. To
remove the heating mantle, unplug the heating mantle thermocouple connector and heating
mantle power source from the front panel of the instrument.

2. Place and center the furnace on the elevator tray.
3. On the front of the analyzer, connect cables in the following order:

a. Furnace thermocouple
b. Furnace cooling air connector
c. Furnace power connector
d. Install the sample thermocouple.
e. Insert the sample thermocouple connector into the thermocouple outlet
f. Secure the thermocouple cable into the p-clip.
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SECURE FURNACE TO ELEVATOR TRAY

This is an optional procedure for securing the furnace to the elevator tray in areas
prone to earthquakes.

Replace the screw that holds the black plastic base to the furnace and replace it with a 8-
32 × 1.5 in. screw [part number 004-28622-00].

1. Invert the furnace and remove the screw that holds the black plastic base to the bottom of
the furnace. Save the lock washer and use it when inserting the longer screw.

Remove screw and lock washer. Save the lock washer for
the next step.

2. Place the black plastic base onto the elevator aligning the hole in the base with the hole in
the elevator.

3. Position the furnace on top of the black plastic base aligning the hole in the furnace bottom
with the hole in the furnace base.

Secure Furnace to Elevator Tray
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11 Hardware

A. Lock washer
B. 8-32 × 1.5 in. screw

4. Raise the elevator. Position the lock washer in the hole in the elevator tray. Insert the
8-32 × 1.5 in. screw through the lock washer, the hole in the elevator, the black plastic base,
and into the furnace.
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HEATING MANTLE INSTALLATION
Pivot Shelf Installation on page 11-11

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

A. Shelf locking mechanism
B. Shelf track
C. Heating mantle lid
D. Heating mantle
E. Heating mantle shelf

If using less than three sample tubes, position the heating mantle cable in the 8
o'clock position when resting on the shelf surface. Ensure that the bottom of all
sample tubes are in full contact with the bottom of the heating mantle interior surface
only and DO NOT touch the thermocouple located on the bottom surface of the
mantle’s interior. A single sample tube must be installed on port 2.

A. Place cable in 8 o'clock position
B. Thermocouple
C. Sample tube positions

Heating Mantle Installation
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11 Hardware

1. Place the mantle around the sample tube bulbs. Ensure that the isothermal jackets are
pushed up against the Dewar cover to avoid damage to the jackets.

2. While supporting the heating mantle with one hand, slide the shelf locking mechanism into
the shelf track.

3. Raise the shelf on the track until the heating mantle rests securely on the shelf and the
sample tubes touch the bottom of the inside of the heating mantle.

4. Turn the locking mechanism clockwise to secure the shelf.

5. Slide the heating mantle cover between the sample tube bulbs and the bottom of the iso-
thermal jackets so that the sample tubes fit within the slots of the mantle cover.
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Do not to apply force to the tubes while installing the lid.

Heating Mantle Installation
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11 Hardware

6. Secure the heating mantle tabs onto the hook and loop fasteners of the heating mantle
cover. Ensure there is at least a 1/2 in. (12 mm) gap between the top of the mantle cover
and the bottom of the isothermal jackets. This will prevent damage to the jackets. Replace
any damaged jackets.

7. Insert the mantle thermocouple and the mantle power plug into the analyzer’s front panel.

A. Thermocouple connector
B. Mantle/furnace power connector

6. Acknowledge the prompt on the Sample Analysis window. The degas will proceed. When
the degas is completed and the mantle has cooled below 45 °C, the Sample Analysis win-
dow will submit a prompt to remove the degas heating mantle and shelf, properly position
the isothermal jackets and Dewar cover, and install the Dewar.

To prevent potential burns, do not touch the sample tube or the heating mantle until
they have cooled.

7. To remove the heating mantle, take off the heating mantle cover, support the bottom of the
heating mantle, then lower the shelf. The shelf must be removed prior to installing the
Dewar.

PARTS AND ACCESSORIES
Parts and accessories are located on the Micromeritics web page.
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PIVOT SHELF INSTALLATION
Heating Mantle Installation on page 11-7

A pivot shelf is used to support the vapor source container or the heating mantle. It can be pivoted
for installation, removal, or height adjustment.

INSTALL THE PIVOT SHELF

A. Slide rail
B. Pivot tray
C. Lever

1. Hold the pivot shelf in your left hand and the pivot block and lever (underneath the shelf)
with your right hand.

2. Pivot the shelf to the left to expose the block and lever.
3. Insert the slide block into the slide rail on the front of the analyzer.
4. To tighten the shelf into position, start with the lever to the right, push and turn the lever

clockwise.
5. Release the lever, then move the lever back to the right position and again push and turn

the lever clockwise.
6. Continue this process until the pivot shelf is snug in the slide rail.

Pivot Shelf Installation
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11 Hardware

REMOVE OR ADJUST THE PIVOT SHELF

1. Pivot the pivot shelf to the left to expose the pivot block and lever underneath the shelf.
2. Hold the pivot shelf in your left hand and the pivot block lever with your right hand.
3. To loosen the tension on the pivot shelf, start with the lever to the left, push and turn the

lever counterclockwise.
4. Release the lever, then move the lever back to the left position and again push and turn the

lever counter-clockwise.
5. Continue this process until the pivot shelf can move on the slide rail.
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SEPTUM
The septum is used to inject quantities of gas into the analyzer.

Septum port

Do not use the septum at pressures above ambient. Gas may escape at elevated pres-
sures.

Accuracy of data is diminished when poor techniques are used for injecting gas through the
septum.

Injecting the gas through the septum causes a peak to appear, but it also causes a perturbation in
the flow of gas through the analyzer. This perturbation is visible in the peak data. To minimize this
perturbation, inject the gas more slowly into the septum. Prolonging the injection causes the peak
to spread.

An injection method should be developed to balance the need to minimize the perturbation with
the need for sharper peaks. See Peak Editor for Dynamic Analysis on page 7 - 10 to adjust
peak data to reduce the effects of perturbation.

n Always hold the syringe by its metal parts away from the needle. Holding the syringe by the
glass allows body heat to affect the volume of gas in the syringe.

n After filling the syringe, allow the syringe to lie on a room temperature surface for about a
minute. This ensures that the syringe and its contents are at room temperature.

n If the gas used is lighter than air, do not allow the filled syringe to remain in a vertical position
(needle up) — the gas will diffuse out and the total volume will be reduced.

Septum
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11 Hardware

Fill the syringe

1. Empty the syringe completely.
2. Insert the syringe into a septum accessory installed on the gas regulator.
3. Draw the syringe plunger back until the syringe is completely filled with gas.
4. Remove the syringe from the septum and allow it to return to room temperature as

described previously.
5. Press the plunger into the syringe until the correct amount of gas is contained in the syringe.

Alternate method to fill the syringe with nitrogen (evaporating from liquid
nitrogen

1. Empty the syringe.
2. Hold the tip of the needle just above the surface the liquid nitrogen.
3. Draw the syringe plunger back until the syringe is filled with nitrogen gas.
4. Allow the syringe to stabilize at room temperature.
5. Push the plunger into the syringe until the correct amount of gas is contained in the syringe.

Inject gas into the analyzer

1. Insert the needle fully into the septum.
2. Press the plunger into the syringe completely to ensure that the entire quantity of gas is

injected from the syringe.
3. Remove the syringe.
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SEPTUM REPLACEMENT

Septum port

The septum usually requires replacing after approximately 100 injections when using the 1 mL
syringe.

1. Turn the knurled nut counter-clockwise and remove it from the injection port.
2. Tap the nut into the palm of your hand to remove the septum and discard the used septum.
3. If the washer came out when the septum was removed, place the washer back into the

knurled nut first.
4. Place a new septum into the knurled nut.
5. Place the knurled nut back onto the injection port. Turn the nut clockwise to finger tighten.

Do not use a wrench to tighten the septum retaining nut. Do not overtighten the retain-
ing nut. Doing so may damage the septum or the fitting.

Septum Replacement

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 11-15



11 Hardware

TCD ASSEMBLY
The filaments in the thermal conductivity detector assembly are heated to high temperatures and
may be exposed to corrosive gases, therefore they may eventually need to be replaced.
Symptoms that the TCD filaments may need replacing:

n A stable TCD baseline cannot be maintained.
n Data collection results in very high or very low peaks that are inconsistent with previous exper-

ience.
n During a data collection, no TCD signal is displayed on the main display, or the application indic-

ates that no TCD signal is present.

CLEAN THE TCD ASSEMBLY
In some instances, contamination of the thermal conductivity detector filaments will produce the
symptoms described above. To clean the filaments, set the filament zone to 150 °C and flow an
inert gas through the analyzer for several hours. Contact your Micromeritics Service
Representative if necessary.
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VAPOR SOURCE CONTAINER INSTALLATION
Vapor Purification on page M - 1

Your equipment may differ slightly. The photos in this section use View A; however,
View B is installed in the same manner as View A. If using View B, the Vapor Source
Mantle will be slightly shorter than shown in this section.

This device has been designed to be used for sample analysis via the analyzer control
panel. Any other use may damage this device or the analyzer. Each time the Psat
tube or vapor source container is replaced, a new gasket is required. Do not touch the
sealing surfaces, the port fitting, or gasket with bare hands.

For chemisorption only the vapor mantle or the sample furnace can be connected at
the time of analysis.

View A View B
1. Use an appropriate wrench to loosen the connecting nut from the port fitting by turning the

connecting nut counter-clockwise while using a second wrench to hold the port fitting sta-
tionary.

Vapor Source Container Installation
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A. Port fitting
B. Gasket
C. Connecting nut

2. Remove the connecting nut and the attached assembly. After removal, the existing seal or a
tight-fitting plastic cap can be used to protect the sealing surface assembly from scratches.
Prior to reassembly, remove the existing seal or cap, then insert a new seal.

3. Install the vapor source container with a new seal by attaching the connecting nut to the port
fitting.

4. Hand tighten the connecting nut by turning clockwise. Use an appropriate size wrench to
tighten the assembly an additional 1/8 to 1/4 turn beyond finger tight, while using a second
wrench to hold the port fitting stationary on the analyzer.

Turn on the vapor source isolation valve to
adjust the vapor flow

5. Use the manual controls on the analyzer schematic, evacuate the space above the vapor
source by opening valves 4 and 6 with all other valves closed. Then close valve 4 before
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turning the vapor source isolation valve to the vertical (open) position. The P0/vapor port
pressure reading on the instrument schematic will show the vapor pressure.

A. Mantle power source
B. Thermocouple connector
C. Vapor source mantle
D. Hook and loop strap
E. Vapor source mantle shelf
F. Shelf locking mechanism
G. Shelf track

5. Slide the vapor source mantle over the vapor source container.
6. Extend the blue knob through the circular hole. Secure the hook and loop strap.
7. Insert the thermocouple plug into the connector labeled Thermocouple.
8. Insert the power plug into the outlet labeledMantle/Furnace Power.
9. If using a support shelf, slide the shelf locking mechanism of the vapor source mantle shelf

into the shelf track on the front of the analyzer.
10. Raise the shelf until the vapor mantle is pushed as close as possible to the underside of the

upper cabinet.
11. To tighten the shelf, turn the locking mechanism clockwise.

Vapor Source Container Installation
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12 MAINTENANCE

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.micromeritics.com).
n Error Messages document (PDF)
n Parts and Accessories
n Smart VacPrep Operator Manual (PDF)
n Vacuum Pump Guide (PDF)

If the equipment needs to be relocated, check with your Micromeritics Service Representative.
The equipment must be positioned such that the mains supply is not obstructed and is easily
accessible to disconnect the equipment from the AC main power supply.

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Do not service or modify this instrument without authorization fromMicromeritics Ser-
vice Personnel. It does not include any user-serviceable parts.

When lifting or relocating the instrument, use appropriate lifting and transporting
devices designed for heavy equipment. Ensure that enough personnel are available
to assist with the movement of the instrument.

The Flex weighs approximately 103 - 106 kg (227 - 234 lb) depending on
configuration.

Use of a power cord or power supply not provided with the instrument could cause
personal injury or damage to the equipment. If a replacement is needed, contact your
Micromeritics Service Representative. Detachable power supply cords with an
inadequate rating could cause significant instrument damage or physical harm.

Do not add anything between the power cord and the power source that would
compromise the earth ground.

12 Maintenance
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12 Maintenance

Do not remove or disable the grounding prong on the instrument power cord.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such as motors, generators, or ovens— should not be placed
on the same power line.

Replacement power supply cords must be rated for the stated specifications.

If the instrument does not have a power switch and must be disconnected from the
wall outlet when powering off, position the instrument where the wall outlet is easily
accessible.

Prior to moving the instrument, disconnect and remove all glassware from the
instrument. Ensure all gas shut-off valves on the gas cylinder have been closed and
gas lines disconnected from the instrument. Contact your Micromeritics Service
Representative.
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SAFE SERVICING

Do not service or modify this instrument without the authorization of Micromeritics
Service Personnel.

To ensure safe servicing and continued safety of the instrument after servicing, service personnel
should be aware of the following risks:

Product specific risks that may affect service personnel:
n Electrical. Servicing or repair could require opening the outer panels and exposing ener-

gized electrical components.
n Liquid nitrogen. See Dewar Precautions on page 6 - 2.
n Elevator. Could pose a pinching hazard when lowering. Maintenance may require the elev-

ator screw to be greased. The service engineer can use a manual switch on the elevator
assembly to cycle the elevator to distribute the grease to permit safe servicing and con-
tinued safety of the equipment after servicing.

Protective measures for these risks:
n Electrical. The electrical components operate at low voltage (24 V or less) and pose low

risk when energized. However, maintenance, troubleshooting, and repairs should be per-
formed with the instrument de-energized whenever possible, in accordance with standard
electrical safety guidelines.

n Elevator. Moves very slowly. It is normally operated from the computer attached to the
instrument, so the operator is physically distanced from the instrument. The safety shield
should be in place during elevator operation.

Verification of the safe state of the instrument after repair:
n Elevator must be in the down position.
n Sample tubes must be removed to prevent accidental breakage. Ports should be capped

(recommended).
n Safety shield door is closed (recommended).

Safe Servicing
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12 Maintenance

GUIDELINES FOR CONNECTING GASES

Analyzer Gauge should indicate
Flex 15 psig (103 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions refer to the installation of a gas line, regulator, and gas cylinder for
each type of gas used. If expansion kits or other accessories are used in the lab, spe-
cial consideration should be given to these configurations when installing the gas
lines.

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

n Ensure the gas cylinder is closed before connecting to the analyzer.
n Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Place the cylinders

close enough to allow for proper connection at the analyzer inlet.

Using gas line extenders on gas cylinders located in remote areas may degrade gas quality
and reduce pressure. Long gas lines, such as those used with gas cylinders placed in remote
areas, should be purged if they are contaminated with water or particulates.

When possible, avoid placing gas cylinders in remote locations. It is always best to have gas
cylinders located near the analyzer.

n Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
n Always use the gas lines provided with the analyzer. It is very important that proper gas lines

are used with the analyzer. The necessary lines are provided. They are all 6 feet (2 m). One is
used for the high pressure input, and the other two are used for the low pressure input.

n Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or
entangling gas lines. This will help avoid confusion when maintenance is required.

n Label the gas line at the analyzer inlet for proper identification and maintenance.
n Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the

pressure reads approximately 600 psig (4140 kPag) on the high-pressure gauge.
Contaminants adsorbed to the walls of the cylinder will desorb as the pressure decreases.
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n Input air must be clean, dry and filtered. If using an air compressor, a secondary air filter is
required (MIC part #710-25601-004). The air filter should be regularly checked for fluid buildup
(and drained as required), and the filter element replaced as necessary. Particulates, water
vapor and oil vapor can contaminate the instrument.

To use oxygen, the analyzer must be equipped with an oxygen-compatible vacuum
pump that uses Fomblin (or a suitable equivalent) pump oil or a dry forepump. Failure
to use the proper vacuum system could result in hazardous conditions, including fire
and personal injury.

Guidelines for Connecting Gases
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CLEAN AND VERIFY THE GAS LINE

Unit [n] > Diagnostics > Start Diagnostic Test
Always clean the gas lines and verify there are no leaks at the connections after a gas cylinder is
connected. This test examines the gas line from the analyzer to the gas cylinder, then from the
analyzer to the regulator shut-off valve. A report is generated at the completion of the test to verify
that it has passed or failed. Causes and corrective action for a failure are provided.

Confirm that the state for valves and the low pressure gauge are as follows:

A. Gas tubing to instrument
B. Gas regulator shut-off valve -

OPEN
C. Low pressure gauge - 14-15

psig
D. High pressure gauge
E. Gas cylinder shut-off valve -

CLOSED
F. Regulator connecter nut
G. Regulator control knob -

OPEN
H. Brass reducer fitting

1. Select Clean and Verify Analysis Gas Line [n] Test Rev [n] in the Test field. The length of
time a test will run is indicated on the window. The Sequence field indicates the file created
as a result of this test.

2. In theOperator field, enter either the name or initials of the operator performing this test.
3. Select the Report after test option then select Preview. Click Start.
4. From the View drop-down list, select eitherOperation, Instrument Log, or Instrument
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Schematic.
5. The following series of prompts display requiring operator response:

a. This is the gas line clean and leak check test for inlet port [n]. Inlet ports being tested
must be connected to a gas cylinder according to the user manual. A Nupro isolation
valve should be installed on the line between the analyzer and the regulator.

b. The test starts with a manual leak check (requires Snoop or equivalent, and IPA), then
the line and regulator are evacuated for 20 minutes for cleaning. Next, the leak rate of
the gas line is determined.

c. With the regulator set to 15 psig, open the cylinder, regulator shut-off valve, and isol-
ation valve. Check each joint for bubbles with Snoop or equivalent. If a joint is leaking,
attempt tightening (without over-tightening) or replace ferrules.

d. When there are no leaking joints, use IPA to remove water from each joint, then wipe
dry.

e. Close the gas cylinder valve. Leave the regulator shut-off and isolation valves open.
f. User will be needed in 30 minutes to close the isolation valve. ClickOK to begin auto-

mated testing.
6. ClickOK when the test is complete. The test reports display.

7. Click each tab across the top of the window and look for a reading of Passed. A Passed
reading indicates all valves are in a proper state for operation. If any test shows a Failed
reading, refer to the following table to help determine the location of the gas leak.

Tab Test If Failed status, then...
Gas Line to Inlet
Port [n]
Test 1

Gas Line to Gas Cylin-
der Test

This test will show a reading of Failed if any of the
other tabs has a Failed reading. Correct the
failed connection and rerun the test.

Corrective Action

Clean and Verify the Gas Line
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Tab Test If Failed status, then...
Gas Line to Inlet
Port [n]
Test 2

Gas Line to Isolation
Valve Test

Check for a leak between the gas line and the
isolation valve. Correct the problem and rerun
the test.

Gas Line to Inlet
Port [n]
Test 3

Isolation Valve To
Cylinder Leak Rate

Check for a leak between the isolation valve and
the gas cylinder. Correct the problem and rerun
the test.

Corrective Action (continued)

If a test reports as failed, one or more valves is not in the proper position. Set the valves, then
ensure the appropriate pressure is displayed on the low pressure gauge.

If re-running the test, close the gas cylinder valve before starting the test.

1. Click Close to close the test report. Click Close again to close the test.
2. Repeat steps 1 through 8 for each gas line attached to the analyzer.

12 - 8 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



REPLACE A GAS CYLINDER

Analyzer Gauge should indicate
Flex 15 psig (103 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions apply to working with inert gases only. When working with
hazardous gases, follow the safety procedures established by your lab.

A power failure or loss of cryogen can result in dangerous pressures in the sample
chamber. When using toxic or flammable gases, additional venting of the cabinet may
be required.

A. Gas tubing to instrument
B. Low pressure gauge
C. High pressure gauge
D. Regulator connecter nut
E. Gas cylinder shut-off valve
F. Regulator control knob

Replace a Gas Cylinder
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Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. It is not neces-
sary to disconnect the gas line from the analyzer inlet if the cylinder will be replaced imme-
diately with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gas will be
vented from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and

move the cylinder to an appropriate location.

Connect a Gas Cylinder

Move the replacement cylinder close to the analyzer and tether it into place.
1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas

cylinder.
2. Place the protective cap in a secure location. It will be needed to recap the gas cylinder

when it is depleted and replaced.
3. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an

appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

4. Check for leaks at the high pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high pressure gauge for approximately one minute.

n If the pressure is stable, proceed with the next step.
n If the pressure decreases, tighten the regulator connector nut until it becomes

stable. If the pressure does not remain stable, remove the regulator and clean all
contacts at the regulator connection, then reinstall the regulator.
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5. Purge the air from the lines by doing the following:

Purge the regulator before starting to prevent contamination of the analysis gas sup-
ply.

a. Open the gas cylinder valve to pressurize the regulator, then close the valve.
b. Adjust the Pressure Control knob to approximately 5 psig (35 kPag).
c. Turn the regulator Shut-off valve counter-clockwise to open. Allow gas to flow until both

gauges read approximately zero.
d. Close the regulator Shut-off valve to stop gas flow.
e. Reconnect the gas line to the regulator.
f. Use two 7/16 in. (11 mm) wrenches to tighten the gas line connection. Hold one wrench

fitting steady and use the other to tighten the connector nut.
6. Set the analyzer pressure by doing the following:

a. Turn the Regulator Control knob clockwise until the low pressure gauge indicates the
appropriate pressure.

b. Open the regulator Shut-off valve.
c. Open the gas cylinder Shut-off valve and flow gas for 10 to 30 seconds.
d. Close the gas cylinder Shut-off valve.
e. Close the gas cylinder valve.

7. If the gas line to the instrument inlet was previously disconnected, reconnect it now.

Replace a Gas Cylinder
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CLEAN THE POWER SUPPLY AIR FILTER
Two power supply air filters are located on the lower rear panel of the analyzer and should be
cleaned or replaced every 30 days (more often in environments with increased levels of dust).

1. Use a flat blade screwdriver to pry the air filter cover from the base. Do not remove the
screws. Use caution when removing the cover to avoid breakage.

2. Use an air compressor to remove the dust, or rinse with tap water and dry thoroughly.
3. Replace the filter and cover by pressing the cover back into the base.
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PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Maintenance Required Frequency
Dewar Check and clean weekly.

Power supply air filters Clean and replace every 30 days (more often in envir-
onments with increased levels of dust).

Analyzer exterior Clean a needed or every 6 months.

Vacuum pump diaphragm(s) Replace every 12 months.

Port gasket Replace every 3 to 6 months (depending on the types of
analyses that were run).

Sample tube O-ring Replace as required or every 3 to 6 months.

Test analyzer for leaks As required or every 12 months.

Septum Inspect and replace every 6 months or after every 150
runs. Replace every 12 month or 300 runs.

TCD Inspect and clean every 3 months or after every 75 runs.
Replace every 12 month or 300 runs.

CryoStat See Preventive Maintenance for the CryoStat on
page D - 12.

Preventive Maintenance
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CHECK AND CLEAN THE DEWAR

When handling Dewars, follow the precautions outlined in Dewar Precautions on
page 6 - 2.

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Ice and suspended frost particles may accumulate in the bottom of the analysis port Dewar.
Particles or deposits exceeding 1/4 in. (6 mm) in depth may jam between the bottom of the sample
tube and the bottom of the Dewar, causing the Dewar not to raise fully.

Accumulations of fine particles impede liquid nitrogen circulation around the bottom of the sample
tube. This causes the sample temperature to be slightly higher which, in turn, can cause pore
volume measurement errors in those samples exhibiting high isotherm slope above 0.97 relative
pressure.

Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen
evaporates. The water must be removed, otherwise it will solidify when liquid nitrogen is added
and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use.
Clean on a weekly basis.

1. Remove the Dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitro-

gen.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

3. Rinse the Dewar with warm water to melt any remaining ice accumulation which may
remain. Dry thoroughly.

4. Replace the Dewar.
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CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning.

Do not allow liquid to penetrate the casing of the instrument. Doing so could result in
damage to the unit.

Use only a mild detergent in water to clean safety shields. The use of isopropyl
alcohol can damage the shield surface.

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If
the elevator starts to vibrate or becomes noisy when traveling, contact a Micromeritics Service
Representative for disposition.

Should lubrication become necessary, apply a light coat of TRIGEL grease [Micromeritics part
number 004-16166-00] to the elevator screw, accessed from the back of the instrument, as
needed.

Clean the Instrument
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POWER INSTRUMENT ON AND OFF

Do not connect or disconnect cables when the instrument is powered ON.

If a Smart VacPrep is used, it is recommended that the power to the Smart VacPrep remain ON
when the analyzer is powered on. If it does become necessary to power off the Smart VacPrep,
exit the analyzer program first. Restart the analyzer program, then power on the Smart VacPrep.

Power ON the equipment in the following order:

1. Computer, monitor, and printer.
2. External vacuum pump.
3. Analyzer.
4. Degasser.

Power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gress when closing the application, the following message is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print
manager will print. If a power failure occurs and an uninterruptible power supply (UPS) is
not attached to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open, and the analysis continues to run.

2. Computer, monitor, and printer.
3. Analyzer.
4. External dry forepump.
5. Smart VacPrep.
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REPLACE THE PSAT FITTING GASKET

A gasket is attached to the Psat fitting. See Replace the Psat Tube Ferrules below.

Each time the Psat tube or vapor source container is replaced, a new gasket is
required. To avoid degassing problems, do not touch the sealing surfaces of the port
fitting or gasket with bare hands.

REPLACE THE PSAT TUBE FERRULES

Over an extended period of time, pivoting the Psat tube may cause wear on the nylon
and teflon ferrules housed in the Psat tube nuts. If the recommended weekly sched-
uled P0 Port Leak Test detects a leak by reporting Failed on the Evacuated or Pres-
sured report, the first time a leak is detected, tighten the Psat nuts 1/2 turn and rerun
the test. If the leak is still present, replace the nylon and teflon ferrules.

It is recommended that the VCR connector not be removed from the port fitting for this
process.

Two ferrule sets are located in the upper and lower Psat nuts. Both sets should be
replaced. Additional ferrule sets were included in the analyzer’s accessory kit.

1. Ensure the Psat tube is filled at atmospheric pressure with gas before loosening the Psat
nut.

2. To remove the lower Psat nut, use a 7/16 in. (11 mm) wrench to loosen the Psat nut by turn-
ing the nut counter-clockwise.

A. Teflon ferrule
B. Nylon ferrule
C. Lower Psat nut

Replace the Psat Fitting Gasket

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 12 - 17



12 Maintenance

3. Remove the Psat tube from the Psat elbow.
4. Remove the nut from the Psat tube and remove the set of teflon and nylon ferrules from

inside the nut. Position the ferrules as shown with the cone pointed out of the nut.
5. Insert the Psat nut onto the Psat tube, followed by a nylon ferrule, then a teflon ferrule.
6. Insert the Psat tube into the Psat elbow.
7. Hand tighten the Psat nut by turning the nut clockwise. Then use an appropriate size

wrench to tighten the nut an additional 3/4 turn while holding the elbow so it does not move.
8. To remove the upper Psat nut, use a 7/16 in. (11 mm) wrench to loosen the Psat nut by turn-

ing the nut counter-clockwise.

A. VCR connector
B. Upper Psat nut
C. Nylon ferrule
D. Teflon ferrule
E. Lower Psat nut

9. Remove the Psat tube from the VCR connector.
10. Remove the nut from the Psat tube and remove the set of teflon and nylon ferrules from

inside the nut.
11. Reinsert the Psat nut onto the VCR connector, followed by a nylon ferrule, then a teflon fer-

rule. Orient the ferrules as shown with the cone pointed out of the nut.
12. Insert the Psat elbow into the upper Psat nut.
13. Hand tighten the upper Psat nut by turning the nut clockwise. Then use a 7/16 in. (11 mm)

wrench to tighten the nut an additional 3/4 turn while holding the elbow so it does not move.
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SAMPLE PORT FRIT REPLACEMENT

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

The chemisorption port frit is changed in the same manner as the sample port frit.

A frit is located in the connecting nut attached to each analysis port. If the frit becomes
contaminated, the contaminant may adsorb or desorb during analysis, affecting the results. A
contaminated frit on the analysis port may be indicated as a leak or a free space reading much
lower than normal.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. Right-click on the valve of the appropriate port. If the valve is open, click Close to close the
valve.

3. Use a wrench to remove the connecting nut from the sample port while using a second
wrench to hold the port fitting stationary. Remove and discard the used frit.

Sample Port Frit Replacement
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To avoid degassing problems, the frit should be clean and should not be touched with
bare hands.

4. Place a new frit into the connecting nut.

A. Frit
B. Connector nut
C. Sample tube fitting

5. Attach the connecting nut to the sample port fitting and finger tighten. Use a wrench to
tighten the nut 1/8 to 1/4 turn past finger tight while using a second wrench to hold the port
fitting stationary.
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SAMPLE TUBE O-RING REPLACEMENT

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomes worn or cracked, it does not provide a good seal and will need to be replaced.

1. Carefully remove the Dewar from the analyzer. Take care not to bump the sample tube
bulbs with the Dewar during this process. Place the Dewar aside.

2. Hold the sample tube firmly with one hand, loosen the sample tube connector nut by turning
counter-clockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to
grasp the sample tube with both hands.

A. P0 slot
B. Connector nut
C. Ferrule
D. O-ring
E. Dewar cover

4. Remove the O-ring from the top of the sample tube and replace it with a new one.

If the O-ring remains inside the sample port, use the O-ring removal tool from the
accessory kit [tool part number 004-54618-00].

5. After the new O-ring is in place, insert the sample tube back into the sample port until it is
fully seated.

Sample Tube O-ring Replacement
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6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule and O-ring will move along with the connector nut). Then, turning clockwise,
hand tighten the connector nut to the sample connector.

Open the TranSeal

Unit > Open TranSeal
Outlines the process of safely opening one or more TranSeals on sample ports.

Damage may occur to the analyzer if the samples are not under vacuum and the
Samples ARE under vacuum option is selected.

Selections Description
Sample ports to open
[group box]

Select the ports to open during analysis.

Samples are NOT
under vacuum
[selection]

Select if samples are NOT under vacuum and specify the amount of
backfill and adsorptive to be used prior to opening TranSeals.

Samples ARE under
vacuum [selection]

Select if the samples ARE under vacuum. This option evacuates
sample ports prior to opening TranSeals. Do not select this option if
the samples are not under vacuum as analyzer damage may occur.

Start [button] Opens the TranSeals. The selected sample port will be either
backfilled or evacuated as specified. The user will be prompted to
open the TranSeals. For each selected port, an event is recorded in
the Instrument Log file with the port pressure before and after opening
the TranSeal.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Tube O-ring

12 - 22 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



PURGE THE SYSTEM

PURGE AIR OR GAS

SeeGuidelines for Connecting Gases on page 12 - 4 when connecting a new gas cylinder to
one of the 12 primary gas inlets on the back of the analyzer for use as a carrier gas. After
connecting a new gas cylinder to one of the four loop gas inlets on the side of the analyzer, open
the gas inlet valve and allow gas to flow for a period of time to purge the gas line before using that
gas in an analysis.

Changing the Gas Flow During an Analysis

When gases are changed during an analysis, allow the new gas to flow for a period of time before
creating conditions that cause the experiment to begin (such as elevating the temperature). To
avoid undesirable combinations of gases within the analyzer, purge one gas (by flowing an inert
gas for a period of time) before starting to flow another gas.

To flow an inert gas between incompatible gases, insert aGas Flow step (in which an inert gas is
flowed for a period of time) and aWait step (to wait for the inert gas to purge the analyzer)
between other steps that involve incompatible gases.

When gas flows are changed while the analyzer is recording data, the gas flow is briefly disturbed.
This may result in a brief period of noise or other visible disturbances on the peak data. Either
disregard the disturbance or insert a Wait for stable baseline step immediately after changing gas
flows.

Purge the System
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13 TROUBLESHOOTING

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

Most operational problems are caused by:

n Leaks (commonly found at the sample tube O-ring at the analysis port)
n Sample weighing errors
n Use of too much analysis bath fluid in the Dewar at the start of an analysis
n Entry of incorrect system volume for analysis
n Impure gas supply

When unexpected analysis results occur, check the above first. Some common operational
problems not indicated on the window and their respective causes and solutions are provided
below:

Elevator cannot be raised or lowered.

Cause: Dewar elevator stuck.

Action: Check for possible obstruction to elevator movement.

Elevator is noisy.

Cause: The elevator screw may need greasing.

Action: Contact your Micromeritics Service Representative.

Sample is not within specifications.

Cause A: There may be a manifold leak.

Action A: See Start Diagnostic Test on page 9 - 1.
Cause B: Gas may be contaminated.

Action B: n Perform a blank analysis. If results are good, perform a reference material
analysis.

n Replace tank.
n Check for line leak, which could cause contamination.
n Flush the lines occasionally to help prevent contamination.

13 Troubleshooting
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13 Troubleshooting

Cause C: Incorrect type of gas line.

Action C: Ensure the gas line is all metal. It is best to use the one shipped with the ana-
lyzer. Do not use polymer gas lines or flexible gas lines that may be coated
internally with a polymer.

High vacuum pump indicator light does not come on.

Cause: No power to the high vacuum pump.

Action: Remove the lower panel on the front of the instrument. Check the power sup-
ply plug to the pump. Power off the high vacuum pump, then power it back on.

Vacuum gauge shows reading above 20 mmHg even after extended pumping through
unrestricted valve with analysis or degas ports closed.

Cause A: Port filter is dirty.

Action A: Replace the port filter.

Cause B: No power to the vacuum pump.

Action B: Check the pump power plug, power switch, and line circuit breaker.

For oil-based pumps:
Cause A: Port filter is dirty.

Action A: Replace the port filter.

Cause B: Vacuum pump oil is low causing ineffective evacuation.

Action B: Add or change vacuum pump oil. Add oil to proper level according to the
pump's indicator window.

Cause C: Alumina in the oil vapor trap is holding moisture because it was not sufficiently
dried before being added to the trap.

Action C: Replace or dry the alumina.

For oil-free pumps:
Cause A: High vacuum pump may have timed out.

Action A: Remove the lower front panel from the analyzer. Power off the high vacuum
pump, then power it back on.

Cause B: The pump diaphragm(s) is worn or damaged.

Action B: Contact your Micromeritics Service Representative.
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Vacuum pump is noisy.

Cause A: Sample tube connector is loose.

Action A: Tighten fitting. Replace O-ring.

Cause B: Sample tube O-ring is worn or cracked.

Action B: Replace O-ring. See Sample Port Frit Replacement on page 12 - 19.
Cause C: Sample tube is cracked.

Action C: Replace with new sample tube.

Cause D: No sample tube loaded on a selected port.

Action D: Install plug or empty sample tube.

Cause E: Gas inlet valve open while vacuum valve open.

Action E: With manual control enabled, use the instrument schematic to close gas inlet
valve.

Vacuum pump system makes loud continuous noise.

Cause A: Sample tube connector nut is loose.

Action A: Turn the connector nut clockwise to tighten.

Cause B: Sample tube fitting is loose.

Action B: Tighten the fitting using a wrench.

Cause C: Sample tube O-ring is worn or cracked.

Action C: Replace sample tube O-ring.

Cause D: Sample tube is cracked.

Action D: Replace the sample tube.

Cause E: No sample tube is loaded on selected port.

Action E: Ensure the port valve is closed. Install a plug or empty sample tube on the
port.

Cause F: A gas inlet valve is open while the vacuum valve is open.

Action F: Enable manual control then use the analyzer schematic to close the gas inlet
valve. See Show Instrument Schematic on page 2 - 24.

13 Troubleshooting
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13 Troubleshooting

Valves cannot be operated.

Cause A: Cable from computer to the instrument is loose.

Action A: Reconnect the cable.

Cause B: Circuit was opened by the circuit breaker.

Action B: Press the Breaker button located on the side of the analyzer near the power
entrance. Contact your Micromeritics Service Representative if the button will
not stay depressed.

A stable TCD baseline cannot be maintained.

Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 11-16 to clean the TCD filaments. Contact
your Micromeritics Service Representative if necessary.

Cause B: Possible leak in reference / carrier path.

Action B: Perform leak test in the reference / carrier path. See Perform a Leak Test on
page 13 - 8.

Data collection results in very high or very low peaks that are inconsistent with previous
experience.

Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 11-16 to clean the TCD filaments. Contact
your Micromeritics Service Representative if necessary.

Cause B: A different (lower) TCD filament temperature is being used.

Action B: Repeat the analysis using a higher filament temperature.

During data collection, a TCD signal of zero is recorded, or no peaks are seen.

Cause A: TCD filaments are contaminated or need to be replaced.

Action A: See TCD Assembly on page 11-16 to clean the TCD filaments. Contact
your Micromeritics Service Representative if necessary.

Cause B: TCD temperature was not reset after a run automatically suspended.

Action B: Re-enable the TCD after all run suspensions.
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Smart VacPrep S/N [n] is already in use.

Cause: Cannot add Smart VacPrep with serial number [n] because a Smart VacPrep
with the same serial number is already attached.

Action: Change the serial number if it was incorrect. Otherwise, remove the Smart
VacPrep with the duplicate serial number.

13 Troubleshooting
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13 Troubleshooting

POWER

The Flex is designed to operate with a universal input power supply (100/115/230 VAC) at 50/60
Hz. Noise-free power of the correct voltage and frequency, with a safety earth ground, should be
available through a standard wall receptacle. The power outlet should be able to supply 15 amps
@ 100 or 115 VAC ±10% or 7.5 amps@ 230 VAC ±10%. These requirements can be checked by
using a circuit analyzer (available at most hardware or electronic supply houses) or a multimeter.
There should also be sufficient outlets for all peripheral devices.

The instrument should be connected to a switch which meets relevant requirements of IEC
60947-3 or a circuit breaker which meets the relevant requirements of IEC 60947-2.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such as motors, generators, or ovens— should not be placed
on the same power line.

Replacement power supply cords must be rated for the specifications stated above.

OIL-BASED VACUUM PUMP
The Vacuum Pump Guide can be found on the Micromeritics web page (www.micromeritics.com).
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O-RING COMPATIBILITY
O-ring selection for chemisorption measurements is based on temperature, time, and chemical
compatibility. Chemical compatibility should be the first consideration when selecting an
appropriate O-ring. The time at which the furnace, and subsequently the sample cell, is at
elevated temperature can also affect the performance of the O-rings and should be a secondary
consideration. Common O-ring materials include Buna-N (nitrile), Viton (fluoroelastomer), and
Kalrez (perfluoroelastomer). Kalrez has historically been used extensively for chemisorption
measurements due to compatibility with a wide range of chemicals and temperatures and should
be suitable for all applications of the chemisorption option. Viton or Buna-N may also be suitable
for analyses similar to the reference material example file. The ability to re-use Buna-N or Viton O-
rings may be limited, while the re-use of Kalrez O-rings should be broader. Frequency of use and,
potentially, several other factors affect the duration of O-ring use, so rigid rules cannot be
specified for these materials. Leak rate and ultimate vacuum levels may be used as indicators for
O-ring performance.

O-ring Compatibility
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13 Troubleshooting

PERFORM A LEAK TEST
Unit [n] > Diagnostics > Start Diagnostic Test
AMicromeritics Service Representative may request that a leak test be performed to determine if
there is a system leak and may also require a copy of the report generated by this test.

The test provides:

n Prompts on preparing the analyzer for the test.
n Approximate time period of the test.
n Prompts in which an operator response is required.

1. Select the test to run.
2. Select Report After Test and choose Preview as the destination.
3. Click Start.
4. Verify all tests have a Passed status by selecting the tabs and looking for the Passed status

for each test run.
5. Click Save As to save the test file results.
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A. Suspend/Resume/
Skip/Play buttons

B. Port report buttons
C. Live graph settings

Perform a Leak Test
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13 Troubleshooting

PNEUMATIC PRESSURE
The compressed air supply for the pneumatically actuated, hard seal valves and furnace cooling
must be set to 100 psi ±20 psi for proper operation. Ensure that the regulator for the compressed
air supply is correctly set. If a portable air compressor is used, perform maintenance as instructed
in the air compressor manual.

RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected
during the analysis will still be present, but the analysis should be restarted in order to produce
complete results.
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A ADVANCED REPORTS - PYTHON MODULE

In a 21CFR11 environment, the Advanced reports feature is applicable to members
of the Developer group only.

The mic Python module is automatically imported when running a user supplied script. The
module provides access to primary and overlay isotherm data and provides support for summary,
tabular, and graphical reports.

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

A Advanced Reports - Python Module
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A Advanced Reports - Python Module

ADVANCED REPORTS
Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 22 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

These options are not available for
dynamic analysis

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. On the Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.
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Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Advanced Reports

Advanced Reports
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A Advanced Reports - Python Module

SCRIPTS

Run a Script

1. Open a sample file with a Complete file status.
2. Select Advanced in the view selector drop-down list at the bottom of the window.
3. Select the Report Options tab.
4. Highlight Advanced in the Selected Reports list box, then click Edit.
5. On the Advanced Report Options window, click Add.
6. Select one or more python scripts then click Select. The selected scripts become a part of

the drop-down list in the Available Scripts section of the Advanced Report Options window.
7. In the Select Reports section, select up to five Advanced reports in the drop-down lists.
8. ClickOK.
9. Click Preview on the Report Options tab to view all reports selected in the previous window.

Remove a Script

Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.
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Edit a Script

When a script is added, the code is stored within the application. If the script changes
outside of the application, the script file will have to be re-added to the Advanced
Report Options window for the changes to take affect.

Selections Description
Add [button] Adds one or more scripts to the Available Scripts box. The added

scripts then become available as options in the Selected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the
original .py text file.

Overlay samples
[check box]

Select to enable the overlay sample files process.

Pressures [button] Select to include or exclude pressures from the report.

n Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

n Cancel. Discards any changes or cancels the current process.
n Exclude All. Select to exclude all pressure points in the table.
n Include All. Select to include all pressure points in the table.
n OK. Saves and closes the active window.

Remove [button] Removes the script from the Available Scripts box but does not affect
original .py text file.

Replace [button] Replaces the contents of the selected script however, the script
name remains the same.

Scripts
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A Advanced Reports - Python Module

PYTHON REPORTS

Graphic Report

This script is an example of the mic module producing a graph with two curves:

1 import mic
2 import numpy as np
3
4 mic.graph( 'My Graph', 'X', 'F(X)' )
5 myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ]

)
6 mic.graph.add( 'X2', myx, myx*myx, marker='o' )
7 mic.graph.add( 'sin(X)', myx, np.sin(myx), marker='^' )

The results are:
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Summary Report

This script produces a summary report with two summaries:

1 import mic
2 import numpy as np
3
4 mic.summary( "My Summaries" )
5 mic.summary.add( "Summary A",
6 ["Label 1:", "Label 2:", "Label 3:"],
7 ["val1", "val2", "val3"] )
8 mic.summary.add( "Summary B",
9 ["Label 4:", "Label 5:", "Label 6:"],
10 ["val4", "val5", "val6"] )

The result is:

Python Reports
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A Advanced Reports - Python Module

Tabular Report

If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.

This script uses the Python package numpy and c-style formatting of the numerical
values.

11 import mic
12 import numpy as np
13
14 mic.table( "My Tables" )
15 mic.table.addtable( "My Set A" )
16 mic.table.addcolumn( "X", ["1.0", "2.0", "3.0"] )
17 mic.table.addcolumn( "Y", ["0.5", "1.0", "1.5"] )
18 x1 = 0.2
19 x2 = 0.5
20 x3 = 3.14159/2
21 mic.table.addtable( "My Set B" )
22 mic.table.addcolumn( "X", ['{:8.3f}'.format(x1),
23 '{:8.3f}'.format(x2),
24 '{:8.3f}'.format(x3)] )
25 mic.table.addcolumn( "sin(X)", ['{:8.3f}'.format(np.sin(x1)),
26 '{:8.3f}'.format(np.sin(x2)),
27 '{:8.3f}'.format(np.sin(x3))] )
28 mic.table.addcolumn( "cos(X)", ['{:8.3f}'.format(np.cos(x1)),
29 '{:8.3f}'.format(np.cos(x2)),
30 '{:8.3f}'.format(np.cos(x3))] )
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The result is:

Python Reports
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A Advanced Reports - Python Module

ACQUIRE BASIC INFORMATION

Physisorption

To acquire the adsorption isotherm and other basic information about the sample being edited, the
callsmic.isotherm,mic.sample_information, andmic.adsorptive_data are applied.

This script produces a graph of the adsorption and desorption isotherms for both relative and
absolute pressure, and prints summaries of the sample information and the adsorptive properties.

1 import mic
2
3 prel, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('rel')
4 mic.graph( 'Graphical Report 1', 'Relative Pressure (P/Po)', 'Quant-

ity Adsorbed (cm³/g STP)' )
5 mic.graph.add( 'Sample Isotherm', prel, qads )
6
7 pabs, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('abs')
8 mic.graph( 'Graphical Report 2', 'Absolute Pressure (mmHg)', 'Quant-

ity Adsorbed (cm³/g STP)' )
9 mic.graph.add( 'Sample Isotherm', pabs, qads )

10
11 mass = mic.sample_information('sample mass')
12 Tanl = mic.sample_information('analysis temperature')
13 dens = mic.sample_information('sample density')
14
15 mic.summary( "Sample Information" )
16 mic.summary.add( "Sample Information",
17 [ "Number of adsorption points:",
18 "Warm free space:",
19 "Cold free space:",
20 "Sample mass:",
21 "Description:",
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22 "Analysis temperature:",
23 "Sample density:" ],
24 [ '{:d}'.format(n_ads),
25 '{:8.3f}'.format(warm_fs) + ' cm³',
26 '{:8.3f}'.format(cold_fs) + ' cm³',
27 '{:8.3f}'.format(mass) + ' g',
28                    desc,
29 '{:8.3f}'.format(Tanl) + ' K',
30 '{:8.3f}'.format(dens) + ' g/cm³' ] )
31
32 csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
33
34 mic.summary.add( "Adsorptive Data",
35 [ "Cross sectional area:",
36 "Hard sphere diameter:",
37 "Density conversion factor:",
38 "Molecular weight:",
39 "Analysis gas:" ],
40 [ '{:8.3f}'.format(csa) + ' nm²',
41 '{:8.3f}'.format(hsd) + ' Å',
42 '{:8.3f}'.format(dcf),
43 '{:8.3f}'.format(mol_weight),
44                    analysis_gas ] )

Note the calls tomic.isotherm andmic.adsorptive_data above are each returning results as a list
with elements of varying return type.

Acquire Basic Information
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A Advanced Reports - Python Module

Chemisorption

This script produces a graph of the primary, repeat, and difference isotherms, and prints
summaries of the sample information and the adsorptive properties.

To acquire the adsorption isotherm and other basic information about the sample being edited, the
callsmic_chem.isotherm,mic.sample_information, andmic.adsorptive_data are applied.

Note the calls tomic_chem.isotherm andmic.adsorptive_data above are each returning results as
a list with elements of varying return type.

1 import mic
2
3 p_primary, q_primary = mic.chem_isotherm('primary')
4 p_repeat, q_repeat = mic.chem_isotherm('repeat')
5 p_difference, q_difference = mic.chem_isotherm('difference')
6 mic.graph('Graphical Report 1', 'Absolute Pressure (mmHg)', 'Quant-

ity Adsorbed (cm³/g STP)')
7 mic.graph.add('Primary', p_primary, q_primary)
8 mic.graph.add('Repeat', p_repeat, q_repeat)
9 mic.graph.add('Difference', p_difference, q_difference)
10
11 mic.summary("Sample Information")
12 mic.summary.add( "Sample Information",
13 [ "Ambient free space:",
14 "Analysis free space:",
15 "Sample mass:",
16 "Description:",
17 "Analysis temperature:",
18 "Sample density:" ],
19 [ '{:8.3f}'.format(mic.sample_information('ambient

freespace')) + ' cm³',
20 '{:8.3f}'.format(mic.sample_information('ana-

lysis freespace')) + ' cm³',
21 '{:8.3f}'.format(mic.sample_information('sample

mass')) + ' g',
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22                    mic.sample_information('sample description'),
23 '{:8.3f}'.format(mic.sample_information('ana-

lysis temperature')) + ' K',
24 '{:8.3f}'.format(mic.sample_information('sample

density')) + ' g/cm³' ] )
25
26 csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
27
28 mic.summary.add( "Adsorptive Data",
29 [ "Cross sectional area:",
30 "Hard sphere diameter:",
31 "Density conversion factor:",
32 "Molecular weight:",
33 "Analysis gas:" ],
34 [ '{:8.3f}'.format(csa) + ' nm²',
35 '{:8.3f}'.format(hsd) + ' Å',
36 '{:8.3f}'.format(dcf),
37 '{:8.3f}'.format(mol_weight),
38                    analysis_gas ] )

Acquire Basic Information
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A Advanced Reports - Python Module

ACQUIRE REPORT RESULTS FOR PHYSISORPTION

Sample file report results may be accessed using themic.report call. This script prints a summary
of the results of the t-plot and BET reports.

1 import mic
2
3 sa  = mic.report("bet", "surface area")
4 c   = mic.report("bet", "bet constant")
5 vm  = mic.report("bet", "monolayer capacity")
6 esa = mic.report("tplot", "external surface area")
7 vol = mic.report("tplot", "micropore volume")
8
9 mic.summary( "BET and T-plot Results" )
10
11 mic.summary.add( "Report Results",
12 [ "BET surface area:",
13 "BET constant:",
14 "BET monolayer capacity:",
15 "T-plot external surface area:",
16 "T-plot micropore volume:" ],
17 [ '{:10.5f}'.format(sa) + ' m²/g',
18 '{:10.5f}'.format(c),
19 '{:10.5f}'.format(vm) + ' cm³/g',
20 '{:10.5f}'.format(esa) + ' m²/g',
21 '{:10.5f}'.format(vol) + ' cm³/g' ] )

The result is:
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Acquiring the results from a pore-distribution report such as the BJH method is done in a similar
way as in the previous script except the return values from themic.report call are slightly different
since they involve lists of data. For example:

1 import mic
2 import numpy as np
3
4 xdat, ydat, desc = mic.report( 'bjhads', 'incremental distribution'

)
5 if not (np.isnan(xdat[0]) or np.isnan(ydat[0])): # NaN indicates BJH

calculation error.
6     mic.graph( 'BJH Adsorption/Desorption', 'Pore Diameter (Å)',

'Incremental Volume (cm³/g)' )
7     mic.graph.add( desc, xdat, ydat )

The result is:

Acquire Report Results for Physisorption
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A Advanced Reports - Python Module

ACQUIRE OVERLAY SAMPLE DATA FOR GAS ADSORPTION

Physisorption

The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file usingmic.report
andmic.adsorptive_data have a very similar interface as themic.overlay call, and a summary of
their usage is shown in the example in this topic.

1 import mic
2
3 p, q, n, fsw, fsc, mass, desc = mic.isotherm('rel')
4 p1, q1, n1, fsw1, fsc1, mass1, desc1 = mic.overlay( 1, 'rel')
5 p2, q2, n2, fsw2, fsc2, mass2, desc2 = mic.overlay( 2, 'rel')
6
7 mic.graph( 'Three Sample Isotherms', 
8 'Relative Pressure (P/Po)',
9 'Quantity Adsorbed (cm³/g STP)' )
10
11 mic.graph.add( 'Primary Isotherm', p, q )
12 mic.graph.add( 'Overlay Isotherm 1', p1, q1 )
13 mic.graph.add( 'Overlay Isotherm 2', p2, q2 )
14
15 mic.summary( "A Summary Report" )
16
17 mic.summary.add( "Two samples",
18 [ "Primary sample:",
19 "Overlay sample 1:",
20 "Overlay sample 2:" ],
21 [ desc, 
22                    desc1, 
23                    desc2 ] )
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The results are:

To enable the use of overlay data in the Advanced reports, the following two actions must be
taken prior to running the script:

n Sample files to overlay must be selected, and
n TheOverlay samples checkbox on the Advanced Report Options window must be selected.

Acquire Overlay Sample Data for Gas Adsorption
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A Advanced Reports - Python Module

Chemisorption

The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file usingmic.report
andmic.adsorptive_data have a very similar interface as themic.chem.overlay call, and a
summary of their usage is shown in the example in this topic.

1 import mic
2
3 p0, q0 = mic.chem_isotherm('primary')
4 p0r, q0r = mic.chem_isotherm('repeat')
5 p1, q1 = mic.chem_overlay(1, 'primary')
6 p1r, q1r = mic.chem_overlay(1, 'repeat')
7 p2, q2 = mic.chem_overlay(2, 'primary')
8 p2r, q2r = mic.chem_overlay(2, 'repeat')
9 mic.graph('Graphical Report 1', 'Absolute Pressure (mmHg)', 'Quant-

ity Adsorbed (cm³/g STP)')
10 mic.graph.add('Primary 0', p0, q0)
11 mic.graph.add('Repeat 0', p0r, q0r)
12 mic.graph.add('Primary 1', p1, q1)
13 mic.graph.add('Repeat 1', p1r, q1r)
14 mic.graph.add('Primary 2', p2, q2)
15 mic.graph.add('Repeat 2', p2r, q2r)
16
17 mic.summary("A summary report")
18
19 mic.summary.add("Sample and Two Overlays",
20 ["Primary sample:",
21 "Overlay sample 1:",
22 "Overlay sample 2:"],
23 [mic.sample_information('sample description'),
24                  mic.sample_information('sample description', 1),
25                  mic.sample_information('sample description', 2)])

A - 18 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



ENABLE THE USE OF OVERLAY DATA

1. On the Report Options tab, clickOverlays.
2. On the Plot Overlay Sample Selection window, to move a file from the Available Files list

box to the Selected Files list box, either double-click a file name in the Available Files list
box or click one or more files in the Available Files list box then click Add.

3. ClickOK.
4. On the Report Options tab, highlight Advanced in the Selected Reports list box.
5. Click Edit.
6. Select theOverlay samples checkbox to the right of the selected report.
7. ClickOK.
8. Run the script using the instructions found in Scripts on page A - 4.

Enable the Use of Overlay Data
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A Advanced Reports - Python Module

ACQUIRE METAL COMPOSITION DATA FOR CHEMISORPTION

The call to obtain information about active metals in a chemisorption sample ismic.metal_
composition. Specifically, this call provides access to the data shown in the table of the Active
Metals window. With no arguments specified, the call returns a list of all the active metals in the
sample. When called with a metal specified, the method returns an associative array (python
dictionary) of the metal's properties. With both the metal and property specified, the call returns
the value for the specified metal property. The following example script illustrates these three
usage patterns.

1 import mic
2 import pprint as pp
3
4 # Without any arguments, the method returns a list of the active

metals in
5 # the sample.
6 mnames = sorted(mic.metal_composition())
7 mic.summary("Metal Composition: " + pp.pformat(mnames))
8
9 # With only the 'metal' argument, the method returns a dictionary

of the
10 # specified metals' properties.
11 mprops = sorted(mic.metal_composition(mnames[0]).items())
12 mkeys = []
13 mvals = []
14 for k, v in mprops:
15     units = ''
16 if 'atomic weight' in k:
17         units = ' amu'
18 elif 'cross sectional area' in k:
19         units = ' nm²'
20 elif 'density' in k:
21         units = ' g/cm³'
22 elif 'percent of sample mass' in k or 'percent reduced' in k:
23         units = '%'

A - 20 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



24     mkeys.append(k + ':')
25     mvals.append('{:8.3f}'.format(v) + units)
26 mic.summary.add("Properties for " + mnames[0], mkeys, mvals)
27
28 # With both first two arguments the method returns a single value

for the
29 # specified property.
30 mweights = []
31 for mname in mnames:
32     mweights.append('{:8.3f}'.format(mic.metal_composition(mname,

'atomic weight')))
33 mic.summary.add("Active Metals and Atomic Weight (amu)", mnames,

mweights)

Acquire Metal Composition Data for Chemisorption
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MICMODULE PYTHON CALLS

TABLES

Available Mic Python calls for tables:

n Create a new tabular report
n Add a column
n Add a table

Add a Table

This script adds a table to the last created tabular report:

1 mic.table.addtable( name )
2
3 Keyword arguments:
4
5   name --- the table name

Add a Column

This script adds a column to the last created table:

1 mic.table.addcolumn(header, values, align='r'):
2
3 Keyword arguments:
4
5   header --- column header; must be a string (or convertible)
6   values --- column values; must be a list of strings (or con-

vertible)
7   align  --- column alignment; 'r', 'l', 'c' for right, left, and

center justified
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Create a New Tabular Report

1 mic.table( title='User Table' )
2
3 Keyword arguments:
4
5   title --- the tabular report title (default = 'User Table')

Tables
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SUMMARY REPORTS

Add a Summary Section

This script adds a summary section to the last created summary report:

1 mic.summary.add(name, labels, values):
2
3 Keyword arguments:
4
5   name   --- summary section name
6   labels --- column of labels; must be a list of strings
7 (or convertible) and the same length as values
8   values --- column of values; must be a list of strings
9 (or convertible) and the same length as labels

Create a New Summary Report

1 mic.summary( title='User Summary' )
2
3 Keyword arguments:
4
5   title --- the summary title
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GRAPHIC REPORTS

Add a Curve

This script adds a curve to the last created graphical report:

1 mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-',
2               marker='a', graphtype='both', interpolation='akima'):
3
4 Keyword arguments:
5
6   name      --- the curve name
7   x         --- list of x values; must be a list of floats
8 (or convertible) and the same length as y
9   y         --- list of y values; must be a list of floats

10 (or convertible) and the same length as x
11   yyaxis    --- place this curve on the yy-axis if True
12                 otherwise place on the y-axis (default = False)
13   color     --- RGB color as an HTML hex string (e.g., '#4169e1')
14 or a three-element list or tuple (e.g.,

[65,105,225]);
15 if None, color is automatically selected (default =

None)
16   linestyle --- line style; (default = '-')
17 '-'        : solid
18 '--'       : dash
19 '.'        : dot
20 '-.'       : dash dot
21 '-..'      : dash dot dot
22   marker    --- marker shape; (default = 'a')
23 '+'        : plus
24 'o' or '0' : circle
25 'x'        : cross
26 '^'        : up triangle

Graphic Reports
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27 'v'        : down triangle
28 's'        : square
29 'd'        : diamond
30 '8'        : hourglass
31 '~'        : horizontal hourglass
32 '' or None : no marker
33 'a'        : automatically selected
34   graphtype --- graph type; (default = 'both')
35 'curve' or 'c' : curve
36 'points' or 'p' : points
37 'both' or 'b' : curve-and-points
38 'hist' or 'h' : histogram
39   interpolation -- linear or akima spline interpolation

(default='akima')
40 'akima' use akima spline
41 'linear' use linear interpolation

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

1 mic.graph.addyy(name, xx, yy):
2
3 Add a curve to the last created graphical report using the second
4 y-axis. The arguments to this call are the same as to mic.-

graph.add.
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Create a New Graphical Report

1 mic.graph(title='User Graph', xlabel='X axis', ylabel='Y axis',
2           yylabel='YY axis',
3           xlinear=True, ylinear=True, yylinear=True,
4           xinvert=False, yinvert=False, yyinvert=False,
5           xrange=None, yrange=None, yyrange=None, xbars_id=''):
6
7 Keyword arguments:
8
9   title    --- the graphical report title (default = 'User Graph')
10   xlabel   --- x-axis label (default = 'X axis')
11   ylabel   --- y-axis label (default = 'Y axis')
12   yylabel  --- yy-axis label (default = 'YY axis')
13   xlinear  --- x-axis linear scale; if false, use log scale
14 (default = True)
15   ylinear  --- y-axis linear scale; if false, use log scale
16 (default = True)
17   yylinear --- yy-axis linear scale; if false, use log scale
18 (default = True)
19   xinvert  --- Invert x-axis if true (default = False)
20   yinvert  --- Invert y-axis if true (default = False)
21   yyinvert --- Invert yy-axis if true (default = False)
22   xrange   --- None, or two values giving the min and max
23                range of the axis.
24   yrange   --- None, or two values giving the min and max
25                range of the axis.
26   yyrange  --- None, or two values giving the min and max
27                range of the axis.
28   xbars_id --- None, or the id of an xbar control created
29                via the mic.control() object

Graphic Reports
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GET EXPERIMENT INFORMATION

1 mic.dyn_chem_experiment(exp_num, sec_num=0, item=''):
2
3   Get data associated with the indexed experiment
4
5   Keyword arguments:
6
7     exp_num    --- The index of the experiment to acquire
8                    information for.  Indexing begins at 1
9
10     sec_num    --- If zero, the primary experiment data is

returned.
11                    If greater than zero, returns associated sec-

ondary
12                    experiment if any (typically these are mass

specs).
13
14     item       --- the specific experiment property to return
15                    information on.  If '' or None, then return
16                    the whole experiment dictionary
17
18   Usage:
19
20     exp = mic.dyn_chem_experiment(exp_num = 1)
21     ms1 = mic.dyn_chem_experiment(exp_num = 1, sec_num = 1)
22     expid = mic.dyn_chem_experiment(exp_num = 1, item = 'id')
23     temp = mic.dyn_chem_experiment(exp_num = 1, item = 'tem-

perature')
24
25 mic.dyn_chem_experiment_all():
26
27   Return a dictionary of all experiments. The key is the experiment
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28   number, the value is a dictionary with keys from 0 (primary exper-
iment

29   data) through n where n is the number of secondary experiments
(e.g.,

30   mass spec data).

Get Experiment Information
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GET PRIMARY ISOTHERM DATA

Physisorption

1 mic.isotherm(press_type='rel', sample_number=0, item=''):
2
3 Get isotherm data.
4
5 Keyword arguments:
6
7   press_type    --- the pressure basis; use 'rel' for relative pres-

sure,
8 'abs' for absolute (default = 'rel'). This is

ignored
9 if the 'item' argument is also used.
10
11   sample_number --- Sample to retrieve
12 0           : current sample file (default)
13 1 through 8 : corresponding overlay sample file
14
15   item          --- string identifying the item to be returned.
16                     For example; 'absolute pressure', or 'quantity

adsorbed'
17                     The default is an empty string for which the

return
18                     value is the below list of quantities
19
20 Usage for specified item:
21   prel = mic.isotherm(sample_number=0, item='relative pressure')
22
23 Usage with tuple returned:
24   p, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('rel')
25
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26   p       --- array of pressure (relative or absolute)
27   qads    --- array of cumulative quantity adsorbed
28   num_ads --- number of points in the adsorption curve
29   warm_fs --- warm free-space
30   cold_fs --- cold free-space
31   mass    --- sample mass
32   desc    --- sample description

Chemisorption

1 mic.chem_isotherm(branch='primary', item=None):
2
3 Get primary, repeat and difference isotherm data.
4
5 Keyword arguments:
6
7   branch --- Specifies which analysis to get isotherm data;
8              use 'primary' for the first analysis,
9 'repeat' for the repeat analysis
10 and 'difference' for the difference of these two
11   item   --- only get the specified item.  Allowed values are None
12 or 'sample temperature'.  No argument means
13              to return p,q
14
15 Usage:
16
17   p, q = mic.chem_isotherm('primary')
18   p, q = mic.chem_isotherm('repeat')
19   p, q = mic.chem_isotherm('difference')
20
21   temp = mic.chem_isotherm(branch='primary',item='sample tem-

Get Primary Isotherm Data
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perature')
22
23   p    --- array of absolute pressures
24   q    --- array of cumulative quantity adsorbed
25   temp --- array of sample temperatures
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GET OVERLAY ISOTHERM DATA

Physisorption

1 mic.overlay(overlay_number=1, press_type='rel'):
2
3 Get overlay isotherm data.
4
5 Keyword arguments:
6
7   overlay_number --- the overlay number (1 through 8; default = 1)
8   press_type     --- the pressure basis; use 'rel' for relative

pressure,
9 'abs' for absolute (default = 'rel')

10
11 Usage:
12
13   p, qads, num_ads, warm_fs, cold_fs, mass, desc = mic.overlay(1,

'rel')
14
15   p       --- array of pressure (relative or absolute);
16               empty-array if overlay is unavailable
17   qads    --- array of cumulative quantity adsorbed;
18               empty-array if overlay is unavailable
19   num_ads --- number of points in the adsorption curve;
20 0 if overlay is unavailable
21   warm_fs --- warm (ambient) free-space; 0.0 if overlay is unavail-

able
22   cold_fs --- cold (analysis) free-space; 0.0 if overlay is unavail-

able
23   mass    --- sample mass; 0.0 if overlay is unavailable
24   desc    --- sample description; empty-string if
25               overlay is unavailable

Get Overlay Isotherm Data
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Chemisorption

1 mic.chem_overlay(overlay_number=1, branch='primary', item=None):
2
3 Get overlay isotherm data.
4
5 Keyword arguments:
6
7   overlay_number --- the overlay number (1 through 8; default = 1)
8
9   branch --- Specifies which analysis to get isotherm data;

10              use 'primary' for the first analysis,
11 'repeat' for the repeat analysis
12 and 'difference' for the difference of these two
13   item   --- only get the specified item.  Allowed values are None
14 or 'sample temperature'.  No argument means
15              to return p,q
16 Usage:
17
18   p, q = mic.chem_overlay(1, 'primary')
19   p, q = mic.chem_overlay(1, 'repeat')
20   p, q = mic.chem_overlay(1, 'difference')
21
22   temp = mic.chem_overlay(branch='primary',item='sample tem-

perature')
23
24   p    --- array of absolute pressures
25   q    --- array of cumulative quantity adsorbed
26   temp --- array of sample temperatures
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GET ADSORPTIVE DATA FOR EACH SAMPLE

1 mic.adsorptive_data(sample_number=0):
2
3 Get adsorptive data for each sample
4
5 Keyword arguments:
6
7   sample_number --- Identifier for the adsorptive data to retrieve
8 0           : current sample file (default)
9 1 through 8 : corresponding overlay sample

file
10
11 Usage:
12
13   csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
14   csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data(0)
15
16   csa          --- cross sectional area (nm^2)
17   hsd          --- hard sphere diameter (angstroms)
18   dcf          --- density conversion factor (dimensionless)
19   mol_weight   --- molecular weight
20   analysis_gas --- mnemonic for the analysis gas species
21 (e.g., 'CO', 'H2')

Get Adsorptive Data for Each Sample
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GET SAMPLE INFORMATION ITEM

1 mic.sample_information( item, sample_number = 0 ):
2
3 Keyword arguments:
4
5   item          --- string identifying the item to be returned.
6                     For example; 'sample mass', or 'sample descrip-

tion'
7                     The default is an empty string for which the

return
8                     value is a list of all available keywords
9

10   sample_number --- Sample to retrieve
11 0           : current sample file (default)
12 1 through 8 : corresponding overlay sample file
13
14 Usage:
15
16   all_keywords = sample_information()
17   mass         = sample_information('sample mass')
18   mass         = sample_information('sample mass',0)
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GET REPORT RESULTS FOR PHYSISORPTION

This script gets report results for the indicted report and sample:

1 mic.report(report_name='', result='', sample_number=0):
2
3 Get report results for the indicated report and sample
4
5 Keyword arguments:
6
7   sample_number --- Identifier for the sample data to retrieve.
8 0           : current sample file (default)
9 1 through 8 : corresponding overlay sample file

10
11 Usage:
12
13   sa                  = mic.report('bet', 'surface area')
14
15   porew, incvol, desc = mic.report('bjhads',
16 'incremental distribution')
17
18 The available report keywords, result keywords and a corresponding
19 description of the result is listed in the table below
20
21    Report        Result                   Description
22 -----------   --------------              -----------
23     bet        surface area               Surface area (m^2/g)
24     bet        bet constant               BET constant (dimen-

sionless)
25     bet        monolayer capacity         Monolayer capacity

(cm^3/g)
26     tplot      external surface area      External surface area

(m^2/g)
27     tplot      micropore volume           Micropore volume (cm^3/g)

Get Report Results for Physisorption
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28     bjhads     incremental distribution   Incremental Distribution
29     bjhdes     incremental distribution   Incremental Distribution
30     dhads      incremental distribution   Incremental Distribution
31     hk         incremental distribution   Incremental Distribution
32     dft        incremental distribution   Incremental Distribution
33     nldft      incremental distribution   Incremental Distribution
34
35
36   where the incremental pore distribution result above (for those
37   reports which return this) is a list with three components being,
38
39   porew  --- array of pore dimension boundaries (angstroms);
40              empty-array if unavailable.
41   incvol --- array of incremental pore volumes (cm^3/g);
42              empty-array if unavailable.
43   desc   --- Name of data set; empty-string if unavailable.
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GET IMPORTED PORE DATA

1 mic.imported_pore_data(import_number=1):
2
3 Get imported pore data.
4
5 Keyword arguments:
6
7   import_number --- the import number (1 through 8)
8
9 Usage:
10
11   porew, incvol, desc = mic.imported_pore_data(1)
12
13   porew  --- array of pore dimension boundaries (angstroms);
14              empty-array if unavailable.
15   incvol --- array of incremental pore volumes (cm^3/g);
16              empty-array if unavailable.
17   desc   --- Name of data set; empty-string if unavailable.

Get Imported Pore Data
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GET METAL COMPOSITION FOR CHEMISORPTION

1 mic.metal_composition(metal='', metal_property='', sample_
number=0):

2
3 Get information about the active metals in this sample
4
5 Keyword arguments:
6
7   metal           --- the metal to return information about
8 if '' or None, then return a list of the
9                       active metals

10
11   metal_property  --- the specific property to return information

on
12 if '' or None, then return all the prop-

erties
13 for the specified metal (requires metal to

be
14                       specified)
15
16   sample_number --- Identifier for the metal data to retrieve
17 0           : current sample file (default)
18 1 through 8 : corresponding overlay sample

file
19
20 Usage:
21
22   metal_list  = mic.metal_composition()
23   copper_prop = mic.metal_composition('copper')
24   copper_perc = mic.metal_composition('copper',
25 'percent of sample mass')
26
27 In the above first usage case, the list of active metals is

A - 40 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



returned.
28 In the above second usage case, a python dictionary type
29 is returned which includes all the properties of the metal
30 available and their corresponding values.  The last case returns
31 a single value (int, float, or string) for the specified property.
32
33 The metal_property keywords which one can use are
34
35   atomic weight
36   oxygen atoms
37   density
38   percent of sample mass
39   metal atoms
40   cross sectional area
41   percent reduced
42   stoichiometry GASNAME
43
44 where in the last keyword one substitutes the desired gas name to
45 obtain its stoichiometry factor.  One can also make the call
46 metal_composition(metalname) without any metal_property keyword
47 provided to see the whole dictionary of keywords and values.

Get Metal Composition for Chemisorption
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B ATOMIC WEIGHTS AND CROSS-SECTIONAL AREAS

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

Metal Symbol Atomic Weight
(g/mol)

Cross-sectional
Area (nm2)

Density (g/mL)

chromium Cr 51.996 0.0635 7.19

cobalt Co 58.933 0.0662 8.9

copper Cu 63.54 0.0680 8.96

gold Au 196.967 0.08696 18.9

hafnium Hf 178.490 0.0862 13.3

iridium Ir 192.220 0.0769 22.4

iron Fe 55.847 0.0613 7.89

manganese Mn 54.938 0.0714 7.43

molybdnum Mo 95.940 0.0730 10.22

nickel Ni 58.710 0.0649 8.9

niobium Nb 92.906 0.0806 8.57

osmium Os 190.220 0.0629 22.6

palladium Pd 106.400 0.0787 12.02

platinum Pt 195.090 0.0800 21.45

rhenium Re 186.2 0.0649 21.02

rhodium Rh 102.905 0.0752 12.1

tuthenium Ru 101.070 0.0613 12.4

silver Ag 107.868 0.0869 10.5

tantalum Ta 180.947 0.0800 16.6

thorium Th 232.038 0.1350 11.7

tin Sn 118.710 0.1082 4.54

tungsten W 183.850 0.0741 19.3

vanadium V 50.942 0.0680 6.11

zirconium Zr 91.220 0.0877 6.51

Atomic Weights and Cross-sectional Areas for Selected Metals

B Atomic Weights and Cross-Sectional Areas
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C CALCULATE FREE SPACE VALUES FOR MICROPORE
ANALYSES
Many microporous materials, such as zeolites and activated carbons, trap and hold helium in their
complex pore structures for many hours after being exposed to helium. Helium trapped in
micropores can interfere with the analysis at low pressures, causing an “S”-shaped curve at the
lower end of the isotherm. For this reason, it is recommended to enter the ambient and analysis
free space volumes when performing micropore analyses, therefore avoiding exposure of the
sample to helium. Two techniques can be used for determining ambient and analysis free-space
values.

The first method is to perform a short analysis on the sample after partial degassing (one pressure
point with no incremental dosing), but prior to final sample preparation. Measure the free space
during this analysis. The measured free space values will be printed on the report and may then
be entered into the sample file after more thorough sample preparation.

The second method requires prior tests using empty tubes that will be employed later for the
sample analyses. The measured free space data can be used thereafter on every analysis
performed using these sample tubes. This small initial investment of time will save considerable
time later. Perform an empty tube analysis on each sample tube to be used for micropore
analysis. Measure the free space of each sample tube, taking only one pressure point

1. Create a sample tube file from each empty tube test.
2. Use the Load from Sample File button to read in the measured free space from the empty

tube tests.
3. In the sample file for the sample analysis, pick the appropriate sample tube from the sample

tube list.
4. Enter the mass and density of the sample.
5. Select Calculate in the free space options in the analysis conditions.

C Calculate Free Space Values for Micropore Ana-
lyses
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D CRYOSTAT

The cryostat elevator is manually operated, however the analyzer elevator must first
be disabled to prevent damage to the analyzer.

A CryoStat is an available option. Parts and accessories are located on the Micromeritics web
page.

Unit [n] > Enable CryoStat
When selected:

n Unit [n] > Disable Elevator is automatically selected
n applicable cryostat fields within the application will be enabled

Unit [n] > Disable Elevator
When selected, the analyzer elevator will not move until this option is deselected.

D CryoStat
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D CryoStat

CRYOSTAT OPERATING INSTRUCTIONS
The cryostat provides automatic analysis temperature control over a wide range of sub-ambient
temperatures.

n Read and fully understand this entire section prior to carrying out operations on the
system.

n All system components must be powered ON in the sequence provided in this sec-
tion.

n Pay attention to all local safety systems and requirements and consider the spe-
cifics of the experiment when operating the system.

1. Prior to starting any analysis on the system, ensure the following:
n Go to Unit [n] > Enable CryoStat and ensure a checkmark displays to the left of the

menu option. A checkmark indicates the item has been selected and disables the elev-
ator during an analysis when using the cryostat.

n The cryostat is correctly mounted and held firmly in place by the metal retaining bands.
n Release the brake on the cryostat cradle and move the system upwards to check that

the sample well and the analyzer sample port is correctly aligned.
n Check that the vacuum connection, helium connection, and wired connections to the

compressor and temperature controller are in place and correctly fitted.

2. Prepare the samples.
n Samples can be prepared in-situ using the analyzer heating mantle (if the heating

mantle fits with the cryostat installed). See Degas in Situ on page 5 - 3. This will
depend on the type of heating mantle used.

n The cryostat can be prepared to run analyses in the DOWN position while the samples
are being prepared. Leave the insulating cover for the cryostat sample well in place
while doing this.

3. Turn on the helium supply and adjust the rotameter to scale position 55. This corresponds
to a flow rate of approximately 5 mL/min. See Rotameter Scale Readings on page D - 8.

4. Allow the helium to purge the sample well for fifteen minutes. This purge procedure
removes water vapor from the sample well and prevents water vapor from freezing when
the system is in use at sub-ambient / cryogenic temperatures.

5. Power ON the compressor by flipping the first switch of the circuit breaker to the UP pos-
ition. The compressor will now start to pump.

6. Press the ALL OFF button to power ON the temperature controller. Set the required tem-
perature on the temperature controller or in the analysis application. If using the tem-
perature controller, refer to the temperature controller manual supplied by the
manufacturer.
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7. Create a sample file (see Create Sample Files on page 3 - 2). There are settings specific
to physisorption analyses using a cryostat in Analysis Conditions for Physisorption and
Chemisorption on page 4 - 5.

8. With the sample tubes in place, preparation completed, and the tubes cooled to ambient
temperature, slide the insulating cover up the sample tubes so that the cover fits snug
against the mouth of the raised cryostat.

9. Remove the insulating cover from the top of the cryostat sample well. When prompted by
the analyzer application, raise the cryostat.

10. Allow the samples to thermally equilibrate before starting the analysis.
11. When prompted by the analyzer application, lower the cryostat and place the insulating

cover over the sample well of the cryostat.
12. If the sample tubes are to be removed, use Unit [n] > Backfill Ports or use the manual con-

trol option and pressurize the sample tubes to 760 mmHg at ambient temperature.
13. Weigh the samples after analysis and enter the sample weight into the sample file. The cryo-

stat can now be used to analyze more samples at the same temperature or change the set
point temperature.

14. Power OFF the compressor, vacuum pump, helium supply, and temperature controller. The
cryostat should remain powered ON unless it will be unused for a long period of time. If it is
necessary to power OFF the cryostat, set it to ambient temperature and allow it to come up
to room temperature.

CryoStat Operating Instructions
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SAMPLE FILE CONFIGURATION FOR FLEX
1. Start the analysis program and open a sample file or create a new one.
2. Select the Analysis Conditions tab then use the Analysis Conditions Buttons table to com-

plete the sample file.

Button Enter....
Preparation

In the Elevator section, selectWait for Operator. ClickOK.
Free Space

Depending on the sample and proposed analysis, the free space can
be entered,measured,measured after analysis, or calculated. If the
free space is to bemeasured, then this can be done in the normal

Analysis Conditions Buttons
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Button Enter....
manner, but with the operator manually moving the cryostat
assembly when prompted.

p0 and T

In the Analysis Temperature Options section, select Calculate the
analysis temperature from p0 or Psat. ClickOK.

Termination

Deselect Backfill after analysis.

Analysis Conditions Buttons (continued)

3. Go to Unit [n] > Sample Analysis.

Sample File Configuration for Flex
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4. Select Control CryoStat, enter a Target Tolerance and a Hold Time. The cryostat tem-
perature will be ramped (if ramp is enabled) to the sample analysis temperature. Once the
cryostat temperature is within the entered tolerance, the analysis will wait for the hold time
before proceeding.

INSTALL SAMPLE TUBE FOR THE CRYOSTAT
Sample Tube Installation for Physisorption on page 6 - 10

Sample tubes for the cryostat are installed in the same manner as the sample tubes for the
analyzer.
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REMOVE THE CRYOSTAT FROM THE ANALYZER
To run a normal analysis, the cryostat must be removed.

1. Move the cryostat to the DOWN position.
2. Place the brake in the bottom position.
3. Remove the 1/8 in. nylon helium tube.
4. Close vacuum valve.
5. Remove the 1/4 in. flexible stainless steel evacuation hose at the Swagelok valve.
6. Remove the large hose clamps and lift the entire cryostat off the cradle.
7. Lay the assembly on an adjacent bench so that other hoses do not need to be dis-

connected.
8. Close the helium purge supply, close the vacuum valve, power OFF the vacuum pump and

compressor, turn OFF the temperature controller.

It is not necessary to remove the carriage assembly from the analyzer; however, the
special safety shield (supplied with the cryostat kit) should be used. This shield has
been modified to reach over the cryostat panel and hook onto the analyzer.

Remove the CryoStat from the Analyzer
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ROTAMETER SCALE READINGS
The rotameter scale corresponds approximately to flow rates:

A. Adjustment knob
B. Brake

Scale Reading Flow Rate (mL/min)
65 5.8

55 5

45 4.3

35 3.3

25 2.5

15 1.8

5 1.3

Rotameter Scale to Flow Rate
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TROUBLESHOOTING THE CRYOSTAT
Frost or ice accumulates around the outside of the cryostat in the area of the sample well

Cause: The internal vacuum is degrading and must be re-evacuated.

Action: Effective re-evacuation can be done only when the cryostat is warm, such as
after an analysis. It is recommended that the vacuum pump always remain
powered ON.

Elevator tries to rise

Cause: Analysis program is not set to enable the cryostat.

Action: In the analysis program, go to Unit [n] > Enable CryoStat and ensure that
this option is selected. Failure to do so will cause the P0 port to be evacuated
and the elevator will try to rise.

Valve motor in cryostat cold head does not start when the compressor starts

Cause A: Cold head cable is not connected.

Action A: Stop the compressor. Connect the cable.

Cause B: Open circuit in the cold head cable.

Action B: Disconnect the cold head cable. Check each conductor for continuity.
Replace the cable if necessary.

Cause C: Defective valve motor.

Action C: Contact your Micromeritics Service Representative.

Cause D: Blown fuse in the compressor's electrical box.

Action D: Refer to the manual supplied by the compressor manufacturer.

Valve motor in cryostat cold head hums but does not start

Cause A: Valve disk has stalled.

Action A: Check the operating pressures on the compressor. Contact your Micro-
meritics Service Representative.

Cause B: Defective valve motor.

Action B: Contact your Micromeritics Service Representative.

Cause C: Open circuit in the cold head cable.

Troubleshooting the CryoStat
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Action C: Disconnect the cold head cable. Check each conductor for continuity.
Replace the cable if necessary.

Valve motor on the cryostat cold head runs but there is no cooldown

Cause A: No insulating vacuum.

Action A: Check the vacuum system for operation and leaks.

Cause B: Gas line couplings are not fully engaged.

Action B: Ensure all couplings are fully engaged and torqued.

Cause B: Gas lines are connected incorrectly.

Action C: Reconnect the gas lines. Refer to the manual supplied by the compressor
manufacturer.

Cause D: Compressor output is inadequate.

Action D: Troubleshoot the compressor. Refer to the manual supplied by the com-
pressor manufacturer.

Shroud is sweating or abnormally cold

Cause: Loss of insulating vacuum.

Action: Check the vacuum system for operation and leaks.

Abnormally noisy operation after a sustained period of five to fifteen minutes

Cause A: Incorrect compressor pressures.

Action A: Troubleshoot the compressor. Refer to the manual supplied by the com-
pressor manufacturer.

Cause B: Contaminants in the gas.

Action B: PerformGas Cleanup and Recharging procedure on the cold head, com-
pressor, and the gas lines. Refer to the manual supplied by the compressor
manufacturer.Contact your Micromeritics Service Representative.

Intermittent operation

Cause: Compressor is cycling on and off.

Action: Troubleshoot the compressor. Refer to the manual supplied by the com-
pressor manufacturer.
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Temperature is cycling

Cause: Contaminated gas is causing a cold head freezing-thawing cycle.

Action: PerformGas Cleanup and Recharging procedure on the cold head, com-
pressor, and the gas lines. Refer to the manual supplied by the compressor
manufacturer.Contact your Micromeritics Service Representative.

Sudden loss of refrigeration capacity

Cause A: Loss of insulating vacuum.

Action A: Check the vacuum system for operation and leaks.

Cause B: Compressor malfunction.

Action B: Troubleshoot the compressor. Refer to the manual supplied by the com-
pressor manufacturer.

Troubleshooting the CryoStat
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PREVENTIVE MAINTENANCE FOR THE CRYOSTAT

The preventive maintenance procedures can be located in the documents supplied by the cryostat
manufacturer.

Maintenance Required Frequency
Cold head Every 13,000 hours

Compressor (absorber) Every 30,000 hours
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CRYOSTAT CALIBRATION
The cryostat temperature reading does not necessarily reflect the temperature at the sample. The
discrepancy is large enough to cause significant differences between data taken with a cryogenic
bath and data taken with the cryostat set to the temperature of the bath.

One solution is to modify the voltage-to-temperature curve stored in the temperature controller so
that the reading accurately reflects the temperature of the sample. This option requires additional
interaction with the temperature controller to download, upload, and select the voltage-to-
temperature curves. However, this is straightforward with the Lakeshore controller and their Curve
Handler software.

REQUIRED ITEMS

n A Flex analyzer equipped with an installed Micromeritics cryostat unit.
n A selection of adsorptives to cover the temperature range to be calibrated— such as nitrogen,

argon, methane, ethane, and propane. Choose adsorptives whose saturation pressure is less
than 800 mmHg at the measurement temperatures.

n The Lakeshore Curve Handler software (free download): http://www.lakeshore.-
com/products/Pages/curvehandler.aspx.

n An empty sample tube for the Micromeritics gas adsorption analyzer being used.
n A spreadsheet application. Knowledge of how to load a .TXT file containing tabular data into a

spreadsheet application is beneficial.

CALIBRATION PROCEDURE
1. In the analysis application, go to the Unitmenu. Ensure there is a checkmark to the left of

Disable Elevator and no checkmark to the left of Enable CryoStat. The cryostat will be adjus-
ted manually.

2. Install a blank sample tube into the gas adsorption analyzer. Note that only one tube is
required for the Flex.

3. Raise the cryostat and lock it in place following the general cryostat procedure.
4. Set the cryostat to the required temperature. On the LakeShore temperature controller,

press SETPOINT, enter the temperature (in kelvin), then press ENTER.

CryoStat Calibration
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D CryoStat

A. Measured temperature
B. Probe signal voltage
C. Setpoint button
D. Enter button
E. Set temperature

5. Wait until the cryostat reaches the entered temperature. The time varies depending on how
big the temperature jump is. For example, going from 200 K to 215 K may take 15 to 20
minutes; going from 298 K to 77 K might take 90 minutes. Once the cryostat has reached
the operating temperature, record the set temperature, the measured temperature, and the
cryostat signal probe voltage.

6. Create a sample file to measure saturation pressure.

The analysis is to run in the absolute pressure dosing mode with an upper pressure limit of
950 mmHg. Increment volume dosing is to be employed using a dose volume of
20 cm3/g STP with a 5 second equilibration time. In Analysis Conditions:

a. Select the Absolute pressure dosing option.
b. Select the adsorptive to be used.
c. Enter the pressure settings shown in the Pressure Settings for Flex table below.

Starting
Pressure
(mmHg)

Pressure 
Increment
(mmHg)

Dose amount
(cm3/g STP)

Equilibration
Interval(s)

Ending
Pressure
(mmHg)

Line 1 0.000000 5 100.000000

Line 2 100.000000 20.0000 5 900.000000

Pressure Settings for Flex

7. Once the analyzer is set up and the temperature for the first data point has reached
equilibrium, start the analysis defined by the sample file. The analyzer will dose the sample
tube with 20 cm3/g STP of adsorptive . Once the tube pressure reaches the adsorptive
saturation pressure, the generated isotherm will climb straight up. Take several points at
this saturation pressure, then pause the analysis and set the cryostat to the next
temperature.

Once the cryostat has reached the set temperature and has equilibrated a few minutes,
record the cryostat temperature and the probe signal, then resume the analysis. Perform
this cycle for the number of temperature points required for the adsorptive being used.
Typical isotherms are shown below. Note that the temperature labels are for clarity and are
not a part of the normal report.
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Additional adsorptives will allow the calibration to be extended. A set of local fits may be
needed to cover a wide temperature change.

Depending on the selected adsorptive, a warning message may be given indicating
that 950 mmHg is not the saturation pressure for the temperature being used. This is
a normal message and will not interfere with the experiment. ClickOK and continue
with the analysis.

These analyses will not end and will have to be terminated manually by stopping the
analysis window. To terminate the analysis, click Cancel, then wait a few seconds
and click Cancel again (do not double-click the Cancel button).

The analysis will end abruptly with adsorptive in the sample tube. The sample tube
must be manually evacuated before the cryostat is lowered.

Manually close all valves. Go to Unit > Evacuate Ports to evacuate the sample
tube(s) used for the measurement.

The cryostat can be lowered once the sample tube has been completely evacuated.

This saturation pressure data can either be read from the graph or an isotherm report can
be made and the saturation pressure read from the report:

8. Place the data in table format using a spreadsheet application.

CryoStat Calibration
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Set Tem-
perature (K)

CryoStat
Temperature (K)

Signal
Probe
Voltage

Measured
Saturation
Pressure
(mmHg)

Sample Tube
Temperature

(K)

Nitrogen

65 64.999 1.04878 137.833 65.317
67.5 67.498 1.04474 206.334 67.778
70 69.999 1.04066 301.792 70.294
73 72.996 1.03572 454.217 73.239
73 72.996 1.03572 456.148 73.271
73 72.998 1.03571 452.139 73.239
75 75.002 1.03240 584.063 75.189
75 75.002 1.03245 587.793 75.240
77 76.993 1.02896 743.094 77.165
77 76.995 1.02897 742.343 77.156
78 78.002 1.02737 832.533 78.165

Ethylene
140 139.999 0.91437 111.175 142.470
145 144.999 0.90456 168.125 147.470
150 150.000 0.89477 245.617 152.350

Temperature and Saturation Pressure Values

Set Temp Cryostat temperature setting, in kelvin.
CryoStat Temperature Temperature reported by the temperature con-

troller.
Signal Probe Voltage Signal probe voltage reading.
Measured Saturation
Pressure

Equilibrium pressure measured by the instru-
ment when the isotherm is vertical.

Sample Tube
Temperature

Sample tube temperature calculated from the
measure saturation pressure using NIST’s
REFPROP program (bundled with the Micro-
meritics applications).
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Screenshot from REFPROP
software

The spreadsheet data can be graphed in the REFPROP spreadsheet program. Plot the
REPROP to determine temperature versus the Cryostat reading. Fit the data points:

Temperature Correlation

Additional adsorptives will allow the calibration to be extended. The following graph
contains data for nitrogen combined with data from ethane:

CryoStat Calibration
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Temperature Correlation

9. The REPROP determined sample tube temperatures, combined with the signal probe
voltages read from the LakeShore controller are then used to construct a cryostat
calibration curve.

The LakeShore Curve Handler program (shown below) is used for this operation. (Refer to
the LakeShore Curve Handler manual for communications information.) Connect the
cryostat to the computer via an Ethernet connection.
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10. Click Connect to establish communication with the LakeShore Temperature Controller.
Once communication is established, all the calibration curves in the LakeShore
Temperature Controller will be listed.

11. The ColdEdge Cryostat/LakeShore Model 336 Temperature Controller uses the DT-670
silicon diode as the temperature sensor according to ColdEdge Micromeritics Interface
Owner’s Manual. Select the curve for the DT-670 temperature probe. Click Save As and
save the DT-670 curve with a different name (i.e., DT-670-xx). Note that all calibration
curves are stored as ASCII files in the Documents library with the file extension .curve.
There will be a DT-670.curve file and a DT-670-xx.curve file.

CryoStat Calibration
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The LakeShore Curve Handler instruction manual provides several methods of entering
user created calibration. The following process uses a file copy of a modified version of
the DT-670 curve previously saved.

12. Produce a modified calibration curve by applying the fit from step 8 to the temperatures in
DT-760 curve.

13. Start the LakeShore Curve Handler program and establish communication with the
LakeShore Temperature Controller.
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14. ClickOpen and select the modified DT-670-xx.curve. Place this curve in the first empty bin.
User curve bins start at Number 21.

15. The new curve should now be able to be loaded into the LakeShore Curve Handler
program. Click the User’s Curve tab in the lower left side of the window.

16. Note in this example the modified curve DT-670-xx.curve is in bin 22 (left column) and the
curve is displayed on the right. The values should be reviewed and any changes made.
Click Save if changes have been made. ClickWrite to load the new curve into the
LakeShore Temperature Controller. Exit the LakeShore program.

17. To select the new curve, on the temperature controller, press the Input command (key 7),
select the Input channel (usually A), use the arrows to navigate to the curve menu, press
Enter, then select the curve. Use curve 22 in this example. Press Enter once more, then
press Escape. The new, modified curve is now in place. More details can be found in the
LakeShore Model 336 Temperature Controller User’s Manual.

The table below shows the effect of the new curve:

CryoStat Calibration
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Set
Temp
(K)

Cryostat
Temperature

(K)

Measured
Saturation
Pressure
(mmHg)

Uncalibrated
Sample Tube
Temperature

(K)

Calibrated
Sample Tube
Temperature

(K)

% Error
(Calculated

vs
Uncalibrated)

73 72.997 473.450 73.553 73.250 -0.414

75 74.996 615.020 75.603 75.215 -0.517

77.3 77.002 786.618 77.648 77.029 -0.804

Temperature and Saturation Pressure Values
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E DATA LOGGING
The Flex has the added capability to collect, access, and use real time transient data (pressures,
temperatures, quantities adsorbed, etc.) during adsorption and desorption measurements. Data
are collected every half second. Data logging can also be performed from a Smart VacPrep
degasser attached to the analyzer. The Smart VacPrep Operator Manual can be found on the
Micromeritics web page (www.micromeritics.com).

This document provides:

n installation instructions for the PuTTY client and outlines how to access and use the data file,
and

n installation instructions for Python components and outlines how the captured data can be
handled using Python scripts.

INSTALL THE PUTTY CLIENT
PuTTY is an open source SSH and telnet client that can be used to access the transient data
output by the Flex analyzer. No additional Micromeritics application is required. The PuTTY.exe
file runs directly from a desktop shortcut. Download the PuTTY application using the following
URL (only save the putty.exe file):

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html

To connect to the Flex analyzer:

1. In the Flex application, go to Unit [n] > Unit Configuration and make a note of the ana-
lyzer IP address.

2. In the PuTTY Configuration window:
a. Enter the analyzer IP address (from Step 1) into the PuTTY application.
b. Enter 54000 54000 in the Port field.
c. Select Raw as the connection type.

E Data Logging
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3. To save the settings (optional):

a. In the Category box, select Session > Logging.
b. In the Session logging group box, select All session output.
c. In the Log file name group box, click Browse to select the destination and enter a .txt

file name. It may be helpful to name this file the same as the sample file to be analyzed.
4. ClickOpen to start collecting the data.

The PuTTY application can be started before the analyzer starts collecting data— it
will be waiting until data output from the analyzer begins.
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ACCESS THE DATA LOG FILE
The text file created in the previous section (Step 3c) contains the transient data and can be
accessed using any means that accepts tab separated value such as Notepad, Microsoft Excel (or
other spreadsheet software), or programming languages that read .txt or .xls files such as
MATLAB, Octave, and Python. MATLAB has the xlsread() function and Octave has the textread()
function.

DATA FILE COLUMN DESCRIPTIONS
When the data file is viewed in a spreadsheet program, the following columns display:

Data File Column Descriptions
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A. 'manifold pressure (Torr)';
B. 'manifold volume (cc)';
C. 'manifold temperature (K)';
D. 'time (ms)';
E. 'port 1 pressure (Torr)';
F. 'port 1 volume (cc)';
G. 'port 1 temperature (K)';
H. 'port 1 ambient temperature (K)';
I. 'port 1 analysis temperature (K)';
J. 'port 1 warm freespace (cc STP)';
K. 'port 1 cold freespace (cc STP)';
L. 'port 1 quantity dosed (cc STP)';
M. 'port 1 quantity adsorbed (cc STP)';
N. 'port 1 has manifold ?';
O. 'port 1 valve open ?';
P. 'port 1 data points taken';
Q. 'port 1 current pressure table index';
R. 'port 1 last data point elapsed time (ms)';
S. 'port 1 last data point pressure Torr)';
T. 'port 1 last data point quantity dosed (cc

STP)';
U. 'port 1 last data point quantity adsorbed

(cc STP)';
V. 'port 1 last data point Po (Torr)';
W. 'port 2 pressure (Torr)';
X. 'port 2 volume (cc)';
Y. 'port 2 temperature (K)';
Z. 'port 2 ambient temperature (K)';

AA. 'port 2 analysis temperature (K)';
AB. 'port 2 warm freespace (cc STP)';
AC. 'port 2 cold freespace (cc STP)';

AD. 'port 2 quantity dosed (cc STP)';
AE. 'port 2 quantity adsorbed (cc STP)';
AF. 'port 2 has manifold ?';
AG. 'port 2 valve open ?';
AH. 'port 2 data points taken';
AI. 'port 2 current pressure table index';
AJ. 'port 2 last data point elapsed time

(ms)';
AK. 'port 2 last data point pressure Torr)';
AL. 'port 2 last data point quantity dosed (cc

STP)';
AM. 'port 2 last data point quantity adsorbed

(cc STP)';
AN. 'port 2 last data point Po (Torr)';
AO. 'port 3 pressure (Torr)';
AP. 'port 3 volume (cc)';
AQ. 'port 3 temperature (K)';
AR. 'port 3 ambient temperature (K)';
AS. 'port 3 analysis temperature (K)';
AT. 'port 3 warm freespace (cc STP)';
AU. 'port 3 cold freespace (cc STP)';
AV. 'port 3 quantity dosed (cc STP)';
AW. 'port 3 quantity adsorbed (cc STP)';
AX. 'port 3 has manifold ?';
AY. 'port 3 valve open ?';
AZ. 'port 3 data points taken';
BA. 'port 3 current pressure table index';
BB. 'port 3 last data point elapsed time

(ms)';
BC. 'port 3 last data point pressure (Torr)';
BD. 'port 3 last data point quantity dosed (cc

STP)';
BE. 'port 3 last data point quantity adsorbed

(cc STP)';
BF. 'port 3 last data point Po (Torr)';

Flex Data File Column Descriptions
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INSTALL PYTHON COMPONENTS
To operate Python to view real time data, three components should be installed in the following
order:

1. Install PYTHON
n Download URL: https://www.python.org/downloads/
n Download Python version 3.2 or later

Depending on the computer operating system, download file versions may vary, however, the
.msi file should be compatible with computers that operate the Flex analyzer.

2. Install NumPY (for numerical functions)
n Download URL: http://sourceforge.net/projects/numpy/files/NumPy/1.6.2/
n Download file: numpy-1.6.2-win32-superpack-python3.2.exe

NumPY contains numerous numerical functions and libraries needed to properly handle the
transient data extracted from the .txt file collected during an analysis. NumPY version 1.6.2
should be download to be compatible with the installed version of Python.

3. Install MatPlotLIB (for graphical display of the data)
n Download URL: http://www.lfd.uci.edu/~gohlke/pythonlibs/#matplotlib
n Download file: matplotlib-1.2.1rc1.win32-py3.2.exe

MatPlotLIB version 1.2.1 is compatible with NumPY from Step 2.

Install Python Components
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SAMPLE PYTHON CODE
The following code was used to produce the data in this section. This is basic code for viewing
transient data. More detailed scripts can be created to compare pressure or quantity adsorbed
between ports, generate a separate figure for each port, etc. Contact Micromeritics’ applications
specialists to discuss and support creating custom scripts for individual applications.

import numpy as np
import matplotlib.pyplot as plt

myFile = 'carbon.txt'
data = np.genfromtxt(myFile, skip_header=2, skip_footer = 1)

# Time (minutes)
x=data[:,3]
x = x/1000/60

# Sample pressure PORT 1(Torr)
y=data[:,4]

plt.plot(x,y,'ko')
plt.ylabel('Pressure (Torr)')
plt.xlabel('time (minutes)')
plt.show()

SAMPLE CODE EXPLANATION

import numpy as np
import matplotlib.pyplot as plt
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Import is needed to load the modules containing functions to be used— in this case, numerical
and plotting functions. Coding is easier if abbreviations such as np and plt are used.

myFile = 'carbon.txt'
data = np.genfromtxt(myFile, skip_header=2, skip_footer = 1)

MyFile is a variable name for the .txt file to be read. As long as the .txt file and the script file are in
the same directory, the script file can run automatically by double-clicking the script file after the
correct file has been hard-coded.

The genfromtxt() function allows for the text file to be converted into a numerical matrix.

The skip_header setting allows for the first 2 rows of data to be excluded from the matrix. As
shown in the following figure, the first row of data is ASCII art created by the PuTTY program, and
the second row of data are the column labels — neither of which are numerical data.

The skip_footer setting is needed because, when the .txt file is read in real time, the entire last row
of data may not be complete. This causes problems for creating the matrix and needs to be
excluded. This means that the last half-second of data is not displayed when the data are viewed
in real time.

Exclude the first
two rows of data

Sample of Transient Data

Sample Python Code
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# Time (minutes)
x=data[:,3]
x = x/1000/60

Data File Column Descriptions on page E - 3 identifies the columns of data recorded. The
fourth column of data contains time in milliseconds, however, the first index in Python is 0;
therefore, 
data[:,3] captures all of the rows (:) in the fourth column.

plt.plot(x,y,'ko')
plt.ylabel('Pressure (Torr)')
plt.xlabel('time (minutes)')
plt.show()

The above code shows the syntax for plotting. The label 'ko' indicates filled black circles.
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DEGASSING AND CHEMISORPTION TEMPERATURE RAMP DATA
The same information provided above applies to capturing Flex data during degassing and during
chemisorption temperature ramping, except:

DEGAS DATA
This data is available during programmed in situ degas sent once per second. Connect to port
54100 (rather than port 54000 ) for in situ degas data (see Data Logging on page E - 1). The
data columns are:

A. time (ms)
B. manifold pressure (Torr)
C. manifold vacuum (Torr)
D. port 1 pressure (Torr)
E. port 1 temperature (C)
F. port 2 pressure (Torr)
G. port 2 temperature (C)
H. port 3 pressure (Torr)
I. port 3 temperature (C)

CHEMISORPTION TEMPERATURE RAMP DATA
Flex data can be captured during chemisorption analyses by connecting to port 54200 (see Data
Logging on page E - 1). Time and sample temperature are sent every half second when the
external trigger is set toON. This is typically done during a flowing preparation temperature ramp.
The data columns are:

n Time (s)
n Sample temperature (°C)

The External Trigger in the analyzer application must be enabled for this data to be available.

n To manually set the trigger go to Unit [n] > Enable Manual Control, right-click the External
Trigger icon and selectON. The box is dark when enabled.

n Enable the Set external trigger box in a Preparation Flow Task in the Analysis Conditions to col-
lect temperature data that is synchronized with an external mass spectrometer or other
detector to be started by the external trigger signal.

Degassing and Chemisorption Temperature Ramp
Data
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F DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of a model that can be
visualized and described mathematically. Early models of physisorption were quite simple, both
conceptually and mathematically. For very practical reasons, hand computations were required.
Today we can explore complex models that describe adsorption systems on the atomic scale of
size and sub-picosecond time frame. This is not because scientists are smarter, but because of
available tools. The DFT models are created by classical approaches to adsorption as well as
models based on modern statistical thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS
Included in this group are methods that model the adsorption system in terms of forces acting
between individual molecules.

THEORETICAL BACKGROUND
Traditional adsorption theories attempt to describe experimental adsorption isotherms with an
isotherm equation containing a small number of parameters. At a minimum, these parameters
include the extent of the surface, such as the monolayer capacity (Qm), and the molar intensity of
the gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some
equations, additional parameters take into account the lateral interaction of adsorbed molecules
with each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters
for the effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the
microscopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters,
the pore size, the pore geometry, and the temperature.

The following example is provided to understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an
evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded
over time. In this situation, the pressure falls rapidly from its initial value and gradually
approaches a steady reading, called the equilibrium pressure. The amount adsorbed
corresponds to the quantity of gas effectively removed from the gas phase by the solid
surface. A graph that plots amount adsorbed versus equilibrium pressure is called an
adsorption isotherm.

F DFT Models
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F DFT Models

Under such conditions, the argon atoms that randomly enter the pore space feel the presence
of the solid surface as the action of an external attractive force (the dispersion forces or Van
der Waal’s forces) and spend more time near the surface. As a result, the space near the
surface acquires a greater average density of argon atoms than regions farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a
function of pressure and the molecular properties of the components of the system, then a
model could be constructed for the adsorption isotherm for the system. Modern physical
chemistry provides several ways to calculate this distribution. All these methods are based on
the fundamental thermodynamic law that such a system adopts a configuration of minimum
free energy at equilibrium. Also needed is a description of the pairwise interaction energy
between atoms, U(s), commonly given by a Lennard-Jones potential:

where

ε = a characteristic energy of the adsorptive,
σ = the diameter of the adsorptive molecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gas molecules in a
system in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these
are used as reference methods because their results are considered exact.

MOLECULAR DYNAMICS METHOD

In the molecular dynamics method, the position and velocity of individual gas particles are
calculated over time at very short intervals. This method takes into account both the forces acting
between the gas particles themselves and those acting between the gas particles and the atoms
of the simulated surface. As the simulated particles collide with each other and with the surface,
the average concentration of particles in the space near the surface is calculated; this calculation
yields the amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the movement of
each particle in the system using time steps of 10-14 seconds. Although the mathematics are
simple, the number of calculations required for a system of even a few hundred particles is
astronomical and challenges even the fastest computers.
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MONTE CARLO METHOD

In the Monte Carlo method, determination of the system equilibrium distribution begins with an
assumption (which may be only approximate) about the initial configuration of particles in the
system. The system is “equilibrated” through a process of randomly selecting one particle and
conditionally moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and
another particle is randomly selected to be moved.

If the move results in a configuration of higher energy, a probability for that event is calculated,
and a random number between zero and one is generated. If the generated number is smaller
than the probability of the event, then the move is accepted; otherwise, another particle is selected
and the process is repeated. This process continues until the average total energy of the system
no longer decreases; at this point, average configuration data are accumulated to yield the mean
density distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic
simulations and can yield the same results; however, neither method provides a really practical
way to calculate complete isotherms.

DENSITY FUNCTIONAL FORMULATION
Density functional theory offers a practical alternative to both molecular dynamic and Monte Carlo
simulations. When compared to reference methods based on molecular simulation, this theory
provides an accurate method of describing inhomogeneous systems yet requires fewer
calculations. Because the density functional theory provides accuracy and a reduced number of
calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated
by a distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system
of constant density; its chemical potential1 ) is determined by the pressure of the system using
well-known equations. The fluid near the walls is not of constant density; its chemical potential is
composed of several position-dependent contributions that must total at every point to the same
value as the chemical potential of the bulk fluid.

1 ) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energy with respect to density (or concentration).

Models Based on Statistical Thermodynamics
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F DFT Models

As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy,
known thermodynamically as the grand potential energy (GPE). Density functional theory
describes the thermodynamic grand potential as a functional of the single-particle density
distribution; therefore, calculating the density profile that minimizes the GPE yields the equilibrium
density profile. The calculation method requires the solution of a system of complex integral
equations that are implicit functions of the density vector. Since analytic solutions are not possible,
the problemmust be solved using iterative numerical methods. Although calculations using these
methods still require supercomputing speed, the calculation of many isotherm pressure points for
a wide range of pore sizes is a feasible task. The complete details of the theory and the
mathematics can be found in the papers listed under DFT Model References on page F - 17.

The following graphs and accompanying text illustrate the results of using density functional
theory to predict the behavior of a model system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Figure 1

Density Profile for Argon on Carbon at
87.3 K and a Relative Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise
distribution of adsorbate; the first monolayer is sharply defined and a third layer can be
distinguished. The area under the profile curve represents the amount adsorbed per unit area at
this pressure. The positions of the maxima are separated by a distance determined by the size of
the adsorptive atom.

F - 4 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as
the integral over the profile. Repeating this calculation over a range of pressures yields the
adsorption isotherm for the model. If the value of H is very large, the isotherm obtained
corresponds to that of an external, or free, surface. If H is smaller, a range of pressures is reached
where two minima exist for the grand potential, showing the presence of two metastable phases
having different density distributions but the same chemical potential. The phase with the lower
GPE is the stable one. As the pressure is increased, a point is reached where the other phase
becomes the stable one. This phase transition reflects condensation of adsorbate in the pore; the
pressure at which it occurs is called the critical pore-filling pressure. This pressure is analogous to
the condensation pressure predicted by the Kelvin equation in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for a model pore with H = 40 angstroms.
The inset shows the density profiles for the corresponding points of the isotherm.

Figure 2

Model Isotherm for Argon at 87.3 K in a
40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close
to the surface.

n Inset a shows the profile corresponding to point a on the isotherm where the surface is about
half covered.

n At point b, the first layer is so full that it is more favorable for atoms to start a new layer.
n At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In

inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4
or 5 molecular diameters from the surface.

n Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center
of the pore, indicating a phase transition.

Models Based on Statistical Thermodynamics
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F DFT Models

Note that the adsorption isotherms for pores larger than the one shown in the previous graph is
identical up to point c. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in the Figure 3, where isotherms for some larger size pores
are shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-
filling pressure. At large pore sizes, density functional theory produces results for the critical filling
pressures that are in good agreement with those produced by the Kelvin equation.

Figure 3

Model Isotherms for Some Larger Pore
Widths Argon on Carbon at 87.3 K

Figure 4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale
for pressure.

Figure

Model Isotherms in the Micropore Size
Range of Pore Width Argon on Carbon
at 87.3 K
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 millitorr.
Pores below 15 Å fill before a monolayer is completed on the surface of the larger pores. In the
micropore size range, the pore volume fills more gradually with pressure and the total shape of the
isotherm is important in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Using the methods of non-local density functional theory, two sets of isotherms have been
calculated to serve as kernel functions for the characterization of porous solids from adsorption
data. The model isotherms are stored in binary format files. These models assume a slit-like pore
geometry. The pore size range from 4.0 to 4000 Å is covered in 91 classes in a geometric
progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A model for
the free or external surface is included to account for unfilled pores. Each of the 92 model
isotherms has been calculated at 181 pressure points from near 1×10-6 to near 1.00 relative
pressure.

These models are identical to those supplied with the original DOS version of DFT software.
Some slight difference from the DOS results may be noted when they are applied to the same
data due to improvements in the deconvolution algorithm and better regularization of the current
software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K

Models Based on Statistical Thermodynamics
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F DFT Models

Using the modified Tarazona prescription described by Olivier (see DFT Model References on
page F - 17 [items 3 and 4]), model isotherms were calculated for a wide range of adsorptive
energies to a relative pressure of 0.6. The model makes no provision for pore filling in the
micropore region. If the sample solid contains small mesopores, the isotherm data should be
truncated (using the Select Data Points window) to a suitably low relative pressure to avoid trying
to fit this region; mesopore filling reports as a large area of low energy in the calculated distribution
of adsorptive potential.

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e.,
for the adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas and MCM-41 mesoporous silicas as well as
zeolites. The pore-filling pressures were determined as a function of the pore size from adsorption
isotherms on MCM-41 materials characterized by X-ray and other techniques. The variation of the
pore fluid density with pressure and pore size has been accounted for by density functional theory
calculations. The N2 model reports pore sizes ranging from 3.8 to 387 Å and the ARmodel from
3.8 to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A NewMethod for the
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Meso-
porous Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local
Density Functional Theory (NLDFT) calculations and experimental isotherms for reference
samples of montmorillionite. The construction method for the hybrid models was analogous to that
described in the first reference below (Jaroniec et al,1999). The additional references add
additional theoretical details as well as examples of the application of the model to pillared clay
catalysts. This model reports pore widths from 3.8 to 387 angstroms.
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References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
a Pillared Interlayered Clay (PILC) from a Hybrid Density Functional
Theory (DFT) Method,” The Journal of Physical Chemistry B; 2001, 105
(3), 623-629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded
Clay Catalysts from Hybrid Density Functional Theory (DFT) and
Adsorption Microcalorimetry Methods,” Langmuir 2002, 18, 9816-
9823.9b.

James P. Olivier, “The Importance of Surface Heterogeneity in
Developing Characterization Methods.” 6th International Symposium on
the Characterization of Porous Solids, Studies in Surface Science and
Catalysis 144, Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
Pillared Rectorite Catalysts from a Hybrid Density Functional Theory
Method,”Microporous and Mesoporous Materials 2003, 57, 291-296.

C02 - DFT Model

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isotherms were calculated using the non-local prescription of Tarazona, employing
molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry: Free surface
Substrate: Any
Category: Surface energy
Method: Argon at 87K

This model was produced in the same manner as the N2 Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.

Models Based on Statistical Thermodynamics
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F DFT Models

N2 - Tarazona NLDFT, Esf = 30.0K

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for
a silica or alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a slit-like pore geometry. These models are slightly different from N2-DFT
and Ar-DFT models that were calculated using NLDFT with density independent weighting
functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio
of 6.

This model is particularly useful for microporous carbon materials. The reported pore size range is
from 3.5 to 250 angstroms.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the same methods and assumptions that were used in the
model above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent
analytical techniques such as high-resolution transmission electron microscopy (HRTEM) and/or
X-ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon
material.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Models Based on Statistical Thermodynamics
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F DFT Models

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the graphitic surface of an
infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The reported
pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and multiple concentric graphitic
surfaces of infinitely long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.

F - 12 Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025



This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites.
The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.

This model is similar to the model above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

MODELS BASED ON CLASSICAL THEORIES
Both surface energy distribution and pore size distribution may be evaluated using classical
approaches to model kernel functions for use with equation (1) of the DFT Theory. The
Calculations document can be found on the Micromeritics web page (www.micromeritics.com). Be
aware that the deconvolution method only provides a fitting mechanism; it does not overcome any
inherent shortcomings in the underlying theory.

SURFACE ENERGY
The use of classical theories to extract adsorptive potential distribution is mostly of historical
interest. At a minimum, the equation must contain a parameter dependent on adsorption energy
and another dependent on monolayer capacity or surface area. This is sufficient to permit the
calculation of the set of model isotherms that is used to create a library model. The Langmuir
equation has been used in the past, as have the Hill-de Boer equation and the Fowler-
Guggenheim equation. All of these suffer from the fact that they only describe monolayer
adsorption, whereas the data may include contributions frommultilayer formation.

Models Based on Classical Theories
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F DFT Models

PORE SIZE
It is well established that the pore space of a mesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pressure,
this knowledge can be used to characterize the mesopore size distribution of the adsorbent. The
correlating function most commonly used is the Kelvin equation. Refinements make allowance for
the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical
condensation pressure. Still further refinements adjust the film thickness for the curvature of the
pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm data
using Kelvin-based theories, such as the BJH method, were for the most part developed decades
ago and were designed for hand computation using relatively few experimental points. In general,
these methods visualize the incremental decomposition of an experimental isotherm, starting at
the highest relative pressure or pore size. At each step, the quantity of adsorptive involved is
divided between pore emptying and film thinning processes and exactly is accounted for. This
computational algorithm frequently leads to inconsistencies when carried to small mesopore
sizes. If the thickness curve used is too steep, it finally will predict a larger increment of adsorptive
for a given pressure increment than is actually observed; since a negative pore volume is non-
physical, the algorithm must stop. Conversely, if the thickness curve used underestimates film
thinning, accumulated error results in the calculation of an overly large volume of (possibly
nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel
functions corresponding to various classical Kelvin-based methods have been calculated for
differing geometries and included in the list of models.

MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:
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Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944).
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).

Models Based on Classical Theories
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Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887g cm-3

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the Inter-
national Symposium on Surface Area Determination, D.H. Everett, R.H.
Ottwill, eds., U.K. (1969).
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DFT MODEL REFERENCES
The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, Micro-
meritics Instrument Corp; presented at the International Symposium on the Effects of Sur-
face Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July
1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped Geometry,”
Perla B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier
Science Publishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional
Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms Calculated
by Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference
on the Fundamentals of Adsorption, Pacific Grove, CA (1995).

DFT Model References
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G EXPORTED DATA EXAMPLE
This exported data has been truncated for this manual.

Sample Information

                    Method:    $                             
                    Sample:    Pt-Al Ref Matl with CO Run 1  
                  Operator:    jch                           
                 Submitter:                                  
                 Mass type:    Calculated                    
                Empty tube:    34.6494 g                     
             Sample + tube:    35.3873 g                     
               Sample mass:    0.7379 g                      
                   Density:    1.000 g/cm³                   
              Type of data:    Automatically collected       
           Instrument type:    3500 Chemi                    
  Original instrument type:    3500 Chemi                    
                  Comments:                                  

                                          Active Metals Table

                                                                   Percent                              
                                                                 of  Percent                  
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                                   Atomic Cross Sect    Density     Sample     Reduced    MxOy    MxOy  
   Element       Atomic Weight        Area (nm²)        (g/cm³)    Mass (%)  (%)XY
--------
  chromium              51.9960               0.0635      7.190        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                         Helium                1.000                                                    

  cobalt                58.9330               0.0662      8.900        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                         Helium                1.000                                                    

  copper                63.5400               0.0680      8.960        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                         Helium                1.000                                                    
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  molybdenum            95.9400               0.0730     10.220        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                         Helium                1.000                                                    

  nickel                58.7100               0.0649      8.902        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                       Ethylene                1.000                                                    

  palladium            106.4000               0.0787     12.020        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                         Helium                1.000                                                    

  platinum             195.0900               0.0800     21.450        0.50     100.00       1       0  
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                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.000                                                    
                         Helium                1.000                                                    

  rhenium              186.2000               0.0649     21.020        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                         Helium                1.000                                                    

  rhodium              102.9050               0.0752     12.410        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                         Helium                1.000                                                    

  silver               107.8680               0.0869     10.500        0.00     100.00       1       0  
                     Adsorptive        Stoichiometry                                                    
                       Hydrogen                2.000                                                    
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                         Oxygen                2.000                                                    
                Carbon Monoxide                1.500                                                    
                         Helium                1.000                                                    

Analysis Conditions

              Analysis conditions:    Pt-Al Ref Matl with CO  
     Pre-analysis evacuation time:      0.50 h                
                  Repeat analysis:    Yes                     
  Repeat analysis evacuation time:      1.00 h                
               Equilibration time:    5                       

                         Adsorptive:    Carbon Monoxide (CO)                  
          Maximum manifold pressure:    123.323 kPa                           
  Therm. tran. hard-sphere diameter:    3.5900 Å                              
     Molecular cross-sectional area:    0.125 nm²                             
         Adsorbate molecular weight:    28.01                                 
                 Mass flow constant:    1.000                                 
               Thermal conductivity:    1.00                                  
                          Gas blend:    No                                    
                   Fluid properties:    T:\fpi\version 3\carbon monoxide.fpi  
                      Dosing method:    Normal                                
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                            Pressure Table

   Starting     Pressure       Dose                         Ending    
   Pressure     Increment     Amount     Equilibration     Pressure   

(kPa)         (kPa)      (mmol/g)    Interval (s)       (kPa)     
-----
   0.0000000                                        20    13.3322400  
  13.3322400    6.6661200                           20    59.9950800  

               Preparation Options

  Backfill and match transducer:    Yes          
                   Backfill gas:    Nitrogen     
                Evacuation rate:    6.67 kPa/s   
        Unrestricted evac. from:    4.00 kPa     
                   Vacuum Level:    6.7e-03 kPa  
                Evacuation time:      0.10 h     

                  Analysis Task 1 - Evacuation

                Evacuate for 30 min    below 2.7e-03 kPa.  
                   Evacuation rate:    6.67 kPa/s          
  Unrestricted evacuation pressure:    4.00 kPa            
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                       Temperature:    110.0 °C            
                  Temperature rate:    10.0 °C/min         

              Analysis Task 2 - Flow

                   Gas:    Hydrogen          
             Flow rate:    50.0 cm³ STP/min  
                  Time:    10 min            
           Temperature:    100.0 °C          
      Temperature rate:    10.0 °C/min       
  Set external trigger:    No                

              Analysis Task 3 - Flow

                   Gas:    Hydrogen          
             Flow rate:    50.0 cm³ STP/min  
                  Time:    30 min            
           Temperature:    400.0 °C          
      Temperature rate:    10.0 °C/min       
  Set external trigger:    Yes               

                  Analysis Task 4 - Evacuation
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                Evacuate for 30 min    below 2.7e-03 kPa.  
                   Evacuation rate:    6.67 kPa/s          
  Unrestricted evacuation pressure:    4.00 kPa            
                       Temperature:    400.0 °C            
                  Temperature rate:    10.0 °C/min         

                  Analysis Task 5 - Evacuation

                Evacuate for 10 min    below 2.7e-03 kPa.  
                   Evacuation rate:    6.67 kPa/s          
  Unrestricted evacuation pressure:    4.00 kPa            
                       Temperature:    35.0 °C             
                  Temperature rate:    100.0 °C/min        

         Analysis Task 6 - Leak Test

  Outgas rate limit:    1.3e-03 kPa/min  
        Temperature:    35.0 °C          
   Temperature rate:    10.0 °C/min      

                     Free Space Options

                Free space type:    Measure after analysis  
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                Evacuation time:    1.00 h                  
   Estimated ambient free space:    12.2664 cm³             
  Estimated analysis free space:    12.1432 cm³             

          Temperature Options

   Temperature control:    Furnace      
  Analysis temperature:    35.0 °C      
      Temperature rate:    10.0 °C/min  

                  Dosing Options

      Absolute pressure tolerance:    0.6666 kPa  
      Relative pressure tolerance:    5.0 %       
  Low pressure equilibration delay                
                          Minimum:      0.00 h    
                          Maximum:    999.00 h    

          Termination Options

  Backfill after analysis:    Yes       
             Backfill gas:    Nitrogen  
          Cool to < 50 °C:    Yes       
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Report Options

                        Report options:    Pt-Al Ref Matl with CO  
                     Show report title:    No                      
                          Show graphic:    No                      
  Use thermal transpiration correction:    Yes                     
        Inside diameter of sample tube:    9.000 mm                

        Isotherm: Yes

  Tabular report selected:    Yes     
     Plot report selected:    Yes     
             X-axis scale:    Linear  
            Plot analysis:    Yes     
     Plot repeat analysis:    Yes     

   Isotherm Plot Options

        Plot curve:    Yes  
       Plot points:    Yes  
   Overlay samples:    No   
  Autoscale X axis:    Yes  
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  Autoscale Y axis:    Yes  

        Difference Method: Yes

G Exported Data Example

Flex Series Operator Manual
350-42800-01 (RevW)—Mar 2025 G - 11



H FREE-SPACE CORRECTION
Free space is that volume of the sample tube which is unoccupied by the sample. The quantity of
gas dosed into the sample tube is calculated from the difference in pressures in the manifold
before and after the dose is delivered. The quantity of gas adsorbed by the sample is calculated
by subtracting the quantity of gas remaining in the free space of the sample tube after equilibrium
is established from the quantity of gas originally dosed into the sample tube. Free space must be
determined accurately to obtain a precise value for quantity adsorbed.

Static-volumetric systems consist basically of a gas manifold joined to a sample tube by an
isolation valve. The manifold section has connections for an absolute pressure transducer, a
temperature gauge, and a vacuum system. It also has inlets for the adsorptive gas and helium. A
Dewar flask containing a cryogenic liquid (usually LN2 at approximately 77 K) is situated so that it
can be raised to immerse most of the sample tube. Two temperature zones exist within the
sample tube when immersed in the cryogenic bath: a warm zone (the volume above the liquid
level and near ambient temperature) and a cold zone (the volume below the liquid level at
cryogenic temperature). Not only must the total free space volume be determined, but it also is
necessary to determine the quantity of gas residing within the “cold” zone since a nonideality
correction must be applied to only that quantity of gas.

The total quantity of gas in the partly immersed sample holder cannot simply be determined using
n = PV/RT because temperature is not constant over the total volume, but instead is distributed as
two temperature zones with a steep temperature gradient between them. A convenient method for
resolving this problem is to derive two factors which, for the existing temperature profile, can be
multiplied by the prevailing pressure to reveal the molar volume of gas contained in the cold zone
and the total quantity residing in the free volume of the immersed sample holder (the analysis free
space).

The analyzer provides the following methods for free space determination:

n Measure
n Calculate
n Enter

MEASURE

Generally, this method, although requiring a little more time (approximately 10 minutes), is the
most preferred one for determining free space. It is simple, automatic, requires very little
information, and essentially is error-proof. With this method, the instrument first evacuates the
manifold and sample tube (containing sample), then isolates the sample tube by closing the valve.
Then the manifold is charged with helium, the pressure measured, and the valve opened allowing
the helium to expand into the sample tube at ambient temperature. Again the pressure is
measured.

H Free-Space Correction
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H Free-Space Correction

The Dewar is raised and the sample tube is cooled to cryogenic temperature. Again pressure
drops; when pressure has equilibrated, the value is recorded. Ambient and analysis free spaces
are calculated from (1) system volume, (2) system, ambient, and bath temperatures, and (3)
measured pressures. From these, the value of the portion of analysis free space at cryogenic
temperature which requires correction for nonideality can be determined.

This method may be undesirable if:

n Helium is unavailable. Free space determination by the analyzer requires the use of helium.
n Analysis speed is a major factor. A helium free space measurement of 10 to 15 minutes is

required.
n The sample tends to absorb and retain helium for a prolonged period of time or if it adsorbs

helium.

CALCULATE
This method is the most rapid and efficient way of compensating for free space. With the sample
tube free space procedure, Helium-free analysis can be achieved. Ensure the following is
accomplished:

1. Perform a blank or sample tube free space analysis on the sample tube.

2. Load the blank analysis file data into the sample tube file or use the sample tube file from a
sample tube free space analysis.

3. Enter the analysis bath temperature (found on the p° and Temperature window).

4. Enter the sample mass and density (found on the Sample Description tab).

ENTER
This method allows for entering predetermined values for the ambient and analysis free spaces.
The values to enter may be obtained in one of two ways:

n A pre-analysis free space calibration of the sample tube containing sample.
n The total free space of an empty sample tube is measured and the displacement of the sample

calculated from its mass and density and subtracted from the total free space.

In either procedure, ensure that the level (or, in cases where the Isothermal Jacket is used, the
effective level) of the cryogen bath on the sample tube is the same when the analysis is performed
as it was when gathering data for free space calculations.
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I GAS CHARTS

RELATIVE THERMAL CONDUCTIVITY OF GASES

Name Chemical Formula Conductivity (Relative to Air)
Air 1.00

Ammonia NH3 0.92

Argon Ar 0.68

Butane C4H10 0.60

Carbon Dioxide CO2 0.62

Carbon Monoxide CO 0.97

Ethane C2H6 0.79

Helium He 5.84

Hydrogen H2 7.07

Krypton Kr 0.37

Methane CH4 1.29

Neon Ne 1.87

Nitric Oxide NO 0.99

Nitrogen N2 1.00

Nitrogen Dioxide NO2 or N2O4 1.51

Nitrous Oxide N2O 0.65

Oxygen O2 1.02

Sulfur Dioxide SO2 0.38

Water Vapor H2O 0.67

I Gas Charts
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I Gas Charts

TYPICAL GASES USED

Flow Rate of 50 cm3/min

Test Preparation
Gas

Carrier
Gas

Loop
Gas

Other

TPR Experiment Argon 10% H2 in
Argon

N/A

Calibration N/A Argon TCD Level Calibration

TPD Ammonia
Helium or
15% NH3 in
Helium Helium

N/A

Calibration N/A NH3 in
Helium TCD Level Calibration

TPD Hydrogen 10% H2 in
Argon

Argon
N/A Calibration

Calibration N/A 10% H2 in
Argon TCD Level Calibration

TPD Oxygen 10%O2 in
Helium

Helium
N/A

Calibration N/A 10%O2 in
Helium TCD Level Calibration

TPO Experiment Helium 10%O2 in
Helium

N/A

Calibration N/A Helium TCD Level Calibration

H2 Pulse
Chemisorption 10% H2 in

Argon

Argon 10% H2 in
Argon

CO Pulse
Chemisorption Helium 10% CO in

Helium

Calibration Not Required

BET Surface Area Helium
30% N2 in
Helium N/A

Calibration N/A
User-defined manual injec-
tions of N2 (0.5, 1.0, 1.5,
and 2.0 cm3)
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GAS CONVERSION CONSTANTS
Dynamic analysis uses a Mass Flow Controller (MFC) to control the flow of gases. The MFC
requires a conversion constant for each gas or gas mixture to compensate for variations in gas
flows resulting from variations in the properties of gases. A default gas table containing MFC
conversion constants is included on theOptionsmenu. The following table provides a more
complete list of gases and their conversion constants.

Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Acetylene C2H2 0.6535

Air (mixture) 0.9901

Allene C3H4 0.4752

Ammonia NH3 0.7822

Argon Ar 1.3861

Arsine A5H3 0.7525

Boron Trichloride BCl3 0.4356

Boron Trifluoride BF3 0.5743

Bromine Pentafluoride BrF5 0.2871

Bromine Trifluoride BrF3 0.4356

Butane C4H10 0.2871

Butene C4H8 0.3267

Carbon Dioxide CO2 0.7723

Carbon Monoxide CO 0.9802

Carbon Tetracloride CCl4 0.3465

Carbon Tetrafluoride CF4 0.4752

Carbonyl Fluoride COF2 0.2673

Carbonyl Sulfide COS 0.6733

Chlorine Cl2 0.8218

Chloroform CHCl3 0.4356

Chlorine Trifluoride ClF3 0.4257

Gas Conversion Constants for the MFC
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I Gas Charts

Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Cyanogen C2N2 0.4950

Cyclopropane C3H6 0.5050

Deuterium D2 0.9901

Diborane B2H6 0.5446

Dichlorosilane SiH2Cl2 0.4356

Dimethylamine (CH3)2NH 0.6634

Dimethylether (CH3)2O 0.5842

Ethane C2H6 0.5446

Ethyl Chloride C2H5Cl 0.2871

Ethylene C2H4 0.6139

Ethylene Oxide C2H4O 0.5842

Fluorine F2 0.9208

Fluroform CHF3 0.5644

Freon 11 CCl3F 0.3762

Freon 12 CCl3F2 0.3861

Freon 13 CClF3 0.4257

Freon 13 B1 CBrF3 0.4059

Freon 14 CF4 0.4703

Freon 21 CHCl2F 0.4554

Freon 22 CHClF2 0.5050

Freon 23 CHF3 0.5644

Freon 113 CCl2F-CClF2 0.2277

Freon 114 CCl2F4-CClF2 0.2554

Freon 115 CClF2-CF3 0.2713

Gas Conversion Constants for the MFC (continued)
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Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Freon 116 CF3-CF3 0.2277

Germane GeH4 0.6436

Helium He 1.3762

Hexamethyldisizane HMDS 0.1386

Hydrogen H2 1.0000

Hydrogen Bromide HBr 0.9703

Hydrogen Chloride (Dry) HCl 0.9802

Hydrogen Fluoride HF 0.9901

Hydrogen Iodide HI 0.9505

Hydrogen Selenide H2Se 0.8317

Hydrogen Sulfide H2S 0.8416

Isobutane C4H10 0.3069

Isobutylene C4H8 0.3366

Krypton Kr 1.3762

Methane CH4 0.8020

Methylamine CH3NH2 0.5644

Methyl Bromide CH3Br 0.6436

Methyl Chloride CH3Cl 0.6832

Methyl Fluoride CH3F 0.7525

Methyl Mercaptan CH4S 0.5842

Neon Ne 1.3861

Nitric Oxide NO 0.9901

Nitrogen N2 0.9950

Nitrogen Dioxide NO2 0.7525

Gas Conversion Constants for the MFC (continued)
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I Gas Charts

Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Nitrogen Trioxide N2O3 0.4356

Nitrogen Trifluoride NF3 0.5446

Nitrous Oxide N2O 0.7426

Oxygen O2 0.9802

Ozone O3 0.7327

Pentaborane B5Hg 0.2871

n Pentane C5H12 0.2376

Perchloryl Fluoride ClO3F 0.4455

Phosgene COCl2 0.5050

Phosphine PH3 0.7822

Phosphorous Pentafluoride PF5 0.3465

Propane C3H8 0.3861

Propylene (Propene) C3H6 0.4653

Silane SiH4 0.6733

Silicon Tetrachloride SiCl4 0.3168

Silicon Tetrafluoride SiF4 0.3960

Sulfur Dioxide SO2 0.7228

Sulfur Hexafluoride SF6 0.2970

Trichlorosilane Cl3HSi 0.3267

Trimethylamine (CH3)3N 0.3168

Tungsten Hexafluoride WF6 0.2871

Uranium Hexafluoride UF6 0.2178

Vinyl Bromide C2H3Br 0.5248

Vinyl Chloride C2H3Cl 0.5347

Vinyl Fluoride C2H3F 0.5743

Gas Conversion Constants for the MFC (continued)
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Gas Symbol
MFC Conversion

Constant
(H2 = 1.000)

Xenon Xe 1.3762

Gas Conversion Constants for the MFC (continued)
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J MAINTAIN HIGH-PURITY GASES

The analysis system was designed to accurately measure the surface area of all types of
materials. It is important that the gases (especially krypton) used for these measurements be of
highest purity, especially when analyzing low surface area samples. Three ways to ensure high-
purity gases are to always maintain:

n Thoroughly purged gas pressure regulators.
n Non-permeable gas lines.
n Leak-free connections.

Impure gas is strongly indicated, for example, if a series of measurements on a low surface area
material yields decreasing specific surface areas with decreasing quantities of sample. The
analyzer uses very small amounts of helium; therefore any residual air in the regulator can distort
results of subsequent analyses for quite some time.

Micromeritics offers the following suggestions to assist in maintaining high-purity gases
(particularly helium):

n Use metal gas lines only.
n Remove trapped air from the regulator and gas lines.

USE METAL GAS LINES
Always use metal gas lines which have been carefully cleaned of any oils and greases used in the
manufacturing process. Do not use plastic or rubber gas lines. When these types of permeable,
nonmetallic gas lines are used with helium, contaminants accumulate at a much faster rate. This
causes errors in analysis results and can also contaminate a clean sample.

REMOVE TRAPPED AIR
When connecting the regulator to the gas cylinder, air is unavoidably trapped on the high and low
pressure sides of the regulator, as well as in the gas lines. Remove as much of this air as is
possible before opening the gas cylinder valve. If this air is allowed to remain in the regulator, it
will mix with the helium and cause inaccurate results in subsequent analyses. Or if the valve is
open for any length of time, the air trapped on the high pressure side may diffuse back into the gas
cylinder and contaminate its entire contents.

There are two methods for removing trapped air from the regulator lines: the Purge Method and
the Evacuation Method.

J Maintain High-Purity Gases
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J Maintain High-Purity Gases

PURGE METHOD

This is the preferred method for removing trapped air.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

If multiple instruments are installed, choose the correct Unitmenu.

2. Close all valves by right-clicking each valve, then click Close.

3. Open the regulator shut-off valve.
4. Open the gas cylinder valve briefly and allow the regulator to be charged with gas until the

high pressure gauge reads just over half the tank pressure, then quickly close the valve.

A. Gas tubing to instrument
B. Low pressure gauge
C. High pressure gauge
D. Regulator connecter nut
E. Gas cylinder shut-off valve
F. Regulator control knob

5. Use the Pressure Control knob to set the output pressure (gas cylinder pressure gauge) to
15 psig.
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6. Loosen the fitting at the instrument helium inlet until the low pressure side drops to approx-
imately 3 psig (0.02 MPa), then tighten the fitting.

7. Repeat steps 4, 5, and 6 three times.
8. Briefly open the gas cylinder valve, then use the Pressure Control knob to reset the reg-

ulator output pressure to 15 psig.
9. After the pressure has stabilized (indicating there are no leaks), open the gas cylinder valve.

J Maintain High-Purity Gases
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J Maintain High-Purity Gases

EVACUATION METHOD

To use this method, the gas tank must be within 10 feet of the instrument.

1. Do one of the following:

If... Then...
The regulator has not
been filled with gas and
the gas line is attached
to the instrument:

Close the gas cylinder valve.

Open the regulator shut-off valve.

The regulator is filled
with gas:

Close the gas cylinder valve.
Open the regulator shut-off valve.
Loosen the helium inlet fitting (or nut) on the instrument.
Allow all of the gas in the regulator to expel from the line (pressure
reading will be zero).
Retighten the helium inlet fitting (or nut).

2. Go to Unit > Enable manual control (if the instrument schematic is not displayed, go to
Unit > Show instrument schematic).

If multiple instruments are installed, ensure the correct Unitmenu is selected.

3. Close all valves, then open valves 6, 7, and 10.
4. Allow evacuation to continue for 20 minutes. This pulls a vacuum on the helium line to the

gas cylinder. The manifold pressure transducer should fall close to zero.

Allow evacuation for a full 20 minutes. If evacuation time is too short, trapped air may
remain in the lines.

5. Close valves 6, 7, and 10.
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K PEAK DETECTION / INTEGRATION OPTIONS

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

This section applies only to dynamic analysis samples.

File Open > [.RPO file] > [Integration button]
Or, select the Integration button while in the Peak Editor.

Peak detection parameters can be customized using the Integration button on the Report
Options window or the Integration button on the Peak Editor window. Peak detection options can
be customized while creating the sample file or after analysis. For Pulse experiments and Loop
calibrations, peaks are found using events that occurred during the analysis — such as the time
an injection started— instead of peak detection options.

K Peak Detection / Integration Options
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K Peak Detection / Integration Options

Selection Description
Standard Settings
[group box]

n Baseline mode

The Baseline Mode affects how the Find All Peaks function works.

If Best Fit Baseline is selected, the bottom of the peaks is placed in
the baseline that best describes the signal outside the range of the
peaks. This assumes a linear baseline between the beginning and
the end of the peak.

If Snap to Signal is selected, the bottom of the peaks is moved to the
signal recorded, not the best fit baseline between the peaks.

n Minimum peak height

Sets the minimum height for peaks to be identified and included in
the peak table. This value is expressed in terms of the trace’s Y-axis
units. Use a value of 0 (zero) to include all peaks.

n Peak smoothing

Smoothing allows the application to average the points before using
them, so that noise spikes are ignored. Specify the number of points
to average into a single value during the peak picking process.

The smoothing parameter can be turned off by setting the value at 1
or 0 (zero). A setting of 1 disables smoothing, and the peak edges
are interpolated to the best X-axis value. A setting of 0 also disables
smoothing, but the peak edges (the points where the peak begins
and ends) are not interpolated. Instead, the nearest data point is
used as the peak edge.

Advanced Settings
[group box]

n Sensitivity

Sensitivity sets the noise rejection level for identifying the peaks in a
trace. Use a value from -100 to 100%. For example, a sensitivity
level of 5%means that 5% of all local maxima in the trace are greater
than the noise and are, therefore to be considered as peaks. A value
of 100% identifies all local maxima (or minima for traces with
transmission Y units) as peaks. One possible exception to note is the
combination of other rejection parameters (such asMinimum Peak
Area and Minimum Peak Height) which can reject peaks even when
the sensitivity is set to 100%.

Peak Detection/Integration Options
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Selection Description
The sensitivity can also be set to negative values to define a specific
noise level (in Y units) for peak rejection. For example, a sensitivity
setting of - 2.5% sets the noise rejection to 2.5 V. This means that
maxima with an

amplitude of 2.5 V or less will be considered as baseline noise
instead of as peaks. (As opposed to theMinimum Peak Height
rejection parameter which eliminates refined peaks by using their
height above the baseline.)

A setting of 0 (zero) automatically sets a default noise level for the
trace.

n Maximum shoulder ratio

There can also be shoulder peaks (also called combination peaks)
within a group. SeeMaximum group separation. on the next
page for a description of peak groups. Shoulders are usually small
peaks that are overlapped on the front or the tail of a larger peak.
These peaks can also be called leaders and followers, respectively.
As with baseline groups, the areas of these peaks can be calculated
incorrectly. If the larger parent peak has a long tail with a much
smaller peak riding on it, most of the area under the trace belongs to
the parent peak. However, if the area of these peaks was determined
using baseline grouping, the smaller peak would be calculated by
using vertical drop lines at the edges. This would give the parent
peak too little area, and the rider peak too much.

The application can detect these shoulder peaks. The areas of
shoulder peaks are calculated by drawing a skimmed baseline from
the leading edge to the trailing edge. Either an exponential or a
straight skim line can be used. The skim type is specified by a
secondary method parameter (seeMethods on page 2 - 13) and
the default is exponential skimming. The remaining area between
the shoulder peak baseline and the group baseline is considered to
be part of the parent peak.

TheMax Shoulder Ratio parameter is used to specify whether the
peaks that are overlapped in the front or the tail of much larger peaks
should be identified as shoulder peaks. To use shoulder peak
detection, use a nonzero value for theMax Shoulder Ratio
parameter. After a baseline group has been identified, the

Peak Detection/Integration Options (continued)
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K Peak Detection / Integration Options

Selection Description
application looks for peaks within the group that satisfy the following
shoulder peak criteria:

Shoulders must have a significantly higher Y value at one edge than
the other. More importantly, the height of the shoulder above the
common value must be much smaller than the height of the “parent”
(larger) peak above the same valley. It must be smaller by the Max
Shoulder Ratio setting. For example, a setting of 33 implies that
shoulders must be smaller than 33% of their parents in terms of
height above the common valley. The areas for shoulder peaks are
calculated by drawing a skimmed baseline from the left shoulder
peak baseline and the group common baseline is considered to be
part of the parent peak.

Shoulder peaks can only be calculated within a group of peaks. See
Maximum group separation. below for a description of peak
groups. If theMax Group Separation parameter is set to 0 (no
groups), aMax Shoulder Ratio parameter value is not used. Use a
value of zero to specify no shoulder peak detection.

A value of 33% works well with most data. Use a setting of zero to
treat shoulder peaks with a perpendicular drop to the common group
baseline instead of a skimmed baseline.

If the application detects unwanted baseline noise peaks, try
increasing the Sensitivity setting. Conversely, if some peaks are not
detected, decrease the value.

Maximum group separation.

The application normally calculates peak areas by drawing a valley-
to-valley baseline from the leading edge to the trailing edge of every
identified peak. However, in many traces, the valleys between peaks
do not always drop back to the original baseline. If a valley-to-valley
baseline is used for this type of peak, the calculated area does not
accurately reflect the true area under the peak.

The application provides a parameter that allows the calculation of
Baseline Groups. A group of peaks is defined by a common baseline
that extends from the leading edge of the first peak in the group to
the trailing edge of the last. The areas of grouped peaks are
calculated by dropping vertical lines from the peak edges down to
the group baseline.

Peak Detection/Integration Options (continued)
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Selection Description

There may also be Report Groups defined by the
method and assigned group letters from A through Z.
Unlike these Baseline Groups, the Report Groups need
not be next to one another. The two types of groups are
not related.

TheMax Group Separation parameter is used to determine which
peaks in a trace have a common baseline. When using peak
grouping, the application compares the width (actually double the
largest half width) of every identified peak in a trace to the width of
the following peak. TheMax Group Separation parameter specifies a
percentage of the smallest of these two widths in X units. If the edges
of two adjacent peaks differ by less than this value, the two peaks
constitute a group and are given a common baseline. For example, if
two adjacent peaks in the trace have largest half widths of 1 and 1.5
respectively, and theMax Group Separation parameter is set at
20%, then a difference of less than 0.4 X units between the adjacent
edges of these peaks would make them a group with a common
baseline. If the same two peaks have adjacent edges that are
greater than 0.4 X units apart, they do not define a group, and each
peak has its own separate baseline.

The areas for grouped peaks are calculated by drawing imaginary
vertical lines from the peak edges to the common baseline. Any
peaks that share common edges are automatically considered a
group and are given a common baseline for anyMax Group
Separation setting greater than 0. To specify no peak grouping (each
identified peak has its own baseline), use a setting of 0. A value of
33% for this parameter works well with most data. Use a setting of
zero to force all baselines to be drawn from peak valley to valley.

n Minimum peak area

This parameter sets the minimum area required for refined,
processed peaks to be recognized, identified, and included in the
peak table. Any peak with a calculated peak area smaller than the
current setting is not detected. Values for this parameter are
expressed in terms of the trace X-axis units multiplied by the Y-axis
units (e.g., millivolt-minutes).

Setting the Sensitivity parameter to large values (greater than 20%)

Peak Detection/Integration Options (continued)
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K Peak Detection / Integration Options

Selection Description
can cause noise spikes (or dips) on the sides of major peaks to be
identified as peaks themselves. If the areas of the peaks are smaller
than the Minimum Peak Area parameter, major peaks in the trace
may not be identified at all. Exercise caution when using high
Sensitivity settings with the Minimum Peak Area parameter.

If peaks are not detected by the application, lower the setting with a
smaller value. This parameter must be adjusted in conjunction with
the Peak Sensitivity and/or Minimum Peak Height parameters
above. Peak rejection is accomplished through a combination of
peak height and peak area rejection parameters. If the application is
not detecting the peak(s) of interest, decrease both parameters.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Peak Detection/Integration Options (continued)
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L TEMPERATURE PROGRAMMED ANALYSES

Dynamic Analysis and Chemisorption options are not applicable when the software is
installed in 21CFR11 environments.

Most temperature-programmed experiments are based on the following highly simplified steps:

1. Gas flows into the analyzer.
2. The gas interacts with the sample as the temperature changes.
3. Gas flows past the detector.
4. The detector collects data.
5. The application plots and calculates results.

How the Detector Works

The detector contains heated filaments that measure the difference in gas thermal conductivity
sensed between the gases flowing over the sample and reference filaments.

The gases flowing past the detector cool the filament by extracting heat. How quickly any type of
gas removes heat from the detector is determined by its thermal conductivity1 ) . A gas with a high
thermal conductivity cools the filament rapidly, and more power is required to maintain its
temperature. A gas with a lower thermal conductivity removes heat from the filament more slowly.

When the sample reacts with the gas, it causes changes in the composition of the gas and,
consequently, changes the thermal conductivity of the gas. These changes are sensed by the
detector as an increase or decrease in the amount of power required to maintain the filament at a
constant temperature.

1 ) The thermal conductivity of a gas is its ability to conduct heat. Each gas has a distinct thermal
conductivity.

L Temperature Programmed Analyses
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L Temperature Programmed Analyses

Data that are Collected

The detector reports the amount of electricity (in volts) required to keep its temperature constant
during the analysis.

The Role of the Sample Temperature

Because the sample’s temperature determines how rapidly it interacts with the analysis gas (or if it
reacts at all), data are collected over the range of temperatures specified.

In some experiments, you may prefer to start collecting data at a very low temperature to establish
a baseline where the gas is completely unaffected by the sample. In other cases, you may prefer
to collect data after a reaction has begun. In still other experiments, your primary interest may be
determining the temperature at which the maximum reaction occurs.

For example, consider the example of a Temperature-Programmed Reduction (TPR). During the
TPR, a metal oxide is reacted with hydrogen to form a pure metal. This reaction is referred to as
“reducing” the metal; for example, TPR of a catalyst containing Platinum. Argon, which has a very
low thermal conductivity, is used as a carrier gas. It is blended in a fixed proportion with hydrogen,
an analysis gas with a much higher thermal conductivity. Then the gas mixture flows through the
analyzer, through the sample, and past the detector.

When the gas blend begins flowing over the sample, a baseline reading is established by the
detector. This baseline is established at a low enough temperature that no reduction of the sample
is occurring, so the baseline level recorded by the detector is that of the thermal conductivity of the
two gases in their fixed proportion. In other words, the proportion of gases flowing over the
detector is the same as the proportion of gases entering the analyzer, because at the low
temperature, there is no interaction with the sample.

A. Gas flows into the sample tube and through the
sample.

B. Before the reaction begins, the concentration of
gases exiting the sample tube is unchanged after
flowing through the sample.
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The temperature is then changed, and when a critical temperature is reached, hydrogen atoms in
the gas flow react with the sample, forming H2Omolecules. The H2Omolecules are removed from
the gas stream using a cold trap. As a result, the amount of hydrogen in the argon / hydrogen gas
blend inside the analyzer decreases, and the proportion between the two gases shifts in the
direction of argon, as does the mixture’s thermal conductivity.

A. As the temperature changes, the sample begins to
react with the gas(es) flowing through it.

B. The concentration of gases exiting the sample tube
is altered after passing through the sample. This
change in the gas concentration is recorded by the
Thermal Conductivity Detector downstream.

Since argon has a lower thermal conductivity than hydrogen, the mixture’s thermal conductivity
consequently decreases. The flowing gas removes heat from the filament more slowly, requiring
less electricity to maintain a constant filament temperature. The analyzer records the electrical
demand as it changes (this is called the detector signal). The detector signal is recorded
continuously over a range of temperatures. When these readings are graphed, the data form one
or more peaks. Peaks can be positive or negative; negative peaks are show in this example.

L Temperature Programmed Analyses
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L Temperature Programmed Analyses

Item Description
1 Baseline readings. The gas(es) is (are) not reacting with the sample, so there is no

change in the signal from reading to reading.
2 As the temperature changes, the sample begins to react with one of the gases. There-

fore the gas mix is then made up of a larger proportion of the other gas. This causes a
shift in the mixture’s thermal conductivity. The detector measures this change by
recording the change in the amount of electricity required to maintain constant filament
temperature.

3 As temperature continues to increase, the interaction reaches a maximum, then begins
to diminish.

4 As fewer and fewer sample atoms are available to bond with the analysis gas, there is
less and less change in the mix of gases flowing into the analyzer and past the
detector, so the thermal conductivity shifts back toward the baseline value.

Negative Peaks Legend

This example illustrates the fundamental concept upon which the analyzer operates. Of course,
the various types of analyses the analyzer can perform result in different types of traces. For
example, a pulse chemisorption analysis results in a series of peaks that gradually increases in
size as the sample is dosed with separate increments of gas. Initially, the gas uptake by the
sample results in smaller peaks. But when all the active sites are saturated, no more gas can be
taken up and the peaks become equal.

PEAK AREA
The area beneath each peak is calculated to provide information about the volume of gas reacted
during the analysis. The Calculations document can be found on the Micromeritics web page
(www.micromeritics.com).

AUTOMATIC OPERATION

The analyzer application provides a simple format to specify all the analysis conditions for the
experiment; create a sample file which contains sample information and a list of specific steps the
analyzer will follow to perform the experiment(s). Then, the analyzer automatically performs the
analysis, from controlling the gas mixture and flow rate to monitoring the temperature and
pressure. After analysis, use the Peak Editor to adjust the peaks to create reports that contain the
data needed, without baseline noise or other undesirable effects.

Because up to 99 experiments can be specified and each experiment can contain up to 99 steps,
the analyzer can perform a wide variety of preparation and analysis functions automatically.
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SORPTION TRAP
In some cases, it is preferred to trap substances resulting from the reaction. In the previous
example, H2O is produced during the analysis. If the gas flow is passed through the sorption trap
at an appropriate temperature, the water can be removed before the gas flows past the detector.

INJECTION LOOP
Injection loops are provided for injecting carefully measured doses of gases for analyses such as
Pulse chemisorption. The analyzer is shipped with a 0.5 cm3 loop installed. A 1 mL loop is also
available. If the sample file is set so that a loop is used for introducing gas into the analyzer, the
analyzer will automatically dose the sample as specified in the sample file.

SAMPLE PREPARATION AND CALIBRATION
Depending on the type of experiment(s) to be performed, sample preparation and/or calibration
may be required. Specific instructions are contained in the appropriate sections of this manual.

A sample is prepared for analysis by removing unwanted adsorbates from the surface of the
sample. This is usually accomplished by flowing gas over the sample and may include heating the
sample. The flowing gas may be inert or chemically active gases may be used to activate the
surface.

Calibration routines provide the analyzer and application with the appropriate information to
convert electrical signals to physically meaningful data such as volume adsorbed, loop volume,
and gas concentration.

L Temperature Programmed Analyses
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M VAPOR PURIFICATION
Physical adsorption of gases is generally used to calculate pore size and surface area of solid
materials. Using vapor adsorptives allows the sorption capacity and isosteric heat of adsorption,
the energy released as molecules adsorb on the sample surface, to be calculated by using
isotherms collected at different temperatures with the same vapor and adsorbent. Heats of
adsorption data are very useful in research applications. In the case of competitive adsorption, the
vapor with the highest heat of adsorption will adsorb first and have the strongest interaction with
the surface. However, if the heat of adsorption is too high, the molecule will be so strongly
adsorbed that desorption or regeneration of the material may be difficult. In order to properly
collect vapor isotherms, a purified vapor must be used. A liquid-filled reservoir is used as the
source of the vapor.

This procedure describes a freeze-thaw method to remove dissolved gases and air within the
reservoir so the vapor purity is suitable for analysis on the Flex. The general principles of this
method could also apply to vapor purification on other gas adsorption instruments. The basic
principle is to evacuate non-condensed species while the vapor reservoir is immersed in a
cryogenic bath. At the pressures achieved during the purification process, nitrogen and oxygen
are not condensed. The use of liquid nitrogen is limited to vapors that will not sublimate at
cryogenic temperatures.

A. Vapor shut-off valve

Valve 4 Open Vapor Source
Container

1. Fill a clean vapor reservoir with liquid. Fill halfway (10 mL) if using water. Fill with approx-
imately 20 mL for other liquids.

2. Attach vapor reservoir to the Flex. See Vapor Source Container Installation on page 11-
17 in the Flex operator manual.

3. Firmly close the vapor shut-off valve above the liquid-filled reservoir.
4. On the schematic, open valve 4 to evacuate the space above the vapor shut-off valve.
5. Close valve 4 on the instrument schematic, then open the vapor shut-off valve on the reser-

voir. Allow the pressure to equilibrate in the vapor container.

M Vapor Purification
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MVapor Purification

6. Submerge the vapor reservoir in a cryogen bath. The use of liquid nitrogen as the cryogen
should be limited to vapors with no sublimation pressure at cryogenic temperatures. Wait
for the pressure in the vapor container to drop as low as possible. This may only be 150 Torr
for the first cycle but should be near zero after two or three cycles. A lab jack is useful to
hold and adjust the Dewar filled with liquid nitrogen.

7. Once the vapor has condensed and has frozen, open valve 4 on the instrument schematic
with the cryogen bath still in place and evacuate the vapor container (the vapor shut-off
valve should still be open). Pressures in the range of 10-4-10-5 Torr should be achievable.

8. Close valve 4 on the instrument schematic and remove the cryogen bath. Let the vapor con-
tainer thaw. The vapor shut-off valve should remain open during this step. To expedite the
process, a warm water bath may be used temporarily to raise the temperature of the vapor
container closer to the ambient temperature. However, a layer of ice formed on the reservoir
could also create a barrier for heat transfer, so it is best to not introduce the water bath
immediately. If pressure stabilizes near the calculated saturation pressure at room tem-
perature, the vapor is free of impurities.

9. If the pressure does not stabilize around the calculated saturation pressure, repeat steps 3
to 8 until the pressure at the last step stabilizes near the calculated saturation pressure of
the vapor. When the vapor is pure, the pressure should stabilize around the same value
after each thawing cycle. Typically, three total purification cycles (two repeats) is sufficient.
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N WETTED MATERIALS

Contact Micromeritics for assistance before running a gas such as ammonia or pyrid-
ine that is incompatible with some of the system components.

Material Location
304 stainless steel , 403 stainless steel , Ceramic
(Al2O3), Silicon, SiO2, Si3N4, Gold, Viton, Low out
gassing epoxy resin

Vacuum gauge

316 Stainless Steel, Hastelloy C-22, 17-7 PH, 430SS,
Nickel, Kalrez (FFKM)

Mass Flow Controller (MFC) (for
chemisorption only)

Aluminum NW/KF ring in vacuum line

Aluminum alloys, stainless steels, fluoroelastomer
and nitrile O-rings, hydrocarbon lubricant, felt, rare
earth magnets, silicon nitride, phenolic resin, carbon-
fiber reinforced epoxy resin, fire retardant polypro-
pylene, polyamide and PVC.

Turbo pump

Borosilicate Glass Physisorption sample tubes, filler
rods

Buna-N n Gas inlet manifold, valve plun-
gers, and O-rings

n NW/KF ring in vacuum line

Buna-N, stainless steel, Platinum TranSeal (optional)

Copper Gas inlet lines

FFKM (Kalrez) n Optional sample port O-rings
n Servo valve

Gold-plated copper Turbo vacuum pump gasket and
vacuum gauge

Gold-plated nickel / iron TCD filaments

Inconel Transducers

Kel-F (PCTFE ) n Valve seats analysis manifold
n Valve seat exhaust valve

(chemisorption only)

Wetted Materials

NWetted Materials
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NWetted Materials

Material Location
PCTFE (Kel-f), Buna-N, FKM (Viton), Stainless steel,
Borosilicate Glass

Check seal (optional)

PTFE, FPM (fluroelastomer), Aluminum Diaphragm roughing pump

Quartz Chemisorption sample tubes, filler
rods, wool filter discs

Stainless steel n Manifolds, valve bodies, plumb-
ing, VCR gaskets, port trans-
ducers, filler rods.

n Gas inlet lines (optional)
n Ferrules in exhaust line

(chemisorption only)
n TCD block

Teflon (PTFE) Ferrules in gas inlet manifold, P0
tube

Viton type A (FKM) Sample port O-rings

Wetted Materials (continued)
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O WORKSHEETS

Worksheets in this section may be copied as needed.

Sample Data Worksheet for Chemisorption on page O - 3
Sample Data Worksheet for Gas Adsorption on the next page

OWorksheets
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OWorksheets

SAMPLE DATA WORKSHEET FOR GAS ADSORPTION

Sample tube identification:

Sample Mass (g)
Before Degas After Degas After Analysis

1. Mass of empty sample tube set g

2. Mass of sample tube set plus sample g g g

3. Mass of sample (step 2 minus step 1) g g g

Degas Information
Degas apparatus
Temperature (°C)
Time (hours)
Actual time started
Actual time finished

Degas Notes:
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SAMPLE DATA WORKSHEET FOR CHEMISORPTION

Sample tube identification:

Sample Mass (g)
Before Degas After Analysis

1. Mass of empty sample tube set g g

2. Mass of sample tube set plus sample g g

3. Mass of sample (step 2 minus step 1) g g

Notes:

Sample Data Worksheet for Chemisorption
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